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About This Manual 

Structure Of The Manual 

The manual contains the following sections: 

Section Contents 

About this 
manual 

Structure of the manual (This section) 

Intended audience (Who can use this manual) 

Terms used (explanation of the jargon used in this manual) 

Disclaimer (Read carefully!) 

Copyrights (Copyright of the ActivePresenter and the products used with 
ActivePresenter) 

Version numbering (How to recognize the version of ActivePresenter and 
this manual) 

What is new in this version of User Manual (List of latest changes) 

General Basic Screen-casting Concepts (A glimpse of how ActivePresenter works 
under the hood.) 

Overview of ActivePresenter (Introduction to user interface, feature-
comparison between ActivePresenter versions) 

System Requirements (Your system must have these resources) 

Installing ActivePresenter (How to install, update and upgrade 
ActivePresenter)  

The multi-tier help system (How to get help while using ActivePresenter) 

Creating a new 
project 

Creating a Capture project (Capturing screen while using an application) 

Creating a project from MS PowerPoint Presentation 

Creating a project from Images (Create a project by importing images as 
slides) 

Creating a blank project (Start with a blank canvas and add items) 

Saving a project (How to save an ActivePresenter project) 

Opening an existing project (How to open an existing ActivePresenter 
project) 
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Editing a project Editing overview 

Project-level editing (Sorting slides, adding/deleting slides, naming slides) 

Editing a slide (Adding annotation objects, editing those objects) 

Advanced Editing (Interactive objects, accessibility, localization…) 

Rendering 
(Exporting) 

How to export the ActivePresenter project to create different types of 
presentations. 

Using 
ActivePresenter 
windows. 

Appendices that explain how different windows work in ActivePresenter: 

 Capture Profile Editor (How to edit all settings for screen-capturing) 

 Event Editor 
(How to set up the interaction objects to respond to various trigger 
events) 

 Image editor (How to edit images) 

 Image Resource Properties Window 
(How to edit the properties of image, such as margins and hotspots) 

 Properties pane (How to edit properties of an object) 

 Resource pane 

 Timeline (How to use the Timeline pane) 

 Selection pane 

Objects Explanation about all annotation and interaction objects used in 
ActivePresenter. 

 What is the basic use of each type of object 

 How they work 

 How to set their visual and behavioral properties  

Menus and 
Shortcuts 

Summary of all menus and hot keys 

Customizing 
ActivePresenter 

Customizing the interface and behavior. 

What's new What is new in this edition of the User Manual. 

(Covers changes in the software and the manual itself.) 

Intended Audience 

ActivePresenter is directly and indirectly used by two different kinds of users: 
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1. Presenters/teachers: They are the direct users of ActivePresenter.  
They use ActivePresenter to prepare a presentation and export it to various formats.  

2. Viewers/students: They are the indirect users of ActivePresenter. 
They watch the exported presentation, practice and take a test. 

In some cases, the presentation is run and moderated by the presenter. In other cases, the 
viewers/students run the presentation in self-paced mode, as guided by the presentation itself. 

In this context, this manual is meant for the direct users of ActivePresenter (i.e., for the 
presenters/teachers). 

No previous experience of screencasting is assumed. All terms are explained within this manual. 

How To Use This Manual 

It is best to read the main chapters of this manual from start to finish. Then you can read the 
Appendices in any order. 

This manual has hyperlinks that are displayed in bold red, NOT in blue text with underline. 

The steps to complete a task such as “Click the HOME tab, then click the Paste tool” can be 
written in short form “Click HOME > Paste” in some cases. 

Terms Used 

Some technical jargon (especially terms related to video encoding) terms are explained below. For 
more details, please refer to the Wikipedia.  

Term Meaning 

Key frame To reduce the size of the video file, a compression technique is used, in which the 
computer stores the whole visual information for only a few frames (called key 
frames). For the rest of the frames, it only stores the differential information with 
reference to the preceding key frame (in some compression schemes, a frame's 
content is derived from key frames on both side of it).  

LMS A Learning Management System. 

 

Disclaimer 

This manual is written by volunteers. Please use it in the same spirit. 

No guarantees are made regarding accuracy.  

The author assumes no responsibility for any loss of data; or for any direct or indirect damages that 
arise out of use, misuse or misapplication of the information provided in this manual. 

http://atomisystems.com/tutorials/
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Please exercise caution and use it at your own risk. 

Copyrights 

All copyrights for the ActivePresenter software belong to Atomi Systems, Inc. 

The copyrights of the other applications mentioned in this manual (e.g. Microsoft PowerPoint, 
Adobe Acrobat Reader, LibreOffice, etc.) belong to their respective developers. 

Due care is taken to use original material in this manual. Nevertheless, if you see any copyright 
infringement in the manual, please send us an e-mail, so that immediate actions can be taken. 

Version Numbers 

The version of ActivePresenter software is denoted with a three-part version number, such as 
5.5.0. 

The version number of this manual is derived from the software's version number by placing a 
serially incrementing number as a suffix.  

For example, the second User Manual written for version 5.5.0 of ActivePresenter will have version 
number 5.5.0-2. 

Getting The Latest User Manual 

The header of each page (right corner) carries the version number of the manual. If you want to 
check whether you have the latest version of the manual, click on the header. This will launch a 
browser and load the manual download page. Compare the version numbers, and if your version 
is outdated, download the latest version.  

To replace the old version with a later version you have to move the downloaded file to the 
installation folder of ActivePresenter and named it in the form: “Help_<langcode>.pdf”, where 
<langcode> is the standard language code, default is “en” for English version. 

After this, whenever you press F1, the latest User Manual file will open. 

What's New In This Version Of User Manual 

Appendix What's New describes what's new in this version of the manual, so that if you have 
already read the previous version, you can update yourself with minimal effort. 

The appendix provides links, so that you can directly jump to the changed portions and catch up. 

http://atomisystems.com/tutorials/
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General 

Basic Screencasting Concepts 

Before using ActivePresenter, you must first understand some basic concepts. 

Screenshot 

Just imagine that we have a camera to take a photo of the whole screen of your PC, an 
application's window or any part of it. Such an image is called “screenshot”.  

This manual contains a lot of screenshots of the ActivePresenter windows. 

Screencasting 

A screencast (also known as “screen capture”) is a digital recording of what happens dynamically 
on your computer screen. A screenshot is like a still photo taken of your screen, while a screencast 
is like a video of your screen. 

In the context of ActivePresenter, the entire process is as follows: 

1. Capturing 

The teacher/presenter works on the target application, and captures the screen. The 
outcome of this step is a video or a slide-show. 

2. Editing and annotating 

The teacher/presenter edits the video or slide-show, and adds shapes, commentary, 
images, audio/video clips, etc. 

3. Making it interactive (Optional) 

Optionally, the teacher/presenter adds interactive elements (typically questions and 
quizzes); and also defines how the presentation should behave when the student gives a 
correct answer, an incorrect answer, or does not respond within the stipulated time. 

A presentation behaves differently to the user, depending upon his previous answer, and 
what he is doing on the screen at that moment. 

4. Exporting (Rendering) 

The teacher/presenter renders the output (=exports the files). 

Broadly, the outputs fall in three different categories: 

 Interactive presentation: HTML5/Flash (viewed in a browser) 

 Video (with audio) 

 Documents: Excel/Word/PowerPoint, PDF, Images, HTML slide-show.  

http://atomisystems.com/tutorials/
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Depending upon the output, it is used by either the teacher/presenter himself to teach his 
course, or by the students or course-participants to study/practice the subject on their own. 

5. Actual delivery 
The actual delivery may be in a classroom setting (on a projector), or via a remote network, 
where the student goes through the presentation using his browser, and/or reads the 
documents using a PDF reader or Microsoft Office/LibreOffice. 

6. Assessment (Optional) 

The students may be required to take tests.  

These may be used by the teacher/presenter to rank the students, or to screen them for 
promotion to the next class.  

Alternatively, they may allow the student to obtain the results for a self-assessment, so that 
the student can improve in his weak areas. 

The results are produced either directly by the interactive module, or by the LMS. Reporting 
is only available when the project is exported in an interactive format (HTML5/Flash). 

Capture Profile 

Capture profile is a set of various options which used during a capture session. The primary option 
in a capture profile is the capture type (mode). There are two capture types: 

1. Full Motion Recording (FMR): ActivePresenter will record the screen like a video camera. 
The result is a slide which contain a video/video show exactly what you have done on 
screen. This capture type is mainly used for creating the demonstration video. 

2. Smart Capture: ActivePresenter will take a screenshot each time a mouse button is clicked 
or a key is pressed. The result is a series of slides (steps) describes how to achieve a 
specified purpose with the application that you are capturing. This capture type is used for 
creating both interactive content (software simulation) and demonstration video. 

The other options in a capture profile are: audio/video codecs and parameters, cursor, annotations, 
and hotkeys settings... 

ActivePresenter offers four default capture profiles as below (note that some of them have names 
similar to capture types).  

1. Record Software Demonstration: When use this capture profile, ActivePresenter records 
the screen like a video. It produces a video clip that captures all actions on the screen 
faithfully. So, it is the most suitable profile when you want to capture the motion effects 
exactly (movement of the mouse, resizing of windows, animated content, etc.). 
This profile uses a lossless Flash Screen Video codec to record the movie so it has 
following advantages and disadvantages: 

 The quality is preserved. 

 It is suitable for recording the software demonstration because the screenshots of a 
software usually have many blocks of contiguous color. 

 It is not suitable for recording movies, games because they have many scene 
pictures so it take much time to encode to video and the recorded file size is large. 

 The frame rate is not high, especially in cases of recording movies and games. 

2. Record movie/Streaming video: This capture profile is very similar to the Record 
Software Demonstration capture profile, but it uses a lossy encoder to record the video, 
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with a choice between H264, MPEG1, and MPEG2.  
Using this capture profile has following advantages and disadvantages: 

 The quality is not preserved, it depends on the quality option which can be set in 
range [1, 100]. 

 It is suitable for recording any applications. 

 The frame rate is high and the recorded file size is not too large. 

3. Smart Capture: When use this capture profile, ActivePresenter captures screenshots when 
there is an input from mouse or keyboard. At the same time, ActivePresenter keeps track of 
the actual elapsed time. This profile produces multiple screenshots (slides) and/or multiple 
videos.  
While recording, you can manually switch between the FMR and Smart Capture capture 
types using hot keys (defaults are F9 and F10). This is very useful when capturing a text 
typing operation or a mouse drag-n-drop operation. 
Using Smart Capture has several advantages: 

 It is possible to create interactive and branching content (HTML5/Flash). 

 High quality output when export to HTML5/Flash but small output size (thanks to 
PNG loss-less compression) 

 Smooth cursor path 

 The presentation is divided into steps so it is easier to manage and edit. 

4. Smart Capture with Auto FMR: When use this capture profile, ActivePresenter switches 
automatically between the two capture types mentioned above: It captures in the Smart 
Capture capture type, but will temporarily switch to the FMR capture type when you start 
dragging the mouse; and switch back to the Smart Capture capture type when you stop 
dragging the mouse.  

You can also create your own capture profiles to use in your authoring process.   

Slide Background 

Slide background in ActivePresenter displays the image of a step (where to click, what key is 
pressed) in interactions chain when creating a tutorial. 

It is also used to display some form of corporate identity throughout the presentation. This could be 
in the form of a corporate logo or simply corporate colors in the backdrop of each slide. This can be 
achieved by inserting a background image that is shared among multiple slides.  

The slide you see is made up of several objects that form a stack. When an object is added to a 
slide, it is placed at the top of the pile, and covers the objects placed beneath it. In this context, the 
background image remains at the bottom of the objects' stack, regardless of when it is added. 

Background is an optional item (some slides may not have it). A given slide can not have multiple 
backgrounds. 

ActivePresenter has the facility to flatten any stack of objects and turn them into a single 
background image. 

A background image can be edited like any other image. 
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Slide Index 

The slide index denotes the order of any given slide in the slide list: The first slide has index 1, the 
second slide has index 2, etc... 

The index numbers of slides change when slides are added, deleted or shuffled. 

Resources 

We need multiple items for annotation: shapes for the annotation, styles for shapes, background 
music, pre-recorded sounds (such as mouse-clicks), additional video clips, etc.  

These are collectively known as “resources”. 

The resources can be divided into two categories, based on their source: Preset resources and 
User resources. 

 The Preset resources are predefined and get installed with the ActivePresenter. They 
cannot be moved, renamed or deleted. 

 The User resources are the resources added by the user to the library. 

The User resources can be further divided into two categories, based on their availability: global 
and project-level. 

 The global resources are available to all ActivePresenter projects.  

 The project-level resources are assigned to a particular project; and are not available to the 
other projects. 

How Resources Come Into A Project 

Resources get into a project in five different ways: 

1. Pre-installed resources (bundled with ActivePresenter) 

2. Resources added by the user, from the file system to the Library (e.g. audio/video files). 

3. Resources added by the user, from the file system to the canvas directly (e.g. audio/video 
files). If you insert the same file multiple times in the same project, the project treats each 
copy as a different resource; and does not try to find duplicates.  

4. Audio objects created by the user in a slide  
(e.g. recorded voice, Text-To-Speech track created from a Closed Caption, etc.) 

5. Logical resources created by certain operations: Splitting of an audio/video, splitting of 
slide, deletion/cutting of a portion, joining with other object, changing the volume, or 
inserting a freeze-frame/silence. 

All these resources appear in the Resources pane, from where you can use them in the current 
project. 

Objects 

Object is a generic name for any structured item that is placed in a slide to add annotation, or to 
make it interactive. 

Examples of Objects are images, different shapes (such as rectangles, circles, ovals, arrows and 
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call outs), text captions, closed captions, highlights, vector curves that represent the path of the 
cursor, zoom-n-pan frames, audio clips and video clips. 

See Appendix Objects for more details. 

Note that the term “objects” is also used in a totally different context when you are taking a 
screenshot: There, an “object” means any part of a window that can be captured in a screenshot, 
such as toolbars, toolbar buttons, panes, menus, scroll bars, controls, etc. 

Object Style 

Style is a preset of object properties (fill, line, text, graphics effects). 

Several options are available in the Styles tab in the Resources pane (select any style listed in 
the pane and use the context menu): Add a new style, Clone from selected style, Copy the 
selected style to project and Delete the selected style. 

When a new style is added, ActivePresenter provides it with a temporary name with an internally 
incremented number. The author should always provide a meaningful name to the newly created 
style. 

Library 

A library is a virtual storage area that contains the often-used resources. 

The Library provides ready resources to all projects. 

Note that the Library contains two different types of resources: 

 Preset resources (bundled with ActivePresenter). 

 User resources (Added to the Library by user). 

Once a resource is placed in the Library, you can delete/move/rename the original.  

The author can also insert resources directly from the disk, rather than placing it in the Library first. 
But there are two major disadvantages: 

1. The resource is used by a particular project only: To use it in another project, you will have 
to insert the resource again from disk.  

http://atomisystems.com/tutorials/


ActivePresenter User Manual  Version 5.5 

General> Basic Screencasting Concepts 20 

2. ActivePresenter does not check whether the new resource is already being used in the 
current project: It will go on adding each copy independently. Thus the project size grows 
tremendously if you use the same resources multiple times. 

Therefore, if you want to re-use a resource in multiple projects, it is always best to first add the 
resource to the Library, and then use it in your projects from there. 

There is only one physical file that stores all library contents. This file is located at: 
C:\Users\<Username>\AppData\Roaming\ActivePresenter\ActivePresenter.aplib (Windows Vista or 
Windows 7) 

or  

C:\Documents and Settings\<Username>\Application Data\ActivePresenter (Windows XP) 

How ActivePresenter Manages The Resources 

ActivePresenter reads the file content and saves it to the Library file (see above). It creates a 
resource entry that points to this imported content.  

This entry has a name, and that name is used to refer to a resource in the library. 

If the file size is bigger than a pre-defined value in Preferences, ActivePresenter does not store file 
content directly in the Library file, but maintains its own local copy of the imported file in an external 
data folder. By default, this limit is 50 MB, but you can freely adjust it any time in Preferences. The 
external data folder has name in form <ProjectFile>_files. You should copy this folder or update its 
name when copying or renaming the project file. 

The original file leads an independent life: If you rename or delete it, the copy in the Library will not 
be affected. 

When you use a library resource in any project, ActivePresenter only creates a link with its file. 
(That means, if the resource file is modified in a future version of ActivePresenter, all projects using 
it will use the modified resource automatically.) 

Annotation 

Just recording a screen is not enough as a training resource: You also have to add some 
explanatory elements (Objects) to the video. Adding these objects to the original screen-recording 
is called annotation.  

You have the option to insert annotations at two stages: 

1. Annotation during capture phase 

In a typical capture project, you would be interacting with the target application by clicking 
on its menus and buttons, pressing hot keys and entering text. 

ActivePresenter has the option to automatically insert annotation shapes where you have 
clicked or when you press any keys on the keyboard. Optionally, ActivePresenter can 
actually insert the description of your actions (e.g. “left click”, “right click”) in the inserted 
shape. 

2. Annotation during edit phase 

Annotation during edit phase is done by various methods: 

 Superimposing different shapes on the video (e.g. a circle/ellipse around a button, 
a rectangle around a control, etc.) 
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 Inserting comments with call outs and text boxes  

 Inserting audio/video clips 

 Adding your own commentary (also called “voice-over”) 

 Adding subtitles and closed captions 

 … 

ActivePresenter And LMS 

The outputs produced by ActivePresenter can be hosted on an LMS (Learning Management 
System), as an online course. An LMS can manage multiple courses on different subjects. The 
LMS also allows multiple students to have multiple sessions of the course, and keeps track of the 
marks scored by each of the students during each of those sessions. 

SCORM 

SCORM is a standard for describing and packing materials so that the LMS can understand. So 
virtually anything can be packed into a SCORM-compatible package. 

Interactive Presentation Modes 

ActivePresenter is capable of generating a presentation in interactive mode, in which the 
generated output uses either HTML5 or Flash technology. 

This is a self-running presentation and normally consists of multiple files: 

 HTML5: They are HTML, JavaScript, CSS and media resource files which will be run by a 
web browser. 

 Flash: The main file is a SWF Flash file, and HTML index page which embed that SWF file 
so it can run inside a web browser. 

The user runs the interactive presentation with a web browser. 

The interactive presentation can run in four different modes: Demonstration, Tutorial, Practice and 
Test.  

The Demonstration and Tutorial modes are appropriate for teacher to lecture automatically or 
manually. The Practice and Test mode are appropriate for the student to take exercise or 
examination. 

ActivePresenter allows to you to display/hide each object in specific modes. For example, you 
might use two different audio narrations for the Demo and the Test modes. 

A brief overview of each mode is given below: 

Demonstration Mode 

The simulation will automatically run based on your time settings for slides and slide objects in your 
project. When the elapsed time for each slide reaches the slide's duration, the presentation jumps 
to next slide if the current slide is not the last one. If toolbar and slides list are available, user can 
navigate to a certain slide, pause/resume or exit the simulation. 

Note a special case: If you export the presentation as a video (AVI, WMV, MP4, MKV, FLV or 
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WebM), ActivePresenter checks each object's Demo mode settings to decide whether to include it 
in the video. In other words, ActivePresenter treats a video like an interactive presentation that is 
running in demo mode. 

Tutorial Mode 

In this mode, the simulation not only runs based on slides and slide objects time setting but also 
supports interactive capability. User must use mouse or keyboard to interact with interactive 
objects on each slide. ActivePresenter will assess user response and execute associated actions 
which are defined in authoring time. 

Practice Mode 

This mode is similar to Tutorial mode except it has options to create and send report about user 
result to specified Email or HTTP address. Besides, if user fails to perform expected interaction, 
the interactive object will be displayed if it is hidden before. 

Test Mode 

This is similar to the Practice mode, but when user fails to perform properly, the interactive object 
won’t be displayed if it is hidden before. Furthermore, the author can limit the maximum time which 
users are allowed to complete the test. 

Frame Rate 

To create an illusion of animation, consecutive images (“frames”) show the action in small 
progression in quick succession. The brain is tricked into believing that these discrete images show 
a single continuous motion. This is the technique behind motion video. 

The frequency (rate) at which the frames are displayed is called the Frame Rate. The normal frame 
rate is in the range of 20-30 frames/s. The three commonly used frame rate standards in the TV 
and movie-making business are: 24, 25, and 30 fps. 

 Higher rates means more frames are required per second to produce the same animation; 
which in turn will increase the file size. 

 Lower rates result in smaller file size, but make the movement jerky. 

 Sometimes, the main power supply (which has 50/60 Hz AC) causes the room lighting to 
flicker at this rate. Normally this is unnoticeable to the naked eye, but sometimes a small 
difference in the frequencies causes a beat frequency, and appears as a large flickering in 
display. This can be avoided by changing the frame rate by a few Hz. 

Reporting 

Even if an ActivePresenter interactive presentation is not running on a SCORM-compliant LMS, it 
can still create a report, and optionally send it to a valid email or HTTP address. 

Typically, the report contains the data related to the performance of the student under Demo or 
Test modes. For example: Time taken to take the test, points obtained, passing criteria, overall 
result (pass/fail), details of the tests taken, etc.  

http://atomisystems.com/tutorials/
http://en.wikipedia.org/wiki/Webm
http://en.wikipedia.org/wiki/Television
http://en.wikipedia.org/wiki/Film


ActivePresenter User Manual  Version 5.5 

General> Overview Of ActivePresenter 23 

HTML5 

HTML5 is a new standard for structuring and presenting content on the web. It contains several 
features which are designed to include and handle multimedia and graphical content on the web 
easily without having to install proprietary plugins. If you want to create the content which can run 
on various platforms and devices, you should consider using HTML5 Simulation output in 
ActivePresenter. 

Overview Of ActivePresenter  

Using ActivePresenter, you can capture the live action on the screen, and also record your 
commentary as voice-over. Then you can edit the result and then add annotations (text boxes, call 
outs, arrows, circles, boxes, etc), images, navigational controls and video/audio clips. 

ActivePresenter User Interface 

The program window contains three main sections as shown below: 

 

1. The Tabbed Toolbar 

At the top of the program window is the Tabbed Toolbar. This contains almost necessary 
tools for editing the content. The tools are organized in logical groups, which are collected 
together under tabs. Each tab relates to a type of activity, such as adding the interactions or 
exporting the project to outputs. The HOME tab contains most common operations 
meanwhile the FORMAT tab only shown when the slide object is selected to reduce clutter. 
The FORMAT tab is called a context tab. You can find more information about tabs and 
tools in the Menus, Toolbars And Shortcuts section. 

a. The ACTIVEPRESENTER button. 
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At the top left of the program window is the ActivePresenter button. When you click 
this button, the ActivePresenter Main Menu is shown providing all common file 
operations, the configuration options, and the list of recent files as below: 
 

 
Note: In this User Manual, the short form like ACTIVEPRESENTER > Save means 
“Click the ACTIVEPRESENTER button, then click Save”. 
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b. Standard window buttons and Minimize/Restore Tabbed Toolbar button. 

 
At the top right of the program window is three standard window buttons (Minimize, 
Maximize/Restore, Close) but they have a different look comparing to normal window.  
Next to the left of three buttons is the Minimize Tabbed Toolbar button. You can use 
this button to collapse the Tabbed Toolbar to save the screen space for editing. 
 

2. The Document Window 
Similar to previous versions, ActivePresenter allows you to open multiple projects 
simultaneously. However, the document windows now are displayed in tabs allows you to 
navigate between documents more easily. 
 

 
 
The document window contains following components: 

a. The Quick Access Toolbar which contains following tools: New, Open, Save, Undo, 
and Redo. 

b. The document tab allows you to navigate between opening documents. You can also 
hover the mouse over this tab to view the location of the project file (displayed in a 
tooltip) or right-click the tab to open the file location, save the file, close other tabs… 
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c. The Slides pane displays the list of slides in your opening project. The following tasks 
can be done by using the Slides pane: 

 Selecting a slide for editing its content or selecting multiple slides for 
cutting/copying/pasting. 

 Changing the order of slides. 

 Modifying the name of slides. 

You can refer to Project-Level Editing for more information. 

d. The Canvas pane shows the slide. (It acts like a canvas for painting, and hence the 
name.) 
All of your spatial editing is done here visually: It shows the captured scene, and allows 
you to add the other annotation/interaction objects as required. 
You can also adjust the relative positions of all items in horizontal and vertical 
directions. You can also make a stack of objects (where objects partly/fully overlap) to 
create special effects. 

e. The Timeline pane shows the slide against time axis. Its main function is to show all 
the objects against time, and let you adjust the entry and exit points of all the objects.  
In fact, the Canvas pane always shows the slide at a particular moment that you select 
on the Timeline. 
Timeline also lets you play the current slide to check the effect of your adjustments. 
You can play the slide for only a selected portion of the Timeline to focus on what 
happens during that slice of time. You can also play the slide in loop mode (endless 
play). 
You can play the slide and record your voice in real time.  
The Using The Timeline appendix explains the functioning of Timeline in detail. 

f. The Properties pane lets you edit all the physical and behavioral properties of the 
object that is selected in either the Canvas pane or the Timeline pane. 

g. The Resources pane shows the global and project-level resources. There are three 
categories of resources in ActivePresenter: Images, Audio/Video, and Styles. 

h. The Selection pane allows you to view and change the selection, lock, and visibility 
states of all objects in the current slide. You can also view the hierarchy of composite 
object using this pane. 

3. The Status Bar 
 

 
 
At the bottom of the program window is the Status Bar. The Status Bar provides the 
following information:  

a. The current slide and the number of slides in the editing project or the current status of 
the program.  

b. The progress of the executing process (for example, exporting or saving).  

c. The Status Bar also allows you to view and change the zoom scale of the editing 
project. You can find the zoom tools on the most right of the Status Bar. 
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ActivePresenter Editions 

ActivePresenter is available in three different editions, with incremental capabilities and pricing: 

Edition Main uses 

Free Demo videos 

Standard Demo videos 
Documentation 

Professional Demo videos 
Documentation  
Interactive training, with score-management 

Feature Comparison 

Note: 

 The above table only lists the features which are different between editions. 

 The interactive feature is not available in the video and document outputs due to the nature 
of these formats. 

Features Free Standard Professional 

Export To Images (JPEG, PNG) Yes Yes Yes 

Export To Video (WMV, AVI, MPEG4, WebM, 
MKV, FLV) 

Yes Yes Yes 

Export To Microsoft Word No Yes Yes 

Export To Microsoft Excel No Yes Yes 

Export To PDF Document No Yes Yes 

Export To HTML Slide Show No Yes Yes 

Export To Microsoft PowerPoint No Yes Yes 

Export To HTML5 Simulation No No Yes 

Export To Flash Simulation No No Yes 

Export To SCORM 1.2, SCORM 2004 Yes Yes Yes 

Import From PowerPoint No Yes Yes 
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System Requirements 

Depending on the deliverable, the following are required: 

Operating system Windows XP, Windows Vista, Windows 7, Windows 8.  

Hardware CPU: 1.0 GHz or faster processor with SSE2 (which is available from Intel 
Pentium 4) (1.2 GHz recent multi-core or higher recommended)  

RAM: 1 GB (Recommended > 2 GB).  

Hard disk: 1 GB of available hard disk space. 

Sound card 

Microphone for audio recording. 

Software For HTML slideshow, or Flash- and HTML5-based simulations, the following 
web browsers are fully supported and tested:  

 Mozilla Firefox 3.0 or higher.  

 Google Chrome.  

 Internet Explorer 7.0 or higher. (Object rotation is not supported in IE7 
and IE8, the object will be displayed without rotation in this case) 

 Safari 4 or higher.  

 For running HTML5 Simulation in Internet Explorer 7 and 8, Adobe 
Flash Player or Microsoft Silverlight plugin is required for multimedia 
playback. 

Opera 9.50 or higher (not recommended because Opera doesn’t allow to 
simulate right-click by default)  

For Microsoft Word export: Microsoft Word 2003 or higher is required.  

For Microsoft Excel export: Microsoft Excel 2003 or higher is required.  

For Microsoft PowerPoint import/export: Microsoft PowerPoint 2003 or higher 
is required.  

Installing ActivePresenter 

It is very easy to install the ActivePresenter: After downloading the installer, double-click on it, and 
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follow instructions. 

Activation The Free Edition does not need activation. To activate the Standard and 
Professional Editions, use the HELP > Activate Product tool. 

Updating New versions of ActivePresenter are posted at the website on a quarterly basis 
(approximately). The new versions have many exciting features. 

To update an existing version of ActivePresenter, just download the latest version 
of the executable and run it by double-clicking on it. There is no need to first 
uninstall the older version. 

Or you can simply use the Check for Updates function in the HELP tab, 
ActivePresenter will check if there are new updates and do the updating 
automatically. 

Upgrading To upgrade your license, please contact the support group. 

Uninstalling The standard way to uninstall the ActivePresenter from your computer is to use the 
Control pane of your Windows, go to the Programs and Features option and 
select ActivePresenter from the application list and follow the instructions to 
uninstall. 

Alternatively, open the folder in which you've installed ActivePresenter, double-click 
on the unins000.exe file and follow the instructions to complete the uninstallation. 

The Multi-tier Help System 

ActivePresenter has a multi-tier help system, as described below: 

Tooltips ActivePresenter has a tooltip system that explains the purpose of all toolbar 
buttons. Hover your mouse pointer on any button and a short description pops 
up.  

User Manual If you press F1 at any time, this user Manual (pdf file) pops up to provide the 
ultimate reference on all topics. 

Demo The best way to learn any product is to watch as someone is actually using it. 
The website provides some excellent demo videos. Watch and learn! 

Tutorials The website has a compilation of tutorials. 

FAQ The website has a FAQ (Frequently Asked Questions) section, where most 
frequently asked question are answered.  

User forum The User Forum answers all your queries. (But it is always best to first check 
whether your query is already listed in the FAQ section). 

If you have any features in mind, you can also post a new feature request. 
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Email support If everything else fails, you can send an email to the support team. 

Phone support For urgent support needs, contact +844-3755-8373. 
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Creating A New Project 

In this chapter, we will see how to launch a new project. 

Planning A Project 

You begin a project with certain deliverable items in mind.  

Here are a few sample outcomes: 

1. Video: Presentation, group training, demo, teaser video, kiosk-based interactive mode. 

2. Flash: Banner for a website, flash screen 

3. PDF: Brochure, handout for a lecture/exhibition. 

4. PowerPoint: Presentation,  

5. E-Learning Course for LMS: Interactive training course with score-management. 

6. Images: Material to create further documents 

Note that often you will want more than one outcomes from a single project. For example, you may 
want to create a video, a flash banner for a website and a pdf brochure. 

If you miss any of the expected outputs (or if your client adds a requirement later), you may have to 
repeat the project with different settings. Therefore you must begin with a careful planning of what 
is expected out of it. 

Find The Success Factors 

Depending on the expected outcome for the given project, you have to consider various success 
factors. The following is only a sample list of considerations: 

1. What is the mode of delivery? Will the user interact with you? 
(Will you need to embed all the information in the product, or deliver some of the 
information in person?) 

2. Is it a simple “start-to-finish” presentation, or will it have branches? 
(Is there additional content that is presented only if/when needed?)  

3. Do you want audio? 
(not if the kiosk is in a shared, noisy exhibition hall) 

4. What is the size and resolution of your target device? 
(low-resolution devices won't run high-resolution presentation) 

5. What is the user's preferred device? 
(Some high-value presentations may be specially created for iPad or HD monitor screens) 

6. Does the situation allow interaction? 
(not if the viewers have to walk past the terminal in groups) 
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7. Will your audience include visually impaired people? 
(The presentation will need Closed Caption and longer duration slides) 

8. Is it meant for international audiences? 
(The text and Closed captions will need to be translated later, called “Internationalization”) 
(You may also have to dub the audio tracks in the other language.) 

9. Will you need a background for your slides? 
(Corporate logo in a corner? Borders in corporate colors?) 

Make a note of these settings, and use them in the next steps. 

Prepare An Outline And Storyboard 

Prepare the outline for your presentation. 

First think of only the top-level topics, and make a bullet list, like this: 

 Point-1 

 Point-2 

 Point-3 

Next, break down each topic into sub-topics. Repeat till you have visualized the project in sufficient 
details. This will create a hierarchical outline for your presentation, like this: 

 Point-1 

◦ Point 1-1 

▪ Point 1-1-1 

 Point 1-1-1-1 

 Point 1-1-1-2 

 Point 1-1-1-3 

▪ Point 1-1-2 

◦ Point 1-2 

 Point-2 

◦ Point 2-1 

▪ Point 2-1-1 

▪ Point 2-1-2 

◦ Point 2-2 

 Point-3 

Tip: Initially, when you are marshaling your thoughts on the subject, you will change your mind 
very rapidly. This means you need to amend your outline rapidly without creating a mess. For 
best results, use Microsoft PowerPoint (or LibreOffice Impress) in outline mode. This allows 
you to move the topics up/down, insert new topics in the list, delete them, edit the text, etc. 

This “top-down” method will save you from a writer's block and also help you stay focused on the 
main subject, and prevent you from straying into unrelated topics. 

Next, think what material you need for each of the lowest-level topics: images, icons, screenshots, 
or a live screen-capture with annotation, etc. Make a note of this against each topic.  
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For best results, write the script for each topic (what exactly do you want to convey?)  

Optionally, create a visual storyboard to bring more clarity. (Note: A Storyboard is more useful in 
creating a video rather than for creating documents.) 

Note that your preparations so far have nothing to do with ActivePresenter or any other tools! 

Identify Your Sources For Presentation 

Now that you are clear about your success factors and ready with an outline and storyboard, 
the next step is to think about how to create the content for that presentation. 

A major part of your presentation would be created by capturing the “live” action of the target 
application as you interact with it. 

In addition, you may already have some resources that can be readily used in your presentation: 

 PowerPoint presentations 

 Images/photos/screenshots 

 Video/audio clips 

In your outline and storyboard, mark the places where each of these resources would be used. 
This completes the visualization of your project. 

Selecting The Content-Generation Method 

Typically, only one of these sources plays a predominant role in your presentation: 

1. Screen action of a target application captured “live”. 

2. A PowerPoint presentation. 

3. Slide show created from multiple images. 

4. Start with a blank project, and add images, video clips and other ActivePresenter projects. 

With this in mind, ActivePresenter lets you launch four different types of projects, each suited for a 
particular content-creation approach. Later, in the Edit phase, insert the content of other types 
wherever required. 

However, if your project uses multiple types of resources in equal proportions, launch a different 
project type for each type of resource. Finally launch a blank project and add all those projects into 
it, to create the final presentation. 

Regardless of the project type (i.e., primary method of generating the content), the resultant 
presentation has to be edited using a common process, as described in the next chapter. 

In this chapter, we will see how to launch each type of project. 

When you launch ActivePresenter, the Welcome Screen appears in the ActivePresenter window 
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as shown below: 

 

At the bottom, there are links to the Facebook and Twitter sites of ActivePresenter.  

The YouTube link takes you to the latest demo videos that explain how to use new features that 
appear in each new version of ActivePresenter. 

The screenshot shows highlight on two options (New Capture and New project). Both are for 
creating a new project. The difference is, the New Capture option starts capturing the screen, 
whereas the New Project option offers all four methods to choose from. By clicking on the New 
Project link, you can launch any type of project. 

We will see how to launch each type of project in the following sections.  

Creating A Capture Project 

This is the first (and most prevalent) content-generation method. This type of project captures 
the “live” action on the screen while you are interacting with the target software. Typically, your 
mouse and keyboard actions would also be captured.  

In the Welcome Screen, select the New Project option. 

Immediately, the screen will vanish, to be replaced by a second window, as shown below: 
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The different parts of the screen work as follows: 

1. This section offers the four methods of launching a new project.  
The “Capture” method is selected by default. Leave it selected. 

2. In this section, give a name to the new project and select the folder to store it.  

Remember that if you plan to insert any videos in this project, the disk must have enough 
space for those videos apart from the captured project's size. 

3. This section lists the four profiles of capturing: 
Record Software Demonstration, Record Movie/Streaming Video, Smart Capture with FMR 
and Smart Capture. 

At this time, we will select the Record Software Demonstration capture profile (the 
appendix explains how to select or create an appropriate profile for a given purpose).  

The controls at the right allow you to edit these default capture profiles and even create 
your own profiles. Refer to appendix for details. 

When you press OK, ActivePresenter now needs to know the area of the screen is to be captured 
and other settings for the new project. 

Since the actual capturing is just one step away, your target application must be running at this 
time. (If not, launch it now, and re-size its window as desired.) 

ActivePresenter displays the following window: 
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The screen has three parts: 

1. The Capture Area section allows you to specify a region on computer screen to capture.  

2. The Audio Input section contains options for recording audio in the capture session. 
ActivePresenter supports recording system audio and Microphone (or another audio input 
device) simultaneously. 

3.  On the very right of the window, a Start Capture button (the big red one) is provided, and 
at the bottom-right corner of the window is the More Options... button. 

Let us see how these sections work: 

The Capture Area Section 

This section include two main options are described below:  

1. The Custom option allows you to select any rectangle region on screen to capture.  

 

In this mode, a floating green rectangle shows the capture area. (The fancy cross-hair in 
the middle is just a visual reminder that this is a target-seeker window.) 

ActivePresenter will capture only the screen enclosed in this frame, and ignore the rest of 
the screen. You can drag this rectangle around, and re-size it as desired by dragging on its 
handles (the tiny gray squares on its border).  
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You can specify an arbitrary size to capture by entering the width and height consequently 
into Size spin boxes. You can also quickly set the capture size by using the Preset sizes 
button (the down-arrow next to Size spin boxes). The Preset sizes button offers some most 
popular video sizes. You can also add your preferred sizes to the list of preset sizes. 

The Lock to application check-box allows you to select a running application window 
listed in the underneath box to snap into the capture area. The Change Lock Mode button 
next to the list of applications box provides two options to define the snap behavior. The Fit 
To Application option will resize the capture area to fit into the window of application when 
the application is selected. The Fit To Boundary option will resize the window of 
application to fit into the capture area when the application is selected. 

2. The Full Screen option provides a quick way to select the entire screen to capture. This 
mode allows you to temporarily change the resolution of the screen before doing the 
capture and automatically revert to the previous setting when you finish the capturing. 

 

The Audio Input Section 

ActivePresenter allows you to record the system audio and one other audio input device 
simultaneously. Recording the system audio and Microphone at the same time is the most 
common in practice. 

 

The Device box shows the list of audio input devices detected. If you want to record the audio from 
your Microphone, let select it in this list. On some computer, selecting Stereo Mix, What U Hear, 
Wave Out, Playback will also record the system audio but using Record System Audio check-box 
is much easier. 

The Volume slider displays the input audio signal level for the audio input device selected in the 
Device box. You can also change the input volume level of selected audio input device with this 
slider. For example, you are selecting the Microphone as the input device and speaking something 
on Microphone to test. If the Volume slider displays the signal in red color, you should reduce the 
input volume value, otherwise the audio quality will be low because the signal is clipped. 

The Record System Audio check-box allows you to select recording the system audio while 
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capturing screen. If ActivePresenter cannot detect the way to record the system audio on your 
computer, this check-box will be disabled. Note that on Windows Vista or later, the system audio 
and audio recorded from selected device in Device box are independent from each other so you 
can see two audio objects in recorded project. While in Windows XP, they are dependent so there 
is only one audio object in recorded project.  

You may also wonder why there is no volume slider for system audio. There are some reasons for 
that. The volume of system audio can be changed easily by clicking the sound icon on the very 
right of the taskbar so we did not add it to avoid flooding the user interface. In additional, you can 
always change the volume of recorded audio in the editor by using the Adjust Volume tool in 
Timeline. 

The Start Capture and More Options... Section 

 

The Start Capture button is a big button with the red color. Click on this button to start a capture 
session. 

The More Options… button provides the following options: 

1. Select Audio & Video Settings to launch the Capture Profile Editor, where you can 
change the settings for audio and video. 

2. Select Calibrate Audio Input... to open the Calibrate Audio Input dialog which allows you 
to turn the audio input volume automatically or manually. 

3. If Show Recording Toolbar option is selected, ActivePresenter pops up a toolbar with all 
controls necessary to start and stop the recording, and adjust the sound level. The large 
counter shows the duration of the recording. 
 

 
 
Note: If this toolbar is placed inside the capture area, it is also captured, so please be 
careful when placing this toolbar on screen. For this same reason, this toolbar should not 
be used when you capture full screen. 

Once you are satisfied with all settings, click on the Start Capture button (the big red button). 

Now ActivePresenter hides in the system tray and captures the target application.  

Work with the target application as usual.  
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After you have finished the action to be captured, click on the  button in the system tray. This 
action pops up the ActivePresenter recording pane.  

 

You have now the following options: 

1. Click on the Pause button to pause the recording.  
The idea is to skip recording for a while and resume later. 

2. Click on the Stop button.  
This ends the recording, and lets you edit the recorded project. 

3. Click on the Discard button. 
This aborts the current recording and discards the recorded project. 

When you press the Stop button, ActivePresenter automatically enters edit mode. The editing 
techniques are described in the next chapter. 

Creating A Project From PowerPoint 
Presentation 

This is the second content-generation method, where slides from a PowerPoint presentation are 
used instead of recording the target application.  

We will again launch ActivePresenter, and on the welcome screen, select the New Project 
option. 

A New Project window pops up. 
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Enter the following details: 

1. Select the Import PowerPoint option. 
The right side of the window changes as shown above. 

2. In this section, enter the project's name, and also select the folder where the project is to be 
saved. 

3. In this section, select the PowerPoint file from where the slides are to be imported. 

Note that ActivePresenter cannot handle the odp files used by OpenOffice and LibreOffice. 
Therefore, you will have to save these files as pptx first, and then import them into ActivePresenter. 
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ActivePresenter pops up an Import PowerPoint Presentation window. 

 

This window offers the following two options: 

 Import Slides as Backgrounds: Each slide turns into a background image for a 
corresponding slide in ActivePresenter project. All the separate objects in the pptx slide will 
be flattened into one image, and you cannot manipulate/animate them. But can add 
annotations in the ActivePresenter project. 

 Process Objects in Slides: All the objects present in each slide are imported in the 
corresponding ActivePresenter slide. You can manipulate these objects and then annotate 
the slides in ActivePresenter. 

Remember that by default, none of the slides are selected. If you do not select any slides, nothing 
will be imported into ActivePresenter. 

You can select multiple slides by pressing SHIFT and CTRL keys as you click on the slides. Or 
else just click on the Select All button. 

Once you are satisfied with the slide selection, click on the OK button. 

This imports the pptx file into ActivePresenter. 

The next step is to edit this project. The editing techniques are described in the next chapter. 
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Creating A Project From Images 

This is the third content-generation method, where images are used to create slides in 
ActivePresenter, instead of recording a target application. 

We will again launch ActivePresenter, and on the welcome screen, select the New Project 
option. 

A New Project window pops up. Select the Image Project option. Immediately the right side of the 
window changes to show the relevant options, as shown below: 

 

The various parts of this window work as follows: 

1. The Image Project option 

2. In this section, select a name for the new project. Also the folder where the project is to be 
saved. 

Keep in mind that a copy of all images will be saved in the project folder (and also any 
videos you may add to the project later). The disk must have enough space to 
accommodate these items. 

3. In this section, select a size for the project's canvas. The Preset sizes button offers 
multiple popular video sizes (including the VGA, 720p and 1080p). 
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While selecting the canvas size, keep in mind the size of images you would be using. If the 
canvas is too small for the image, the image will be clipped. 

You can re-adjust the canvas size after inserting all the images. (ActivePresenter displays 
the size of all images, which makes it easy to find the largest height/width and set the 
canvas size accordingly.) 

4. This section lets you insert images. 

First click on the  button to insert an image. This pops up a browse window. You can 
navigate to the desired folder and select an image file. 

The list of all images appears in the left pane, as shown. Note that ActivePresenter displays 
the size of each image. This lets you adjust your canvas size to fit the largest of the images 
(to avoid clipping). 

To remove any image from the list, click on it and then click the  button. 

To change the order of the images, select any image and then click on the  or  buttons 
to move it up or down in the list. 

ActivePresenter shows a preview of the selected image in the right pane. You can flip or 
rotate the image using the four buttons at the bottom of the right pane. 

If you select the Use images as objects option, each image will be inserted on a different 
slide as an object. But if you do not select this option, then ActivePresenter will place each 
image as the background of each slide. 

5. Click the OK button. A new project is launched, with all the selected images. 

The next step is to edit this project. The editing techniques are described in the next chapter. 

Creating A Blank Project 

This is the fourth content-generation method, where you get a blank canvas. 

Now wait a minute! Why would you need a blank project (without any content)? 

The answer is, to create a “hybrid” project, that has a bit of everything: Slides from other 
ActivePresenter projects, images, video/audio clips, etc. 

To launch a blank project, launch ActivePresenter, and in the welcome screen, select the New 
Project option. 

A New Project window pops up. Select the Blank Project option. Immediately the right side of the 
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window changes to show the relevant options, as shown below:  

 

The various sections of this window work as follows: 

1. The Blank Project option 

2. In this section, select a name for the new project. Also the folder where the project is to be 
saved. 

Keep in mind that you are likely to insert a wide variety of objects (images, video clips, etc.) 
in a blank project. All these files will be saved in the project folder. The disk must have 
enough space to accommodate these items. 

3. In this section, select a size for the project's canvas. The Preset sizes button offers 
multiple popular video sizes (including the VGA, 720p and 1080p). 

Keep in mind the largest item you would be inserting in the project, and adjust the canvas 
size accordingly. 

4. This section lets you insert any number of slides. This is just for convenience: You can add 
new slides at any time later. 

5. Click the OK button to launch the project. 

Since this type of project does not have any content, all content has to be added using editing 
techniques described in the next chapter. 
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Saving A Project 

You can save a project by clicking on the  button in the Quick Access Toolbar, or using the 
CTRL+S shortcut, or use ACTIVEPRENSER > Save. 

Note that when you save a project that was created with an older version, ActivePresenter 
automatically saves it in the new format. Such files cannot be opened with the older version of 
ActivePresenter. However, most users use the latest version of ActivePresenter, so usually this is 
not a problem. 

ActivePresenter warns you when you try to save such a project: 

 

Closing The Project Without Saving 

When you try to close a project, ActivePresenter checks if there are any changes vis-a-vis the last 
saved version. If so, it will alert you whether you want to save the changes made to the project. 
Just select No.   

Shrinking A Project 

Often a project has many unused resources, including some new resources that you create 
during the course of the project. 

You may choose to get rid of those unused resources and reduce the size of the project. 

Use the ACTIVEPRESENTER > Shrink Project option. 

A window pops up: 
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This sample shows that there are three unused resources. 

You can select the Delete all unused resources check box and click on the Shrink button. This 
removes the unused storage space and reduces the file size on disk. 

You also have the option to manually check all the unused resources before deciding whether to 
delete them. In fact, if this is a new resource created within this project, you may want to export it 
as a file, to create an asset for yourself. In that case, click on the Delete Manually button. 

This pops up another window: 

 

You can also click on the Select unused resources  button (1). ActivePresenter will select all 
such resources (2) for you. Check them out visually and decide whether you would like to save 
(export) them. 

 Pressing the  button in the Image tab exports all selected images at once. 

 Pressing the  button in the Audio and video tab exports all selected audio/video 
resources at once. 

 Remember that if you don't export any unused resource, it will be lost when you shrink the 
project. 

Opening An Existing Project 

You can open an existing project in various ways: Press CTRL+O, or use the 
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ACTIVEPRESENTER > Open menu option, or click on the  button in the Quick Access 
Toolbar. 

You can also click on the Open option on the Welcome Screen that appears when 
ActivePresenter is launched. 

All these options allow you to browse your folder system to select a project file. 
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Editing A Project 

The previous chapter describes how to create a new project by capturing an application, or by 
importing slides from PowerPoint file, or by importing images. (As discussed, each “type” of project 
refers to what kind of content is added to the project.) Finally we saw how to combine these 
different types of projects into a blank project. 

At this point, the captured content is “raw”, and usually not presentable to your target audience. 

In fact, the content may not be even complete, because each project type can only capture only 
one type of content. You have to add the other types of content to complete the project. 

The real value-addition comes only when we edit the project to add annotations (shapes, 
audio/video clips, voice narration, closed captions, etc.), and (optionally-) make the presentation 
interactive. 

All this is done in the edit phase of the project. These editing techniques are common for all types 
of projects. 

The following sections show how to edit a project. 

The Editing Process 

All editing is done in the program window, which pops up automatically when- 

1. You finish creating a new project, or- 

2. You open an existing project. 

The project is edited in three distinct steps: 

1. Project-level editing: Since the project is made up of slides, we essentially deal with slides 
in this step – Sort the slides in the correct order, remove redundant slides, get slides from 
other projects, name all slides, and add new slides to bridge a gap in the presentation. 

This is the stage where you populate a blank project by inserting slides from other project 
types. 

This is also the stage where you can insert the non-predominant type of content in any 
project (for example, in a capture type project, you can add slides from PowerPoint or 
images). 

2. Slide-level editing: In this step, we fine-tune each individual slide. Since a slide is made 
up of objects, we essentially deal with objects in this step – Insert objects (shapes, text, 
interactions, video clip, audio clip, highlight, closed captions, etc.), and add voice over 
(commentary). 

Next we adjust the properties of each object, both in the Canvas pane and also in the 
Properties pane. 

Then we preview the slide, and adjust the objects on the Timeline pane (adjust the timing 
of its entry/exit and also manipulate its sequence amongst all objects of the slide). 
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Finally we play each slide separately and optimize it by adjusting all objects one final time. 

3. Advanced editing: 

 Making the project interactive: This involves inserting questions, and also adding 
actions that deal with correct and incorrect responses from the viewer. 

 Making the project accessible: This means making the project available to as 
many people as possible. More specifically, we edit the project so that viewers with 
disabilities can perceive, understand, navigate, and interact with the project output. 

 Localizing the project: Here, we adapt the project to a particular language, culture, 
and desired local look-and-feel. 

The following sections provide more details of these steps. 

Remember that if you commit any mistake, you can reverse any number of steps by pressing 
CTRL+Z for the required number of times. And in case you have pressed CTRL+Z too many times, 
you can cancel them by pressing CTRL+Y (called “re-do” operation).
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Project-Level Editing 

As mentioned before, this is the start of the edit cycle, in which we take a bird's eye view at the 
project and make coarse adjustments. 

Naming The Slides 

Before you can do anything, you must name the slides based on their function. This helps in the 
next step of sorting the slides, and later inserting navigational controls (for example, to enable 
jumping to a particular slide, etc.). 

To name a slide, follow these steps: 
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1. In the Slides pane, select the slide that you want to modify the name. 

 

2. Go to the Properties pane and click in the Name field and type a new name. You can also 
use some simple HTML tags (<b>, <i>, <u>, <span>…) to format the name of slide. Press 
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ENTER to confirm the change. 

 

3. If you want to format the name of slide in a visual way, you can click the button on the right 
of the Name field to launch the HTML editor. The editor contains the most common 
formatting functions to change the name of slide. After editing, click OK to confirm the 
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changes. 

 

Note that you can select multiple slides to rename at once. To rename a single slide, you can also 
double-click the slide in the Slides pane in the Titles mode (right-click the Slides pane and select 
Slide In Titles) to launch the HTML editor. 

Sorting The Slides 

Now that the slides are named after their function, it is easier to recognize them in a list. 

In the Slides pane, right-click the pane and select Slides In Grid or Slides In Column. Here, you 
can drag-n-drop any slide to a new position.  

As you drag the slide over the other slides, they move aside to make space for it. If you release 
LMB, the slide will drop in the gap below. 
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The current slide is highlighted in orange, as shown above. Also note that while a slide is dragged, 
it retains its original sequence number (in this example, 1). In case you change your mind, this 
number will help you remember where to drop it back. 

Once in a while, switch to the Titles tab to check if all slides are ordered correctly. 

Note that the Slides pane has three view modes and you can right-click the pane to switch to one 
of them: 

1. The default mode is Slides In Column in which the thumbnail of slide expands its size 
to fit the available width of the pane. 
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2. The second mode is Slides In Grid in which the slides are arranged into multiple 
columns and rows. 

 

3. The third mode is Slides in Titles in which the pane only displays the names of slides. 
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Inserting Slides 

At this stage, you are likely to find that the presentation has some gaps in it. ActivePresenter 
allows you to insert additional slides using the following techniques: 

1. Insert blank slides and then insert any desired elements in them 

2. Create new slides by fresh screen-capturing 

3. Create new slides by importing images 

4. Copy slides from another ActivePresenter project. 
(Either an archived project, or a project where you inserted content of different type.) 

5. Create new slides from a PowerPoint file 

These options are described in depth below. 

Inserting A Blank Slide 

A blank slide acts as a blank canvas (a placeholder) for other objects.  

For example, if you want to add an image, video or audio clip in a project, you need a slide.  

Now this slide can be an already existing slide (one that already contains other objects). But 
usually objects like a video clip do not share screen space with other objects (unless you want to 
show the video in a part of a screen, like Picture-in-Picture). Therefore you need a blank slide. 

Some important uses of a blank slide are as follows: 

1. Make the title of the presentation 

2. If you have divided your presentation in different chapters/topics, make title of the chapters. 

3. In a long presentation, insert “coffee break” slides. 
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4. At strategic points during the presentation, insert blank slides to allow audience 
participation. 

5. At the end of the presentation, insert an “Any questions?” slide. 

6. The final “Thank you!” slide, with your corporate logo and address. 

7. Insert an external video 

8. Insert two comparative videos side by side and run them in parallel 
(e.g. a “before vs. after” comparison, a “wrong vs. right” demo)  

To add a blank slide: 

1. Click HOME > Blank Slide  or SLIDES > Blank Slide . The new slide is inserted after 
the current slide. ActivePresenter keeps displaying the current slide. You may switch to the 
new slide manually. 

2. In the Slides pane, right click on an existing slide. From the context menu that appears, 
select the New Blank Slide option.  

Inserting New Slides By Fresh Capturing 

This technique is mainly used when your primary project was created using either from 
PowerPoint or Images, and now you want to add complementary slides by capturing the “live” 
action on screen while operating a software. 

This is equivalent to launching a new Capture project, but with the difference that the newly 
captured slides are inserted in the current project, rather than opening up a new project.  

The new slides from this instant capture project are inserted after the current slide. 

To insert slides by fresh capturing: 

1. Click HOME > Captures Slides  or SLIDE > Capture . 

2. The procedure in the next steps is same as launching a new capture project. 

Inserting Images As Slides 

This technique is mainly used when your primary project was created using either from 
PowerPoint or Capturing; and now you want to add complementary slides by inserting images as 
slides. 

This is equivalent to launching a new Image project, but with the difference that the newly created 
slides are inserted in the current project, rather than opening up a new project.  

The new slides from this instant Image project are inserted after the current slide. 

To insert slides from images: 

1. Click HOME > Slides From > From Images…  or SLIDE > Images . 

2. The procedure in the next steps is same as launching a new Image project. 

Inserting Slides From Another Project 

This technique is mainly used when you have launched a Blank project, or if you want to add 
complementary slides in an existing project of any type. 

Often the slides you want are already available in other ActivePresenter projects. All you need to 
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do is to copy those slides and paste them to the current project at the appropriate places. 

Here is the procedure: 

1. While the current project is opening, open the other ('donor') project. 

2. Now select desired slides from the other project and press CTRL+C (or use the HOME > 
Copy tool). This places the selected slides into the clipboard. You can select multiple slides 
by using SHIFT+Click and/or CTRL+Click. 

3. Now switch to the “home” project, and in its Slides pane, click on the slide after which you 
want to paste the copied slides. 

4. Press CTRL+V (or use the HOME > Paste tool). This pastes the slide after the current slide 
in the “home” project; along with objects, background, slide properties and all resources 
that are referenced by the “source” slide and its objects. 
Note that the imported slides and their objects always keep their original sizes and 
positions (they are not rescaled to match the home project). If the donor project and the 
home project do not have the same canvas size and/or resolution, some imported objects 
may lie outside the slide canvas. Therefore always check all imported slides and edit them 
as necessary. 

5. Repeat steps 2-4 for other slides. 

6. Close the 'donor' project. 

7. Repeat this with other 'donor' projects to import more slides from them. 

Inserting Slides From A PowerPoint Presentation 

This technique is mainly used when your primary project was created using either from Images or 
Capturing; and now you want to add complementary slides by inserting a PowerPoint 
presentation. 

This is equivalent to launching a new PowerPoint project, but with the difference that the newly 
created slides are inserted in the current project, rather than opening up a new project. 

The new slides from this instant PowerPoint project are inserted after the current slide. 

To insert slides from a PowerPoint Presentation: 

1. Click HOME > Slides From > From PowerPoint…  or SLIDE > PowerPoint . 

2. The procedure in the next steps is same as launching a new PowerPoint project. 

Removing A Slide 

To delete a slide, select it in the Slides pane and press DEL.  

 For deleting, you can also right-click the Slides pane and select Delete menu option. 

 To delete multiple slides at a time, select those slides by using CTRL+Click and/or 
SHIFT+Click, and then delete them. 

There are a number of reasons for discarding a few slides: 

1. The presentation is too long. 

2. Some slides repeat/paraphrase/stretch the same contents.  
Remember: In the world of presentations, less is more! 

3. Some slides are irrelevant for the current presentation. 
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But always remember that you need not throw them away on a permanent basis. Indeed, you may 
find them useful on another occasion! 

Here are a couple of tricks to solve this dilemma: 

1. Save a backup copy of project, and then start deleting the slides. Effectively, you will be 
creating two different versions of the same presentation: one full version, and a few 
abridged versions. 

If you want to follow this approach, it would be best to do this at the very end of the project, 
where you have edited all slides. Otherwise you will end up editing the same slides for each 
version. 

2. Create a master repository project that holds all slides on a given subject. 

As you create new content, keep adding it to the master project. Reorganize the slides from 
time to time. 

Whenever you need to create a new project, start by taking a copy of this master project, 
and then trim it ruthlessly.  

Editing Project Properties 

Project properties fall in three categories: 

1. Properties of the project, such as size of the canvas, total number of slides and the total run 
time for the presentation, the size of the project file, the date on which the project was 
created and last modified. This information is provided by ActivePresenter and is non-
editable. 

2. Properties that you can edit, such as the author's name, and any remarks that you may 
wish to attach to the project's file (such as client name, conference detail, the type of 
outputs for this project, etc.)  

3. The JavaScript code which is executed when loading the project. You use this property in 
the case that you want to extend the capability of HTML5 output. 

To see the project properties, click the ACTIVEPRESENTER > Project Properties... menu option.  

The following window pops up: 
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You can do the following: 

1. Enter a meaningful project name  
(This may be a combination of subject and client. You should define your project-naming 
scheme beforehand) 

2. Enter description for the project. 

3. Click on the triangle, and from the palette widget that appears, select a color. This changes 
the background color for the slides. 

4. Specify the language of editing project. ActivePresenter will use the corresponding 
translation of selected language to display in the output (name of elements of toolbar and 
messages in Flash and HTML5 Simulations) if the language is supported in 
ActivePresenter. For other languages, you can still modify the texts in output by using 
Output Language Editor. 
The Project Language is also important if you want to support the language which has 
special layout or representation such as the right-to-left languages (Arabic, Hebrew…). 

This is global setting that affects all slides, but if a slide already has a background image, it won't 
be affected. 
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On the Author tab of this window, enter all your details. 

 

You can also enter a password for opening the project file. Once you set the password, you can 
only open the file if you enter the password. 

This is useful if you have to leave the project file on a public computer where others may fiddle with 
it. 

Note that this feature is not meant to provide a bullet-proof security. As with any security system, 
given enough time, someone will manage to break in. 

On the Event tab of this window, you can enter the JavaScript code which is executed when 
loading the project. 

http://atomisystems.com/tutorials/


ActivePresenter User Manual  Version 5.5 

Editing A Project> Editing A Slide 62 

 

Editing A Slide 

So far we have collected all the slides we want; and more importantly, discarded the ones we don't 
want. 

This is the right time to fine-tune each slide, by- 

 Modifying the properties of the slide. 

 Adding objects to the slide and editing and arranging them 

 Adding a narration (voice-over) 

Occasionally you will realize that you still need a few slides here and there. This is natural. Just go 
back to the previous step to add those slides and then return to this step. 

Let us see the details. 

Slide Properties 

When a slide is selected, the Properties pane displays the properties of the slide which are listed 
below: 
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Property Default 
value 

Remarks 

Name Blank Title of the slide or Slide Name. This property will be used as a table 
of content (TOC) entry in HTML5, Flash Simulation outputs or as a 
brief description of slide in document outputs. 

When planning navigational jumps amongst slides, their titles are 
also very useful.  

Base it on the content of the slide. 

Description Blank Your comments about the content. While exporting the project to 
document formats (PDF, MS Word, Excel, PowerPoint), you can 
choose whether to export slide description. For example, if you plan 
to present the slides personally, you can enter your speech 
associated with the slide in this field (equivalent to the “Notes” field in 
PowerPoint).  

Group Title Blank For creating groups. Slides with the same group title will 
automatically belong to the same group. (ActivePresenter does not 
have a separate mechanism to define slide groups.) 

Take care in entering names: A small spelling change will put the 
slide in a different group! (White spaces also count.)  It's better to 
select several slides and change group title at once in Properties 
pane. 

This is used if you export the project to document formats (PDF, 
Word, Excel) in compact mode. In compact mode of export, only one 
image is exported for each slide group.  

Show In Slide 
List 

Show – 
Continue 
Numbering 

This property is only used in HTML5 and Flash Simulation outputs. It 
specifies how the Slide Name displayed in Slide List (TOC). You can 
set the Show In Slide List property to one of following: 

1. Hide: The Slide Name is not displayed in TOC. 

2. Show – No Numbering: The TOC displays the Slide Name 
without a prefix order number. 

3. Show – Continue Numbering: The TOC displays the Slide 
Name with a prefix order number which follows the value of 
previous slide. 

4. Show – Restart Numbering: The TOC displays the Slide 
Name with the ‘1.’ before it. 

Timing & 
Transition 

 Set the duration and the transition effect of slide. 

Duration 5000 ms You can set the duration of each slide in milliseconds. This duration 
is represented as a slide bar in Timeline. 

Note that you can also set the duration of the slide on the Timeline 
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(by moving the red tick on slide bar). 

This is only the default value to start with: If any object in a slide ends 
after this time limit, ActivePresenter automatically extends that slide's 
duration to display all objects. 

Transition None This is the visual effect when the presentation enters this slide. 

Select from None, Fade In, Fly In and Wipe. 

Background  Set the background image and the background color of slide. 

Background 
Image 

None Slide background in ActivePresenter is mainly used for the image of 
a step (where to click, what key is pressed) in interactions chain 
when creating software tutorials. A background image can also be 
used for other purposes, such as show a corporate logo throughout 
the presentation, set different backgrounds for different 
segments/subjects of the presentation, show a theme, etc. 

Click button to edit the background image. 

Background 
Position 

0,0,0,0 There are four parameters here: 

1. x-offset from top-left corner (default=0) 

2. y-offset from top-left corner (default=0) 

3. Width of the background image 

4. Height of the background image 

Changing the width and height scales the original image.  

Background 
Color 

Project's 
settings 

The part of canvas that is not occupied by the background image 
takes this color. By default, all slides of a project has the same color. 
But you can change the background color of any slide. Click and 
select from the available palette of colors.  

Accessibility  Define properties that make the slide accessible by viewer with 
disabilities when viewing the project output. 

Auto Label  If this property is selected, accessibility text will be generated 
automatically from the slide name and slide description. 

Name  Accessibility name of the slide. Screen reader will read this text aloud 
when the slide appears. 

Description  This provide more information about the slide. Screen reader will 
read this text aloud when the slide appears, after reading the 
accessibility name. 

Event  The JavaScript code which is executed when loading the slide. 
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Inserting Objects 

ActivePresenter allows you to annotate the slide by adding a large variety of objects. 

Appendix Objects provides the details of each type of object, and how to use it. 

Arranging The Objects 

After inserting the objects in a slide, you will have to arrange them in some logical manner. For 
example, you may want to create a flowchart out of shapes and arrows. Or add annotations to a 
captured video (see examples below). 

This is achieved by moving the objects around in the canvas and placing them exactly where you 
want. For example, in the examples above, I want all shapes in my flowchart to be centered on a 
vertical line. I want to place a red circle around a minaret of the Taj, and a call out to point at the 
dome of the Taj. 

You may also have to place some objects overlapping over others (typically, all annotations 
overlap on a video or image). 

Although this free placement generally works, you will often need to arrange the objects accurately. 
For example, to create a flow-chart.  

You may also need to select multiple shapes and make their sizes uniform. 

ActivePresenter offers you the following tools: 

1. Align (snap) objects with each other 

2. Aligning all selected objects with a reference object 

3. Resizing all selected objects to the size of a reference object. 
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4. Changing the layers (z-order) of objects 

The following sections show how this is done. 

Basic Movement Of Objects 

You can move objects individually or in groups. 

To move an individual object, you have the following options: 

1. Drag the object with mouse, and release the LMB when the object is placed properly. 

2. Click on the object. Now move it by using the Arrow keys. 
Pressing CTRL at the same time accelerates the movement by a factor of 10. 

To move a group of objects together, you have to first form a group. For this, draw a lasso with the 
mouse or CTRL+Click on all objects (if you CTRL+click on a selected object, it gets deselected).  
Now move the group just like you move an individual object (see above). 

Object Rotation 

You can rotate almost slide objects in ActivePresenter except: Feedback, Spotlight, Gesture 
Effects, Zoom-n-Pan, Cursor Path, and Closed Captions. You can rotate multiple objects at once. 

There are two ways to rotate an object: 

1. Select the object then drag the rotation handle of the object on the Canvas pane. 

2. Select the object then change the Rotation property in the Transform section in the 
Properties pane. 

 

Note that due to the limitation of Internet Explorer 7 and Internet Explorer 8, the rotation property of 
objects will be ignored when viewing the HTML5 output on these browsers. 

Aligning Objects With Each Other (Snapping)  

ActivePresenter has a snap mode for the Canvas pane.  

You can toggle this mode by using the VIEW > Canvas snapping. 

When this mode is turned on, when the dragged object (or group of objects) come close to an 
edge, ActivePresenter shows an orange line connecting the dragged object/group and the target 
object. The dragged object/group will also make a tiny jump to align itself with this orange line. 
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If you drop the object/group, it aligns perfectly with the reference edge. You may also choose to 
continue dragging the object/group. 

In the following example, the green diamond (B) is being dragged. We will see what happens when 
it comes in the vicinity of the yellow rectangle (A). 

 

As shown below, when the diamond comes close to the rectangle, ActivePresenter shows an 
orange line, and snaps the diamond to it. 

 

Once the objects snap to a guiding line, you can slide the dragged object along this line. Despite 
small shakes of your hand, the object will stay locked to the line. 

If you are not looking for this particular alignment, just ignore this present orange line and continue 
dragging. As soon as a threshold distance value is crossed, the orange line will vanish. 

When the snap mode is on, you can press CTRL during the dragging operation to temporarily turn 
the snap mode off. 

Aligning Objects With A Reference Object 

The last object selected is the reference object. This object does not move: Rather, all the other 
objects move (or re-size) to align to this object. Therefore, always be careful and select the 
reference object at the end. 

You can click one of the currently selected objects (without holding CTRL) to set it as reference 
object. 

To access the aligning objects tools, you can click HOME > Align or FORMAT > Align. 
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Icon Function 

 The top of all objects will get aligned vertically with the top of the reference object. 
Their horizontal position will not be affected. 

 The center of all objects will get aligned vertically with the center of the reference 
object. Their horizontal position will not be affected. 

 The bottom of all objects will get aligned vertically with the bottom of the reference 
object. Their horizontal position will not be affected. 

 The left side of all objects will get aligned with the left of the reference object. Their 
vertical position will not be affected. 

 The center of all objects will get aligned with the center of the reference object.  
Their vertical position will not be affected. 

 The right side of all objects will get aligned with the right of the reference object.  
Their vertical position will not be affected. 

 The entire group of object will move to the center of the canvas vertically.  
The relative position of the group-members will not be changed. 

 The entire group of object will move to the center of the canvas horizontally.  
The relative position of the group-members will not be changed. 

 Make the horizontal spaces between selected objects equal. 

(This command works only when more than two objects are selected.) 

 Make the horizontal spaces between selected objects equal. 

(This command works only when more than two objects are selected.) 

Resizing Objects To A Reference Object 

The following tools also work on a group of objects (again, the last-selected object is the reference 
object). To access these tools, you can click HOME > Align or FORMAT > Align. 

Icon Function 

 The height of all other objects is adjusted to match the height of the reference object. 

 The width of all other objects is adjusted to match the width of the reference object. 

 Both height and width of all other objects are adjusted to match the height and width of 
the reference object, respectively. 
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Setting The Z-Order Of Objects 

Imagine the slide canvas to be a horizontal surface (like a table top), where all the objects are 
placed one by one. When we place any object, it covers all the previously added objects if they 
happen to lie under it partly or fully. 

This vertical order of object-placement is called z-order (named after the z-axis, which is pointed at 
the viewer in this virtual 3D world). 

We can avoid overlapping of objects by spreading out the objects in the slide. 

However, sometimes we actually want to place the objects with partial/full overlap; to create some 
special effects. We may even apply shadows on some objects to stress that they are on top of the 
other objects. 

Sometimes, it is difficult to gauge which object is at the top (especially when they are not 
overlapping). Just keep in mind that the Selection pane always lists the objects by their order in 
the stack.  

 

 

In the example above, the diamond is at the top of the stack, and so the Selection pane puts it at 
the top of the list. The Cross is at the bottom of the stack, so the Selection pane lists it last. 

This fact will help you in assessing the z-order of objects even when they are not placed 
overlapping.  

To access the Z-Order tools: 
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1. Select the objects in the Canvas or Selection or Timeline pane (click on the name or on 
the Time Bar of the object). 

2. Right-click the selected objects and select the Display Order menu option, or click 
HOME > Order, or click FORMAT > Order. 

The following tools change the stacking order:  

Icon Name Shortcut Function 

 Bring to Front CTRL+Home Place the selected object at the very top of the 
stack. 

 Bring Forward CTRL+PageUp Send the selected object higher by one level in 
the stack. 

 Send to Back CTRL+End Place the selected object at the very bottom of 
the stack. 

 Send Backward CTRL+PageDn Send the selected object lower by one level in 
the stack. 

 

Removing Objects 

To remove an object, follow this two-step procedure: 

1. Select the object, by any one of the following methods: 

 In the Canvas pane, click on its outline, or- 

 In the Timeline pane, click anywhere on its row. 

 In the Selection pane, click anywhere on its row. 

2. Press the DEL key on the keyboard, or right-click and use the Delete menu option. 

Editing Objects 

The objects can be edited in different ways: 

1. Change the physical properties  
(position on screen, size, rotation, fill/outline colors, transparency, shadow, etc.) 

2. Change the text inside the object  
(especially text in questions, Text caption, closed caption, etc.) 

See Appendix Objects for details. 

Moving The Objects In Timeline 

In a presentation, the timely entry and exit of each object is all-important. 

Therefore you must adjust the time bar of each object very carefully, and play the slide repeatedly 
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to check whether the overall effect is exactly as you wanted. 

Refer to the Using The Timeline appendix to know how to manipulate the objects on the Timeline. 

Find And Replace Text 

To locate a word or phrase in slides (text in objects) and then replace it with another word or 
phrase, do the following: 

1. Click the HOME tab, then click Find  to find or click Replace  to find and replace the 
text. You can also use the keyboard by pressing Ctrl + F and Ctrl + H for these purposes. 

2. In the Find what box, enter the text you want to find and replace. 

3. In the Replace with box, enter the text you want to use as the replacement. 

4. In the Look in list, specify the scope to search, either Selected Slides or All Slides. 

5. Do one of the following: 

 To search for the next occurrence of the text, click Find Next. 

 To replace the currently selected occurrence of the text, click Replace. 

 To replace all occurrences of the text, click Replace All. 

 To cancel a search in progress, click Close. 

Removing Objects From Multiple Slides 

Sometimes you realize that you have made the same mistake in multiple slides.  

For example, while capturing the target application, you chose to record sound, but the final project 
does not need sound, or it got recorded poorly, and now you would like to remove the sound object 
from all slides. 

Rather than laboriously selecting each slide and deleting the sound, you have a shortcut: Select 
SLIDE > Batch Operations > Delete Objects.... 
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A window is launched: 

 

It has three sections, which are to be used as follows: 

1. What to delete:  
This section contains the master list of all objects. Select the ones you want to delete. 

2. Where to delete:  
In this section, identify the slides where you want this mass destruction to happen. (Be 
careful! You could delete objects from good slides as well!) 

In case you want to specify certain slides only, separate their numbers with comma. A 
hyphen indicates range. For example, the screenshot shows the range 3-6 (slide # 3, 4, 5, 
and 6).  

3. Additional Option:  
Check this if you also want to delete objects which have been set to show over multiple 
slides, normally these are background music or corporate logo.... 

Inserting Objects Into Multiple Slides 

This is the opposite of the situation described above: You may realize that multiple slides are 
lacking a particular object.  

To insert an object in multiple slides at once, select SLIDE > Batch Operations > Insert 
Objects.... 

http://atomisystems.com/tutorials/


ActivePresenter User Manual  Version 5.5 

Editing A Project> Editing A Slide 73 

 The following window opens: 

 

This is a two-step process: 

1. The Object Type drop-down list offers all available types of objects. Select the type of 
object to be inserted. Then click the Settings... button to adjust the properties of the 
selected object type. 

2. Select the slides in which to insert the object. 

In case you want to specify certain slides only, separate their numbers with comma. A hyphen 
indicates range. For example, the screenshot shows the range 3-6 (slide # 3, 4, 5, and 6).  

Note that the inserted object will have its default properties in all slides. You will have to edit the 
properties of the object in each slide separately. 

Changing Object Style In A Batch-Operation 

ActivePresenter also has a batch-operation to find and replace any given object style with another. 
Use the SLIDE > Batch Operations > Change Style for Multiple Objects menu option. 
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The window has two parts: 

1. Select the style to be replaced, and the style which should take its place. 
You will need to define the replacement style in advance. 

2. Select the slides where you want this effect. 
You can select all slides, current slide or specific slides. 

The check box at the bottom includes objects that are shared over multiple slides. 

Changing Object Transitions In A Batch-Operation 

The transitions of an object is a matter of personal taste. Therefore, you may have set the 
transitions according to your taste. Now suppose your boss does not like it. How to change them 
now? 

Worry not! ActivePresenter helps you to change the transition effects in all objects (or only for the 
selected objects) in one stroke, using a batch operation. 

Use the SLIDE > Batch Operations > Change Transition Effects for Multiple Objects menu 
option. 

A window opens: 
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It has three sections, which are to be used as follows: 

1. Select the transition effects (entry and/or exit) from the drop-down list, and set the timings 

2. Select the objects to which this transition is to be applied. 
The Select all check boxes at the end allow you to select and deselect all objects in each 
list. 

3. Select the slides where you want this effect. You can select all slides, current slide or 
specific slides. 

Remember that you can use this window several times to apply different settings to different sets of 
objects. 
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Undo 

If you make a mistake, you can reverse the effect of the last step by pressing CTRL+Z (or by 
selecting the Undo tool in Quick Access Toolbar). 

In fact, you can undo any number of steps by repeating this. 

Note that you cannot undo a particular past step selectively (for example, you won't be able to 
undo only the fourth-last step.) 

Redo 

If you try to Undo several steps, you are very likely to Undo a step that is actually needed. But 
typically you will realize this mistake only when you see results that you didn't expect. 

One option is to repeat what you did last time. But that requires too much of effort. Besides, you 
may not achieve the exact same result as the last time. 

So a better option is to retrace the last step that you rolled back. That's why it is called “Redo” (Re-
do = Do it again). 

You can Redo all the steps that you just rolled back, provided that you don't do anything after that 
last Undo operation: If you take a new step just after rolling back (=Undoing) some steps, then the 
Redo queue is emptied. 

Previewing A Slide 

Now that we have inserted all objects and customized slide properties, the slide is ready for 
presentation.  

But the proof of the pie is in the eating. If the slide does not look good when played, we need to 
edit it further. 

So play the slide by pressing the spacebar or clicking on the  button on the Timeline pane. Go 
on editing various parts till the slide plays perfectly. 

If everything goes well, move on to the next slide. 

Adding A Voice-over/Commentary (or Dubbing) 

Many presentations contain a voice over (commentary by an unseen person). This technique is 
mostly adopted for documentaries. 

ActivePresenter has a special recording feature that allows you to add a voice over. 

You can also use this feature for dubbing your presentation (adding the commentary in a different 
language than the original). 

A good sound track is critical for your presentation. 

Audio without a sound track (or with a poor audio) would create a very bad impression. Therefore, 
you must take utmost care of your sound track. 

Pay special attention to these five areas: 

1. Choosing a quiet and comfortable location 
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2. Eliminating (and preventing) any disturbing sounds 

3. Selecting your recording equipment 

4. Setting up your equipment correctly 

5. Tips for recording 

Let us see some details for each: 

Choosing A Quiet And Comfortable Location 

Record in a quiet location. Avoid recording in a public/shared location. 

If possible, you should be alone in the recording room, with complete silence prevailing. Place a 
"Silence please!" notice outside your door to let others know that you are recording. 

Avoid using a large bare room, as it produces echos. Placing furniture, books and curtains in the 
room absorbs the echoes. For best results, hang heavy curtains on walls also. 

Eliminating (And Preventing) Any Disturbing Sounds 

Most home/office areas do have ambient noises:  

 Noise of traffic on the road 

 Insects/birds 

 Music playing 

 Your colleagues/friends/family talking (or yelling) to each other or on phone 

 Wind noise (or air blown by an overhead AC vent) 

 Creaking of your chair when you move 

 Pets/children making a noise 

 Humming of your PC fan (or an overhead fan) 

Normally we are not aware of these constant noises, because our brain tunes them out naturally. 
However, when the same noises are heard during your presentation, your audience would be 
distracted.  

To check for ambient noises, leave the microphone on for a couple of minutes without speaking, 
and then play back that recording. If you hear anything at all, you will have to address the source of 
that noise. 

Your PC may be running applications (e.g. chat clients) that pop up messages frequently, or 
produce alert sounds. Turn off all such applications. 

Put your mobile in Silent mode (or better, switch it off). 

Do a short test recording to make sure that your audio is being recorded without any distortion. 

Selecting Your Recording Equipment 

Buy the best-possible microphone (look for high sensitivity figures). 

USB microphones use less computer resources and record better audio than an analog 
microphone. 

If you are using a microphone on a stand ("goose-neck"), select the stand such that you are able to 
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sit with correct posture (you should not have to lean too forward or bend down to speak into the 
microphone.) Wrong posture will not only spoil your voice delivery, but it will also be tiring for long-
duration recordings. 

Use a microphone stand with a stable base that does not wobble and create noise. 

Use a microphone with a wind shield (they are available in two forms: foam cover or diaphragm). 

Setting Up Your Equipment Correctly 

Make sure your computer table is not wobbly, and your keyboard is stable on an even surface. 

Keep your keyboard as away from microphone as possible, otherwise you will end up recording the 
tapping noise. Avoid hammering your keyboard when you type. Place a folded cloth under the 
keyboard to soften its sound. 

If the microphone is kept too near your nose, it will pick up the noise of your breathing. 

If the microphone is kept too near your mouth, it will catch the puff of air whenever you speak a 
fricative consonant. 

General Tips For Recording 

Some people prefer to record “live”: They explain even as they are operating the target application. 
However, not many people can do this simultaneously. Therefore it may be best for you to record 
the narration as the last operation, after you have recorded the slides and added the other objects. 

Many people are at a loss for words when they are trying to find the best way to express something 
(especially when you are also operating a software). They typically fill the gaps with “um...” and 
“ah...”. This is extremely irritating for your audience. To avoid this problem, create an outline (plot 
of your presentation story) and a script beforehand. 

Recording narration for the entire slide at a time may be difficult, because you don't remember 
exactly what comes next. Therefore mentally divide each slide in smaller logical parts, and then 
record audio for each part separately. 

Before actual recording, first conduct a few practice trials. Use loop mode and repeat the play till 
you can speak without mistakes and without "um.." and "er.." sounds. (Even with best care, you 
may not be able to totally avoid such sounds. Be sure to edit them out later!) 

Speak loudly, as if you are addressing a small audience in a large room. 

Monitor the audio level as you record (most of the green LEDs should be visible, but not the 
orange/red). Adjust the sound level from time to time. Remember also that if you are recording in 
multiple sessions, you will have to set up the sound level for each session. 

Never play a background music while you record a narration: It is best to add the background 
music separately, so that you can adjust its relative volume precisely. 

If you are using paper sheets for script, ensure that they do not rustle when you turn the pages. 

Splitting A Slide 

Sometimes you will need to split a slide into two or mode slides. 

ActivePresenter allows you to split a slide at a chosen point. You can split a given slide any 
number of times. 

Refer to the Using The Timeline appendix for details. 
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Adding Navigational Elements 

You can easily add navigational buttons to slides by using mouse-click interactions: 

 Insert mouse-click interactions to slide 

 Open its Event Editor, select On Correct tab, remove all current actions and add a “Go 
Forward”, “Go Backward” or “Go to Slide” action 

 If you want to add hot keys you can also insert and use key-stroke interaction 

Advanced Editing 

Making The Project Interactive 

In ActivePresenter, you can make your projects interactive by using various types of Interactive 
Objects. They are special objects designed to respond to user inputs in a predefined manner. 
Users can interact with them using a keyboard, mouse, or other input devices. 

For any of these objects, you can specify trigger conditions (e.g. “when the mouse rolls over this 
shape”), and specify what actions should be taken for that trigger condition (e.g. “display the hint 
message”). 

You can also control the way that users interact with an interactive object by customizing its 
settings: 

 Attempts: specify the number of times a user can interact with the object before it becomes 
unresponsive. 

 Pause: specify whether the presentation pauses for user response. 

 Timeout: specify the time limit for user response. 

How Interactive Objects Behave 

The following chart shows the trigger conditions for each interactive object. (A trigger condition is 
the user's action that causes a pre-programmed response from the object.) 
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Mouse Click Y   Y Y  Y Y Y   

Text Box   Y Y Y Y Y Y Y   
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Key Stroke  Y  Y Y  Y Y Y   

Mouse Hover        Y Y   

Drop Area    Y Y  Y Y Y   

Drop Target        Y Y Y Y 

Question – True/False    Y Y Y Y     

Question – Multiple 
Choice 

   Y Y Y Y     

Question – Multiple 
Response 

   Y Y Y Y     

Question – Essay    Y Y Y Y     

Question – Fill in Blank    Y Y Y Y     

Question – Fill in 
Multiple Blank 

   Y Y Y Y     

Question – Sequence    Y Y  Y     

Question – Drag-n-Drop    Y Y Y Y     

In fact, for each object, you can specify multiple trigger conditions and corresponding actions. 
Further, for a given trigger condition, you can define multiple actions, in a pre-defined sequence. 

For example: 

1. If the mouse rolls over the shape, display the hint message. 

2. When the mouse rolls out of the shape, hide the hint message. 

3. If the user presses CTRL+Click, (a) display a message first, and then (b) end the 
presentation.  

4. If the user presses SHIFT+Click, go to slide#25 

 

The Trigger Conditions (a.k.a. Events) 

The trigger conditions are explained below: 

Trigger Remarks 

Mouse click You can define specific combinations of LMB/RMB clicks and modifier 
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keys (SHIFT, CTRL and ALT). 

For example, ALT+SHIFT+Left-click. 

Keystroke Any press of a single key of the keyboard OR hot key (e.g. 
CTRL+ALT+SHIFT+P) is defined as a keystroke. 

Text You can define a text string, and optionally make it case-sensitive. If the 
user enters exactly the same string, the condition is met. 

On Correct  When the answer is correct. 

On Incorrect When the answer is not correct. 

On Incomplete  When the answer is incomplete. For example: 

 The user leaves a field blank in the Text Box object and Question 
objects that contain a text box (Fill in Blank, Fill in Multiple Blank, 
and Essay). 

 The user leaves all check boxes or radio buttons unchecked in 
case of True/False, Multiple Choice, or Multiple Response 
Question. 

 The user leaves all drop targets empty (do not contain any drag 
source) in Drag-n-Drop Question. 

On Timeout When the user does not respond within the specified time. 

On Rollover When the mouse rolls over the shape of the object (enters the boundary of 
the shape) 

On Rollout When the mouse rolls out of the shape of the object (exits from the 
boundary of the shape). 

On Accept When the user drops any accepted drag sources on the drop target. 

On Reject When the user drops any rejected drag sources on the drop target. 

 

The Actions 

In response to those trigger conditions, you can take the following actions: 

Option Remarks 

Continue The effect depends on the current state of the presentation: 

 If the presentation is playing, this action does not change anything. 

 If the presentation had paused, this action will continue playing the 

http://atomisystems.com/tutorials/


ActivePresenter User Manual  Version 5.5 

Editing A Project> Advanced Editing 82 

presentation from the time it is paused. 

But how is a presentation paused in the first place? 

Well, you can pause a presentation in two ways: 

 Click in the Pause check box in the Settings tab for any 
interactive object. In this case, when the object is played, the 
presentation will pause. 

 Execute the Pause Presentation action (see below). 

Pause 
Presentation 

The presentation's main stream is halted (all objects stop playing against 
the Timeline) but the user can still interact with interactive objects.  

The presentation is paused indefinitely, until one of the following actions is 
executed: Continue Presentation, End Presentation, Go to Slide, Go to 
Slide at Index, Go Forward, or Go Backward. 

End 
Presentation 

Exit the presentation 

Go to Slide Jump to the specified slide. 

Note that the link is made to a specific slide: If you move that slide to a 
new position, the link will follow it, and jump to this new position. If the 
target slide is deleted, the link gets dissolved automatically. 

Go to Slide at 
Index 

Jump to any slide that is currently at the specified index.  

Note that when you add, remove or shuffle slides, another slide may take 
the place of the current slide. Regardless of that, this command will jump 
to the nth slide in the order. 

Go Forward Go forward by the specified number of slides. 

Note that the target is not a specific slide: The jump will land on any slide 
that is presently n slides away from the current slide. 

Go Backward Go backward by the specified number of slides. 

Note that the target is not a specific slide: The jump will land on any slide 
that is presently n slides away from the current slide. 

Send Email This action launches default email client program installed on user PC; 
and loads the previously configured content in the mail (including recipient 
address, subject line, etc.) 

Note that the email is not sent silently or automatically: The user must 
manually press the send button. The user can also modify the email 
content before sending. 

Open Web page Open the specified URL. You can specify whether to open it in the current 
window or to use a different window. (Recall that the interactive 
presentations are always delivered through a browser window.) 
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Execute 
JavaScript 

Execute the specified JavaScript. 

Show Object Show shapes, images, audio and video objects. 

Users can also specify whether this action is blocking or not. If this action 
is blocking, subsequent actions will be blocked until the object is hidden. 
Otherwise, subsequent actions will be executed right after the object is 
displayed. 

Hide Object This action is used to hide any objects which are displayed by Show 
Object action before they hide automatically. 

Play Audio This action is used to play audio resource. It is similar to the Show Object 
non-blocking action with audio object, except it does not require an audio 
object is inserted earlier. 

Submit This action send whatever users entered in the specified interactive object 
to the presentation to evaluate. 

Clear User Input This action clears whatever users entered in the specified interactive 
object, for example:  

 Clears text in all text fields for Text Box and Question objects that 
contain a text box. 

 Un-checks the radio buttons or check boxes for Question objects. 

 Send dropped drag sources to theirs original position. 

Setting Up The Interactions 

The actual interactions are set using the Event Editor. 

To invoke the Event Editor for each interaction object, you can use one of following methods: 

 Double-click on the interaction object, or 

 Select the interaction object, then click INTERACTION > Event . 

Creating Drag and Drop Interactions 

Drag-and-drop is a visual and eye-catching interaction that allows user to drag an object and drop 
it onto another object. A drag-n-drop interaction needs an object that can be dragged, and a place 
or object to drop it. ActivePresenter calls them drag source and drop target, respectively. 

Drag Source 

You can turn any Image, Shape, Highlight, or Text Caption object into a drag source, except: 

 Objects show across multiple slides. 

 Objects are showed by Show Object actions. 
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 Objects are elements of Questions, excluding Drag-n-Drop Question. 

By default, a light green marker is displayed to indicate that an object is a drag source. This marker 
is used only in the editor, it does not appear in any output format. You can also turn off this marker 
from VIEW > Drag-n-Drop. 

 

To convert objects into drag sources 

1. Select objects. Please note that you can converting multiple objects at once. 

2. Change their Type in Drag-n-Drop section of the Properties pane to Drag Source. 

 

Drag source properties 

 Effect: Specify the effect for selected drag sources. The effect is displayed when users drag 
these objects. 

 Revert: Specify whether the selected drag sources are sent back to their original positions if 
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they are dropped outside drop targets. 

Drop Target 

Any Image, Shape, Highlight, or Text Caption object can be converted into a drop target, except: 

 Objects show across multiple slides. 

 Objects are showed by Show Object actions. 

 Objects are elements of Questions, excluding Drag-n-Drop Question. 

By default, a light orange marker is displayed to indicate that an object is a drop target. This 
marker is used only in the editor, it does not appear in any output format. You can also turn off this 
marker from VIEW > Drag-n-Drop. 

 

To convert objects into drop targets 

1. Select objects. Please note that you can converting multiple objects at once. 

2. Change their Type in Drag-n-Drop section of the Properties pane to Drop Target. 
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Drop target properties 

 Effect: Specify the effect for selected drop targets. The effect is displayed when users drag 
any drag source over one of these objects. 

 Accept Behavior: Specify how the presentation responds when users drop a drag source 
onto one of selected drop targets. 

o Accept List: List of drag sources that can be dropped onto the selected drop target. 
If a dropped source is accepted, it snaps to the drop target based on Snap 
Behavior, and an On Accept event is triggered. 
If a dropped source is rejected, it will be sent back to its original position, and an On 
Reject event is triggered. 
When users select this property, a button appears. Click on this button to launch the 
Event Editor for the selected drop target. In the Event Editor, users can edit the 
Accepted Drag Sources list, specify actions for On Accept, On Reject events… 

o Accept Audio: The short audio played when the selected drop targets accept a 
dropped source. You can also define it in the On Accept tab of the drop target’s 
Event Editor. 

o Reject Audio: The short audio played when the selected drop targets reject a 
dropped source. You can also define it in the On Reject tab of the drop target’s 
Event Editor. 
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Note: In case of Drop Area (a special drop target object), On Correct and On Incorrect are 
triggered instead of On Accept and On Reject. 

 Snap Behavior: Specify properties of drag sources after they are dropped onto one of 
selected drop targets. 

o Size: In percentage of drag sources’ original sizes. 

o Opacity: From 0 to 255. The higher the value, the more opaque the drag sources. 

o Position: 

 Absolute: The drag sources remain at the same position where users drop 
them. 

 Anchor: The drag sources snap to an anchor in the drop target. Users can 
select one of nine anchors in the dropdown list, e.g. Top Left, Top Center… 

 Tile: The drag sources are arranged so that they fill the drop target but do 
not cover each other. Users can select one of eight tiling direction in the 
dropdown list, e.g. From Top, Left To Right; From Top, Right To Left… 

Drop Area 

Drop Areas are drop targets that assess, score and keep track of user response. For Drop Areas, 
accepted means correct, and rejected means incorrect. In other words, an On Correct or On 
Incorrect event is triggered when users drop a drag source onto a Drop Area, instead of On Accept 
or On Reject. 

A Drop Area cannot “contain” more than one dropped source. When users drop a new accepted 
drag source, it will replace the old one if any, the old one will be sent back to its original position. 

 

Please notice that the Drop Area marker and normal drop target marker have different color. 

A drop target that is not an element of a Drag-n-Drop Question will be converted to a Drop Area 
automatically when users connect a drag source to it (see Drag Drop Connector section). 

For more details about this type of object, see the Drop Area and the Event Editor sections in the 
Appendix. 

Drag-n-Drop Question 

Drag-n-Drop Question is a type of Question that includes multiple drag sources, drop targets and 
require users (who take the output simulation) to map them correctly. 

Unlike Drop Area, Drag-n-Drop Question does not evaluate correctness of user response each 
time he/she drops a drag source, but when he/she clicks the Submit button. However, the 
evaluation for acceptance still takes place on each drop target every time it receives a dropped 
source. 
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For more information about this type of object, see the Drag-n-Drop Question and the Event 
Editor sections in the Appendix. 

Drag Drop Connector 

 To map a drag source to the correct drop target, select the drag source. Drag the marker 
appears at the center of the drag source to the correct drop target. 

 

 To remove a correct drag – drop map, click the connector to select then delete it (by using 
hotkey, default is Delete key, or menu, toolbar). 

 To map an already mapped drag source to another drop target, drag the head of the 
connector arrow to the new drop target. 

Note: 

 A drop target that is not an element of a Drag-n-Drop Question will be converted to a Drop 
Area automatically when users specify the correct drag source for it. 

 You can also define correct drag source – drop target pairs in the Event Editor of Drop 
Area (the Accepted Drag Sources tab), and Drag-n-Drop Question (the Answer tab) 
object. 

 One drag source can be mapped to multiple drop targets. When taking the output 
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simulation, users can drag the source to one of the targets. 

 Multiple drag sources can be mapped to one drop target. When taking the output 
simulation: 

o If the drop target is a Drop Area: users can drag one of the sources to the Drop 
Area. 

o If the drop target is an element of a Drag-n-Drop Question: users must drag all of 
the sources to the drop target. 

Tips for Creating Drag and Drop Interactions 

 If you want to assess learner response instantly when they drop a drag source, and you 
need only one drop target, use Drop Area interaction. Otherwise, Drag-n-Drop Question is 
suitable for your needs. 

 You should insert all objects before converting them to drag sources / drop targets and 
mapping them. It will reduce your editing time because ActivePresenter allows editing 
multiple objects at once. In case of Drag-n-Drop Question, please note that you must insert 
objects (Shapes, Images) into the question by using the floating toolbar on the right of the 
question. 

 You should rename drag sources / drop targets to meaningful names before mapping them. 
It will help you to identify them easily in the Event Editor window. 

 In case of Drop Area, please ensure that drag sources do not start exiting before the Drop 
Area pauses for leaner response. You can view and adjust their timing properties in the 
Timeline pane. 

 If you use Shapes as drag sources / drop targets and you want to change them to other 
shapes, select them then click FORMAT > Change Shape and select a shape from the 
menu. You don’t need to delete them and insert new shapes. 

 If you use Images as drag sources / drop targets, you should prepare them all then insert 
once. ActivePresenter allows you to insert multiple images at once. 

 If you have two overlapped drop targets, when a drag source is dropped onto the 
overlapped area, the drop target that has higher z-order will process the dropped source. 
You should set the z-order properly to get desired results. 

Custom JavaScript in HTML5 Output 

ActivePresenter allows accessing to elements of presentation in the HTML5 output by exposing the 
JavaScript API. You can write custom script in following areas: 

 The Event tab of project. 

 The Event section of slide. 

 The Execute JavaScript action in Event Editor. 

You can access to the presentation by using the global object Prez. 

The Prez is a global object which has following methods: 

Method Description 

ShowSlide(index) 
Go to the slide which has specified index. Note that the 
index of the first slide in project is 1. 
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index: An integer indicates the index of the slide.  

ShowNextSlide() 
Go to the next slide. 

ShowPreviousSlide() 
Go to the previous slide 

ShowPreviousVisitedSlide() 
Go to the previous slide of current point in the navigation 
history stack. 

ShowNextVisitedSlide() 
Go to next slide of current point in the navigation history 
stack. 

GetSlide() 
Return the current slide. 

GetObject(objectName) 
Return the object in the current slide which has specified 
name. 

objectName: A string that defines the name of object 

 

 
The Slide object has following functions: 

Method Description 

GetObject(objectName) 
Return the object in the slide which has specified name. 

objectName: A string that defines the name of object 

 

The Object object has following functions: 

Method Description 

SetText(text) 
Change the text of the object. 

text: A string that defines new text. 

GetText(plaintext) 
Return a string represents the text of the object. 

plaintext: If true, return the plain text, otherwise, 

return HTML text. 

Show(show) 
Show or hide the object 

show: A boolean determining whether to show or hide 

object.. 

IsShown() 
Check if the object is shown or hidden 

GetPosition() 
Return an JavaScript object represents the position of the 

object in form {x, y} 

SetPosition(x, y) 
Set the position of the object 

x: An integer determining the horizontal position 

y: An integer determining the vertical position. 

Making The Project Accessible 

ActivePresenter allows you to make your projects accessible to anyone, regardless of disabilities. 
More specifically, you can edit your projects so that viewers with disabilities can perceive, 
understand, navigate, and interact with the project outputs. The project outputs can be viewed in 
various ways that do not depend on a single sense or ability. For example, viewers can navigate 
with a keyboard, not with a mouse only. Also, audio content should be accompanied with closed 
caption for hearing impaired viewers, text description should be provided for visual content so that 
screen readers can read out loud for visually impaired viewers. 

In this version, HTML5 is the only output format that supports accessibility. 
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Tips for Creating Accessible Projects 

To create accessible projects, you should always use more than one means (e.g. text, visuals, and 
sounds) to convey information. 

 For viewers with visual impairment, add text description or audio equivalents for visual 
objects. For example, provide accessibility text description for Video object, so that you 
can send the information to viewers through the screen reader. For objects that contain text 
such as Shape, Text Caption, you should enable the Auto Label property, the screen 
reader will read the text when this object is displayed. If you choose to attach audio to the 
object, don't forget to remove all accessibility text, otherwise voice from the screen 
reader will interfere with the attached sound. 

 For users with hearing impairment, add text equivalents for audio objects. For example, 
when delivering narrative audio, it is important to provide captions at the same time. You 
can use Closed Caption or any other type of object that can display text, and remember to 
synchronize the text with the audio using the Timeline. 

 For viewers with either visual or mobility impairment, ensure that viewers can interact with 
the output using keyboard. For example, enable Focusable property for Mouse Click 
objects, so that viewers can press the Tab key to navigate to the object, and the Enter or 
Space key to activate it. You can also provide a Key Stroke object that acts as a keyboard 
shortcut for each Mouse Click object.  

 Enable accessibility features when exporting to output formats that support accessibility. 

Customizing Accessibility Text for Slides 

In ActivePresenter, you can add accessibility text describing each slide for screen readers to read 
aloud when the slide is displayed. Screen readers and accessibility text are useful for people with 
visual impairment. 

 

By default, ActivePresenter uses slide name and description as slide accessibility text. To provide 
different text for screen readers, do the following steps: 

1. Select the slide that you want to change accessibility text. 

2. In the Properties panel, expand Accessibility property. 

3. Deselect Auto Label property, the accessibility Name and Description are now enabled. 
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4. In the accessibility Name field, type the accessibility name or short description for the slide. 

5. In the accessibility Description field, type text that describes the slide. 

6. When the slide appears, screen readers will read aloud the accessibility name first, then the 
accessibility description. If you don't want screen readers to read anything, leave both 
accessibility name and description blank. 

Customizing Accessibility Text for Objects 

ActivePresenter also supports accessibility text for each object on a slide. By default, accessibility 
text is generated automatically from the text that the object displays, or the object name if it doesn't 
contain any text. Therefore, the default accessibility text is usually useless for objects that doesn't 
contain text, such as video, image. In this case, you should customize the accessibility text to 
provide sufficient information about the object. 

 

1. Select the object that you want to change accessibility text. 

2. In the Properties panel, expand Accessibility property. 

3. Deselect Auto Label property, the accessibility Name and Description are now enabled. 

4. In the accessibility Name and Description field, type the accessibility name and description 
for the object. 

5. When the object appears, screen readers will read aloud the accessibility name first, then 
the accessibility description. If you don't want screen readers to read anything, leave both 
accessibility name and description blank. 
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Localizing The Project 

Localization is the process of adapting your project for use in a specific country, region with a 
particular language, culture, and desired local look-and-feel. If you are creating a demonstration or 
simulation of a certain application that supports multiple languages, you may need to localize your 
project for each language. With ActivePresenter, you can do it easily thanks to the slide 
backgrounds replacement and the text translation features. 

Localizing Process 

Before doing localization, make sure that you have finished editing the original project (usually in 
English). 

To localize your project, do the following steps: 

1. Export texts in your project to XLIFF format. 

2. Translate texts in the exported XLIFF file using any tool that supports XLIFF 1.2, e.g. 
Swordfish Translation Editor. 

3. Replace the original slide backgrounds with the new ones that are captured in the new 
language. 

4. Import the translated XLIFF file into the project that its slide backgrounds have been 
replaced in step 3. 

5. Test the localized version of your project, make sure that all screenshot images are 
replaced, all texts are properly translated and displayed. 

The next sections will describe each step in detail. 

Exporting To XLIFF 

XLIFF (XML Localization Interchange File Format) is an XML-based format created to standardize 
the way localizable data are passed between tools during a localization process. 

To export texts in your project to XLIFF format, do the following steps: 

1. Click LOCALIZE > Export To XLIFF. 
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2. In the Export To XLIFF dialog, select types of text which you want to export for translation. 

3. Select option Use TMX 1.4b standard compatible tags (<bpt>, <ept>, <ph>) if your 
translation tool doesn't support <g> and <x/> tag. 

4. Enter the output location and filename. 

5. Click OK to start exporting to XLIFF. 

Replacing Slide Backgrounds 

You should not localize directly in your original project, but do it in a copy of the original project. So 
this section also describes the step to copy the project for completeness. 

1. Create a copy of the original project for the new language: 

 Copy the project file in File Explorer, or use ACTIVEPRESENTER > Save As 
feature in ActivePresenter. 

 If you copy it in File Explorer, make sure it is not opening in ActivePresenter. The 
project copied from an opening project may be corrupt. 

 Give the copied project a meaningful name. It is recommended that the project 
name has language code suffice, e.g. Skype_es.approj. You can also create a 
folder for the new language and place the copied project there. 

2. Capture new project for the new language: 

 Change language preferences and settings for the captured application and OS to 
display the new language, if needed. 

 Use the same project size (width x height) as of the original project. 

 Use the Smart Capture profile. 

 Should name the new captured project a meaningful name, e.g. 
Skype_es_captured.approj. 
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3. Open Slide Background Replacer dialog to replace slide backgrounds in the project 
copied in step 1 by new ones captured in step 2: 

 Open the project copied in step 1 (Skype_es.approj). 

 Select LOCALIZE > Replace Slide Backgrounds > All Slides From Project. 

 If you just want to replace some slides, select them then choose Selected Slides 
From Project in LOCALIZE > Replace Slide Backgrounds menu. 

 Browse the new project captured in step 2 (Skype_es_captured.approj). 

4. In the Slide Background Replacer dialog, arrange new slides on the right in the same 
order as current slides on the left: 

 To move a slide, drag it and drop to new position. 

 To copy/ cut/ paste/ delete slides, use hotkeys or right-click menu. 
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 To undo/ redo, use hotkeys or buttons. 

 If you are not sure that a new slide is redundant or not, use Move To Bottom 
function instead of deleting it. 

 If a certain step (slide) is required in the new language, but not available in the 
original language, use Copy To Left function. 

 If you do not want to change a certain slide in the left (for example, the introduction 
slide), use New Place Holder function. 

5. Click OK button on the Slide Background Replacer dialog to replace slide backgrounds. 

Importing From XLIFF 

After translating text and replacing slide backgrounds, you need to import the XLIFF file back to the 
project that its slide backgrounds are replaced. ActivePresenter will replace current texts in your 
project with the corresponding texts in the translated XLIFF file. 

1. Open the project that has been replaced slide backgrounds. 

2. Click LOCALIZE > Import From XLIFF and browse the translated XLIFF file for the 
project. 

3. Verify imported text on each slide, adjust object position and size if necessary. 

Right-To-Left Language 

ActivePresenter 4.0 introduces a new property of project, Project Language which allows you to 
create the content for right-to-left language whether it is supported in the user interface of 
ActivePresenter or not. 

The right-to-left language is fully supported in the most important features such as editing, Export 
To HTML5 Simulation, Export To Video. It is also supported partially in Export To Microsoft 
Word/PowerPoint/Excel… 
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The following screenshot shows how the right-to-left language is supported in the editor: 

 

This screenshot shows how it looks like in the HTML5 Simulation output: 
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Active Window 

Suppose you are creating a simple manual with ActivePresenter, for example a Microsoft Word 
document shows how to delete a folder in Windows. Sometimes, you want ActivePresenter to 
capture the window of file explorer, the other times, you want it to capture only the confirmation 
dialog which ask you whether to delete the folder. So, how to achieve this with ActivePresenter? 

ActivePresenter can automatically detect the area that you want to capture and save the 
information to captured slides. That information is called Active Window. To view the Active 
Window, you can select the SLIDE > View Active Window tool. 

The following screenshot shows an Active Window area (in the dotted red rectangle) in a captured 
slide: 
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The Active Window areas detected while capturing are not always fit in a certain circumstance. 
You can modify these areas by enabling the SLIDE > Edit Active Window tool. After the Edit 
Active Window Area tool is enabled, you can drag and resize them similar to manipulating a slide 
object. 

The following screenshot shows how the content in above example displayed in the exported 
output. Note that the exported area contains the Active Window area and other slide objects: 
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Exporting The Project 

In the previous chapters, we saw how to create content and edit it. Now we have come to the 
final stage of exporting the content in the desired formats (as images, videos, interactive 
presentation or documents). 

Depending upon the export format, an exported presentation can be viewed on standard software, 
such as web browsers (e.g. Firefox, Internet Explorer), video players (e.g. VLC, The KMPlayer), 
image viewers (Picasa, Irfanview, XnView, etc.), Microsoft Office/LibreOffice, etc. 

Overview Of Exporting Options 

ActivePresenter allows you to render the presentation in many different forms: 

Format Remarks 

Images Export all slides as images, and then use those images for any purposes 
related to the presentation/training course.  

Video  Use videos when interaction with audience is not needed. 

HTML SlideShow Slides are exported as images, and embedded in HTML pages; to be 
viewed in a browser. 

PDF Document Slides are exported as images, and embedded in PDF format. 

Microsoft Word Slides are exported as shapes, text and images, and inserted in a 
doc/docx file. Now this file can be edited further in Microsoft Word (or 
LibreOffice Writer). 

Microsoft Excel Slides are exported as shapes, text and images, and inserted in a 
xls/xlsx file. Now this file can be edited further in Microsoft PowerPoint 
(or LibreOffice Calc). 

Microsoft PowerPoint Slides are converted into PowerPoint slides. This exported ppt/pptx file 
can be edited further in Microsoft PowerPoint (or LibreOffice Impress). 

HTML5 Simulation  Presentation is exported as a set of files (HTML, CSS, JavaScript…) 
using HTML5 standard so it can run on most modern browsers (Internet 
Explorer 9 or later, Google Chrome, Mozilla FireFox, Safari) on various 
devices and platforms (Windows, MacOS, Linux, iOS, Android). The 
presentation can also run on older browsers (such as Internet Explorer 7 
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and 8) if Adobe Flash Player or Microsoft Silverlight plugin is installed. 

Flash Simulation Presentation is exported as a set of HTML files with Flash content; to be 
viewed in a browser. 

These options are explained in details in below sections. 
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Exporting To Images 

Typical uses of exported images are to create brochures, handouts, and posters for the training. 
Images are also useful to translate the training in another format, such as PowerPoint. 

To export the project to images, click EXPORT > Images . 

General Options 

 

These options are divided in three sections, as follows: 

Rendering Options 

Option Remarks 

Include Closed 
Caption 

If this option is selected, the images will have Closed Caption. 

 Note that if the image size is reduced, the captions may not be 
readable. On the contrary, they will obstruct whatever little space 
is left. Then it is best to drop it. 

Include Objects 
Started by Event 

If this option is selected, ActivePresenter includes objects that are 
triggered by events. 

Include Cursor 
Path 

Allows you to show (or hide) the cursor path. 
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Only Export Active 
Window Area 

The exported area only includes the Active Window area and slide 
objects which are selected to export. 

Image 

Parameter Options Remarks 

Size Range: 10% to 150%  
(in steps of 10%) 

The size is relative to canvas size selected at the 
beginning of the project (you can check this out at any 
time by using the ACTIVEPRESENTER > Project 
Information menu option) 

Note that ActivePresenter only works with logical size 
(i.e. pixels). However, when displayed/printed, the 
physical size depends on pixels and the dpi (dots-per-
inch) setting of the displaying printing device. 

Color Depth True Colors (24 bit) 

256 Colors (8 bit) 

Grayscale (8 bit) 

Higher color depth makes the presentation look 
stunning. But it also increases the file size. When the 
images are inserted in other files, that file also will 
become large. 

Format  JPEG 

PNG 

Due to their specs and compression algorithms, JPEG is 
best suited for pictures while PNG is best suited for 
computer-generated images (screenshots, drawings...).  

Note that JPEG compression is lossy while PNG is 
lossless, so PNG retains crystal clear quality, but the 
downside of PNG is that it does not compress well with 
pictures (very big file size) and the decoding (when 
viewing) is slower than JPEG. However, screenshots 
are compressed better with PNG, the file has small size 
and there is no loss of quality. 

Optimization 
Level  

None 

Low 

Normal 

High 

Ultra 

These are relative compression levels. Note that the 
higher the compression level, the longer it takes to 
export.  

 Select None when testing the output. 

 Select Ultra or High when exporting the final 
result. 

This option is only available if the PNG image format is 
selected. 

Quality Range: 1% to 100% The higher the quality, the larger the output file size. 

This option is only available if the JPEG image format is 
selected. 

Output Location 

Define the location where the exported images will be placed. 

http://atomisystems.com/tutorials/


ActivePresenter User Manual  Version 5.5 

Exporting The Project> Exporting To Images 105 

SCORM Options 

These are the SCORM-related options: 

 

Parameter Options Remarks 

Generate 
SCORM 
Package 

No 

SCORM 1.2 

SCORM 2004 

If your LMS supports both 1.2 and 2004 versions of SCORM, 
please choose 2004 version (the latest version). 

Package 
Version  

 
Specify a version that can be used to differentiate manifests with 
the same identifier. For example, if you are uploading the same 
project after modifying it, provide a different version number. 

Identifier  Specify a name used by the LMS to identify different manifests. 
(This value is generated automatically by ActivePresenter but 
you can change it if needed.) 

Organization 
Title 

 Specify a title for the organization which this item belongs to. 
(ActivePresenter automatically generates this value from project 
name. However, you can enter a difference text.) 

Item Title  Specify a title for the item. (ActivePresenter automatically 
generates this value from project name. However, you can enter 
a difference text.) 
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Exporting To Video 

Video format is suitable when the audience (or an individual student) does not have to interact with 
the presentation in a self-paced manner. 

The advantage of video over the image or documents formats is that the video contains all 
animations, closed captions and voice.  

The disadvantage of video is that it can be made in one language at a time (thanks to the Closed 
Caption and audio objects it contains).  

You can export in multiple video formats. The selection of a format over the others is primarily 
driven by which codecs are allowed to be used in your country, thanks to the country-specific 
patent laws. Other than that, there may be quality vs file size preferences or what player software 
is available on the target hardware.  

To export the project to video, click EXPORT > Video . 
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General Options 

 

The options are divided into four sections: 

Rendering Options 

Option Remarks 

Exported 
Closed 
Captions as 
Soft Subtitles 
(.SRT) 

If you select this option, the Closed Captions will be exported as a separate 
subtitle file (with srt extension). The player must have the capability to display 
subtitles. 

Note that this allows you to change the font size and color of the subtitles at 
play time. 

You can also change the srt file to display the subtitles in a different 
language. 

Export Closed If you select this option, the Closed Captions will be hard-coded inside the 
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Caption as 
Hard Subtitles 

video. In this case any video player can play the video can also display 
subtitles. However, the attributes of the subtitles cannot be changed at play 
time. 

Zoom-n-Pan If selected, the effects of zoom-n-pan objects will be included in the exported 
video. 

Include Cursor 
Path 

Whether to render the cursor paths or not. 

Export Audio This option is selected by default. Deselect this option if you want to remove 
audio from the output. Since the audio data is not written to the output file so 
the file size will be smaller comparing to a similar video with silence audio.  

Video 

Option Remarks 

Video Size  Range: 50% to 150% (in steps of 10%) 

The reference is the canvas size which you specified when you created the 
project. The video will be rescaled using Bicubic interpolation. 

Note that the aspect ratio is fixed when you created the project; it cannot be 
changed at render time. 

If you specify the Width or Height option, the Video Size option is 
automatically calculated based on the original size of project. 

Width The width of exported video. If you specify the Video Size or Height option, 
the Width option is automatically calculated based on the original size of 
project. 

Height The height of exported video. If you specify the Video Size or Width option, 
the Height option is automatically calculated based on the original size of 
project. 

Frame Rate Set between 1 and 30 fps (frames per second). 

Key Frame  Specify the number of frames between which we must have a key frame. 
(default=3* Frame Rate) 

Quality Select in the range [1,100]  

(Higher the number, better the quality and larger the file size) 

Audio 

Option Remarks 
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Channels Select from mono/stereo 

Bit Rate Select from 64, 96, 128, 192, 256, 320 kbps 

This option is only available for AVI, MP4, FLV, and WMV formats. 

Sample Rate Select from 11025, 22050, 44100, and 48000 Hz. 

The 48000 Hz option is not available for FLV format. 

Quality Select in the range [1,100]  

(Higher the number, better the quality and larger the file size) 

This option is only available for WebM format. 

Output 

Option Remarks 

Format Select from AVI, MP4, WMV, WebM, MKV, and FLV. 

The following video and audio codecs are used for each container format: 

 AVI: MS MPEG4 v2, WMA v2 

 MP4: H264 Baseline@L5.0, ACC 

 WMV: WMV v2, WMA v2 

 WebM: VP8, Vorbis 

 MKV: Flash Screen Video, PCM 16-bit (this format using lossless 
audio and video codecs so it can be used for further editing in other 
programs without quality loss) 

 FLV: H264 Baseline@L5.0, MP3 

Output File Specify the file path and name for exported video. 
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Advanced Options 

The following SCORM options are available: 

 

Parameter Options Remarks 

Generate 
SCORM 
Package 

No 

SCORM1.2 

SCORM 2004 

If your LMS supports both 1.2 and 2004 versions of 
SCORM, please choose 2004 version (the latest version). 

Package 
Version  

 
Specify a version that can be used to differentiate manifests 
with the same identifier. For example, if you are uploading 
the same project after modifying it, provide a different 
version number. 

Identifier  Specify a name used by the LMS to identify different 
manifests. (This value is generated automatically by 
ActivePresenter but you can change it if needed.) 

Organization 
Title 

 Specify a title for the organization which this item belongs to. 
(ActivePresenter automatically generates this value from 
project name. However, you can enter a difference text.) 

Item Title  Specify a title for the item. (ActivePresenter automatically 
generates this value from project name. However, you can 
enter a difference text.) 
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Exporting To HTML SlideShow 

To export the project to HTML SlideShow, click EXPORT > HTML SlideShow . 

This has two different options: General options and Advanced (SCORM). 

General Options 

 

These options are divided in three sections, as follows: 

Rendering Options 

Option Remarks 

Include Closed 
Caption 

If this option is selected, the images will have CC. 

 Note that if the image size is reduced, the captions may not be 
readable. On the contrary, they will obstruct whatever little 
space is left. Then it is best to drop it. 

Generate Navigation 
Guide page 

Create a first page which contains guideline about using hot-key to 
navigate through the slides. 

Include Cursor Path Deselecting this option will hide the cursor path. 
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Generate in compact 
mode 

Create only one slide per Slide Group. 

Include Objects 
started by event 

Includes the objects that are started by event. 

Only Export Active 
Window Area 

The exported area only includes the Active Window area and slide 
objects which are selected to export. 

Image 

Parameter Options Remarks 

Size Range: 10% to 150%  

(in steps of 10%) 

The size is relative to canvas size selected at the 
beginning of the project (you can check this out at any 
time by using the ACTIVEPRESENTER > Project 
Information menu option) 

Note that ActivePresenter only works with logical size 
(i.e. pixels). However, when displayed/printed, the 
physical size depends on pixels and the dpi (dots-per-
inch) setting of the displaying printing device. 

Color Depth True Colors (24 bit) 

256 Colors (8 bit) 

Grayscale (8 bit) 

Higher color depth makes the presentation look 
stunning. But it also increases the file size. When the 
images are inserted in other files, that file also will 
become large. 

Format  JPEG 

PNG 

Due to their specs and compression algorithms, JPEG 
is best suited for pictures while PNG is best suited for 
computer-generated images (screenshots, drawings...).  

Note that JPEG compression is lossy while PNG is 
lossless, so PNG retains crystal clear quality, but the 
downside of PNG is that it does not compress well with 
pictures (very big file size) and the decoding (when 
viewing) is slower than JPEG. However, screenshots 
are compressed better with PNG, the file has small size 
and there is no loss of quality. 

Optimization 
Level  

None 

Low 

Normal 

High 

Ultra 

These are relative compression levels. Note that the 
higher the compression level, the longer it takes to 
export.  

 Select None when testing the output. 

 Select Ultra or High when exporting the final 
result. 

This option is only available if the PNG image format is 
selected. 
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Quality Range: 1% to 100% The higher the quality, the larger the output file size. 

This option is only available if the JPEG image format is 
selected. 

Output Location 

Define the location where the exported contents will be placed. 

Advanced Options 

The following SCORM-related options are available: 

 

SCORM-related Options 

Parameter Options Remarks 

Generate 
SCORM 
Package 

No 

SCORM1.2 

SCORM 2004 

If your LMS supports both 1.2 and 2004 versions of SCORM, 
please choose 2004 version (the latest version). 

Package 
Version  

 
Specify a version that can be used to differentiate manifests 
with the same identifier. For example, if you are uploading the 
same project after modifying it, provide a different version 
number. 

Identifier  Specify a name used by the LMS to identify different manifests. 
(This value is generated automatically by ActivePresenter but 
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you can change it if needed.) 

Organization 
Title 

 Specify a title for the organization which this item belongs to. 
(ActivePresenter automatically generates this value from 
project name. However, you can enter a difference text.) 

Item Title  Specify a title for the item. (ActivePresenter automatically 
generates this value from project name. However, you can 
enter a difference text.) 
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Exporting To Adobe PDF Document 

To export the project to Adobe PDF Document, click EXPORT > PDF Document . 

This has three tabs: General options, Advanced options (SCORM-related), Text styles options. 

General Options 

 

The options are divided into four sections: 

Rendering Options 

Option Remarks 

Include Objects 
Started by Event  

Include Objects Started by Event  

Create 
Bookmarks 

Bookmarks are created from slide names and each bookmark is linked to 
corresponding slide image. 

In other words, ActivePresenter creates bookmark links to each slide. 
However, there is a little difference in Compact mode, the first bookmark 
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level is slide group title, the second one is slide name. 

Only Export Active 
Window Area 

The exported area only includes the Active Window area and slide 
objects which are selected to export. It is usually used with the Slides per 
page – Contiguous option. 

Layout 

Option Remarks 

Slides per page One – Single slide per page 

Two – Two slides per page (top, bottom) 

Contiguous – The slides are written contiguously in a page until there is 
not enough space, then it will move to the next page. 

Compact – In this mode, only the screen of first slide in each group is 
exported. For the following slides, ActivePresenter exports only the slide 
name and slide description. 

Description This is the slide description. 

None – No description exported. 

Choose on which side of the slide the description has to be placed: Top, 
Left, Right, or Bottom  

Page orientation Choose from landscape and portrait. 

The page size is fixed (A4). 

ActivePresenter also used fixed margins of 1” (2.54 cm) on all sides. 

Image 

Parameter Options Remarks 

Size Range: 10% to 150%  

(in steps of 10%) 

The size is relative to canvas size selected at the 
beginning of the project (you can check this out at any 
time by using the ACTIVEPRESENTER > Project 
Information menu option) 

Note that ActivePresenter only works with logical size 
(i.e. pixels). However, when displayed/printed, the 
physical size depends on pixels and the dpi (dots-per-
inch) setting of the displaying printing device. 

Color Depth True Colors (24 bit) 

256 Colors (8 bit) 

Grayscale (8 bit) 

Higher color depth makes the presentation look 
stunning. But it also increases the file size. When the 
images are inserted in other files, that file also will 
become large. 
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Format  JPEG 

PNG 

Due to their specs and compression algorithms, JPEG 
is best suited for pictures while PNG is best suited for 
computer-generated images (screenshots, drawings...).  

Note that JPEG compression is lossy while PNG is 
lossless, so PNG retains crystal clear quality, but the 
downside of PNG is that it does not compress well with 
pictures (very big file size) and the decoding (when 
viewing) is slower than JPEG. However, screenshots 
are compressed better with PNG, the file has small size 
and there is no loss of quality. 

Optimization 
Level  

None 

Low 

Normal 

High 

Ultra 

These are relative compression levels. Note that the 
higher the compression level, the longer it takes to 
export.  

 Select None when testing the output. 

 Select Ultra or High when exporting the final 
result. 

This option is only available if the PNG image format is 
selected. 

Quality Range: 1% to 100% The higher the quality, the larger the output file size. 

This option is only available if the JPEG image format is 
selected. 

Output File 

Specify the file path and name for the exported PDF document. 

Advanced Options 

The options are divided in three sections:  

1. SCORM-related options  

2. PDF document-related options 

3. Security password for opening the PDF document. 

http://atomisystems.com/tutorials/


ActivePresenter User Manual  Version 5.5 

Exporting The Project> Exporting To Adobe PDF Document 119 

 

SCORM-related Options 

Parameter Options Remarks 

Generate 
SCORM Package 

No 

SCORM1.2 

SCORM 2004 

If your LMS supports both 1.2 and 2004 versions of 
SCORM, please choose 2004 version (the latest version). 

Package Version   
Specify a version that can be used to differentiate 
manifests with the same identifier. For example, if you are 
uploading the same project after modifying it, provide a 
different version number. 

Identifier  Specify a name used by the LMS to identify different 
manifests. (This value is generated automatically by 
ActivePresenter but you can change it if needed.) 

Organization Title  Specify a title for the organization which this item belongs 
to. (ActivePresenter automatically generates this value 
from project name. However, you can enter a difference 
text.) 
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Item Title  Specify a title for the item. (ActivePresenter automatically 
generates this value from project name. However, you can 
enter a difference text.) 

PDF file-related options 

Parameter Remarks 

Title Title of the PDF document.  

 When you open the pdf in a viewer, this name appears in the Windows 
Bar (or in the tab, in case of a tabbed pdf reader). 

Subject Subject of the document. This is one of PDF document properties which can 
be seen in Document Properties in any PDF Viewer. 

Keywords Keywords defined in the PDF document. 

Protection 

Opening 
Password  

You can set a password for opening this PDF document. 

Confirm 
Password 

Enter the password again manually (no copy-paste from the previous field). 

 This is to avoid the possibility that you entered a wrong password. 

Text Style Options 

These options control the text in the generated pdf file. 
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The font size, text color and line spacing are controlled for three different parts of the slides: 

1. Group Title 

It is printed before any slide group. Please note that the group title will only be exported in 
Compact mode. 

2. Slide name (As entered in the Slide Titles pane) 

3. Slide Description 
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Exporting To Microsoft Word Document 

To export the project to Microsoft Word Document, click EXPORT > Microsoft Word . 

There are two tabs: 

1. General 

2. Advanced 

General Options 

 
Rendering Options 

Option Remarks 

Include Objects 
Started by Event  

Include Objects Started by Event  
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Create Table of 
Contents 

Adds a TOC to the document, hyperlinked to the slides 

Only Export 
Active Window 
Area 

The exported area only includes the Active Window area and slide objects 
which are selected to export. It is usually used with the Slides per page – 
Contiguous option. 

Layout options 

Option Remarks 

Slides per page One – Single slide per page 

Two – Two slides per page (top, bottom) 

Contiguous – The slides are written contiguously in a page until there is not 
enough space, then it will move to the next page. 

Compact – In this mode, only the screen of first slide in each group is 
exported. For the following slides, ActivePresenter exports only the slide 
name and slide description. 

Description Slide description. 

None – No description exported. 

Choose on which side of the slide the description has to be placed: Top, 
Left, Right, or Bottom  

Page orientation Choose from landscape and portrait. 

The page size is fixed (A4). 

ActivePresenter uses fixed margins of 1” (2.54 cm) on all sides. 

Use Native 
Objects 

Use Microsoft Word auto-shapes, images, text boxes, and text for 
representing slide objects. Otherwise, each object is exported as an image. 
Using native objects will allow editing the shapes directly within MS Word 
later once exported. Otherwise, slide objects are exported as images so it is 
almost impossible to edit exported document later. 

Use Template 
Layout 

Use the layout specified in the template. Refer to Appendix Create custom 
Word template to learn more about how to create a custom layout. 

 

Image options 

Parameter Options Remarks 

Size Range: 10% to 150%  

(in steps of 10%) 

The size is relative to canvas size selected at the 
beginning of the project (you can check this out at any 
time by using the ACTIVEPRESENTER > Project 
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Information menu option) 

Note that ActivePresenter only works with logical size 
(i.e. pixels). However, when displayed/printed, the 
physical size depends on pixels and the dpi (dots-per-
inch) setting of the displaying printing device. 

Color Depth True Colors (24 bit) 

256 Colors (8 bit) 

Grayscale (8 bit) 

Higher color depth makes the presentation look stunning. 
But it also increases the file size. When the images are 
inserted in other files, that file also will become large. 

Format JPEG 

PNG 

Due to their specs and compression algorithms, JPEG is 
best suited for pictures while PNG is best suited for 
computer-generated images (screenshots, drawings...).  

Note that JPEG compression is lossy while PNG is 
lossless, so PNG retains crystal clear quality, but the 
downside of PNG is that it does not compress well with 
pictures (very big file size) and the decoding (when 
viewing) is slower than JPEG. However, screenshots are 
compressed better with PNG, the file has small size and 
there is no loss of quality. 

Optimization 
Level  

None 

Low 

Normal 

High 

Ultra 

These are relative compression levels. Note that the 
higher the compression level, the longer it takes to 
export.  

 Select None when testing the output. 

 Select Ultra or High when exporting the final 
result. 

 This option is only available if the PNG image 
format is selected. 

Quality Range: 1% to 100% The higher the quality, the larger the output file size. 

This option is only available if the JPEG image format is 
selected. 

Output location 

Template Location of the template file, which the doc file has to use. 

Output File Specify the file path and name of exported document. 
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Advanced Options 

These are SCORM-related options. 

 

Parameter Options Remarks 

Generate 
SCORM 
Package 

No 

SCORM1.2 

SCORM 2004 

If your LMS supports both 1.2 and 2004 versions of 
SCORM, please choose 2004 version (the latest version). 

Package 
Version  

 
Specify a version that can be used to differentiate 
manifests with the same identifier. For example, if you 
are uploading the same project after modifying it, provide 
a different version number. 

Identifier  Specify a name used by the LMS to identify different 
manifests. (This value is generated automatically by 
ActivePresenter but you can change it if needed.) 
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Organization 
Title 

 Specify a title for the organization which this item belongs 
to. (ActivePresenter automatically generates this value 
from project name. However, you can enter a difference 
text.) 

Item Title  Specify a title for the item. (ActivePresenter automatically 
generates this value from project name. However, you 
can enter a difference text.) 

 

Creating Custom Word template 

When exporting to MS Word Document, you can create your own Word template and let 
ActivePresenter use it to create the output document. 

To create a custom layout template, you must have Word 2002 (Word XP) or higher version 
installed on your computer. 

The steps are as follows: 

1. Placement Of Contents 

The following tags will be used to specify the location to place exported contents: 

 $SlideName1 

 $SlideDescription1 

 $SlideImage1 

For example, if you want to place slide name somewhere in the template, you type $SlideName1 at 
that location. 

Only the usage of $SlideImage1 is different. This used to specify the location of slide content (slide 
background, balloons, captions, texts, ...). You need to insert Word drawing canvas and set its 
Alternative Text to $SlideImage1. 

2. Styling The Contents 

To set style (font name, font size, color...) for Slide Name, Slide Description, you can not set text 
properties directly to the tags, instead you need to open the Styles pane and add new styles and 
named them as: SlideName and SlideDescription. ActivePresenter will automatically use these 
styles when writing Slide Name and Slide Description text. 

After exporting, you can also change these styles easily by opening exported document and 
changes appropriate styles. 
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Exporting To Microsoft Excel Worksheet 

To export the project to Microsoft Excel Worksheet, click EXPORT > Microsoft Excel . 

This has two tabs: General options and advanced options 

General Options 

 

Rendering options 

Option Remarks 

Include 
Objects 
Started by 
Event  

Include Objects Started by Event  

Only Export 
Active Window 

The exported area only includes the Active Window area and slide objects 
which are selected to export. It is usually used with the Slides per page – 
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Area Contiguous option. 

Layout options 

Option Remarks 

Slides per 
page 

One – Single slide per page 

Two – Two slides per page (top, bottom) 

Contiguous – The slides are written contiguously in a page until there is not 
enough space, then it will move to the next page. 

Compact – In this mode, only the screen of first slide in each group is 
exported. For the following slides, ActivePresenter exports only the slide name 
and slide description. 

Description Slide description. 

None – No description exported. 

Choose on which side of the slide the description has to be placed: Top, Left, 
Right, or Bottom  

Page 
orientation 

Choose from landscape and portrait. 

The page size is fixed (A4). 

ActivePresenter uses fixed margins of 1” (2.54 cm) on all sides. 

Use Native 
Objects 

Use Microsoft Excel auto-shapes, images, text boxes, and text for 
representing slide objects. Otherwise, each object is exported as an image. 
Using native objects will allow editing the shapes directly within MS Excel later 
once exported. Otherwise, slide objects are exported as images so it is almost 
impossible to edit exported document later. 

Image options 

Parameter Options Remarks 

Size Range: 10% to 150%  

(in steps of 10%) 

The size is relative to canvas size selected at the 
beginning of the project (you can check this out at any 
time by using the ACTIVEPRESENTER > Project 
Information menu option) 

Note that ActivePresenter only works with logical size 
(i.e. pixels). However, when displayed/printed, the 
physical size depends on pixels and the dpi (dots-per-
inch) setting of the displaying printing device. 

Color Depth True Colors (24 bit) 

256 Colors (8 bit) 

Grayscale (8 bit) 

Higher color depth makes the presentation look 
stunning. But it also increases the file size. When the 
images are inserted in other files, that file also will 
become large. 
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Format  JPEG 

PNG 

Due to their specs and compression algorithms, JPEG 
is best suited for pictures while PNG is best suited for 
computer-generated images (screenshots, 
drawings...).  

Note that JPEG compression is lossy while PNG is 
lossless, so PNG retains crystal clear quality, but the 
downside of PNG is that it does not compress well with 
pictures (very big file size) and the decoding (when 
viewing) is slower than JPEG. However, screenshots 
are compressed better with PNG, the file has small 
size and there is no loss of quality. 

Optimization 
Level  

None 

Low 

Normal 

High 

Ultra 

These are relative compression levels. Note that the 
higher the compression level, the longer it takes to 
export.  

 Select None when testing the output. 

 Select Ultra or High when exporting the final 
result. 

This option is only available if the PNG image format is 
selected. 

Quality Range: 1% to 100% The higher the quality, the larger the output file size. 

This option is only available if the JPEG image format 
is selected. 

Output location 

Template Location of the template file, which the file has to use. 

Output File Specify the file path and name of exported worksheet. 
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Advanced Options 

 

These are SCORM-related options. 

Parameter Options Remarks 

Generate 
SCORM 
Package 

No 

SCORM1.2 

SCORM 2004 

If your LMS supports both 1.2 and 2004 versions of SCORM, 
please choose 2004 version (the latest version). 

Package 
Version  

 
Specify a version that can be used to differentiate manifests 
with the same identifier. For example, if you are uploading the 
same project after modifying it, provide a different version 
number. 

Identifier  Specify a name used by the LMS to identify different manifests. 
(This value is generated automatically by ActivePresenter but 
you can change it if needed.) 

Organization  Specify a title for the organization which this item belongs to. 
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Title (ActivePresenter automatically generates this value from 
project name. However, you can enter a difference text.) 

Item Title  Specify a title for the item. (ActivePresenter automatically 
generates this value from project name. However, you can 
enter a difference text.) 
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Exporting To Microsoft PowerPoint Presentation 

To export the project to Microsoft PowerPoint Presentation, click EXPORT > Microsoft 

PowerPoint . 

This has two tabs: General and Advanced. 

General Options 

 

Rendering options 

Option Remarks 

Include 
Objects 
Started by 
Event  

Include Objects Started by Event  

Only Export 
Active 

The exported area only includes the Active Window area and slide objects 
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Window Area which are selected to export. 

Layout options 

Option Remarks 

Show slide 
name 

Whether to display the slide names. 

Full Screen Open the presentation in full screen initially. 

Show slide 
description 

Whether to render the slide description. 

Use Native 
Objects 

Use Microsoft PowerPoint auto-shapes, images, text boxes, and text for 
representing slide objects. Otherwise, each object is exported as an image. 
Using native objects will allow editing the shapes directly within MS 
PowerPoint later once exported. Otherwise, slide objects are exported as 
images so it is almost impossible to edit exported document later. 

Advance 
slides 

Select between automatic and manual 

Image options 

Parameter Options Remarks 

Size Range: 10% to 150%  

(in steps of 10%) 

The size is relative to canvas size selected at the 
beginning of the project (you can check this out at any 
time by using the ACTIVEPRESENTER > Project 
Information menu option) 

Note that ActivePresenter only works with logical size 
(i.e. pixels). However, when displayed/printed, the 
physical size depends on pixels and the dpi (dots-per-
inch) setting of the displaying printing device. 

Color Depth True Colors (24 bit) 

256 Colors (8 bit) 

Grayscale (8 bit) 

Higher color depth makes the presentation look 
stunning. But it also increases the file size. When the 
images are inserted in other files, that file also will 
become large. 

Format  JPEG 

PNG 

Due to their specs and compression algorithms, JPEG 
is best suited for pictures while PNG is best suited for 
computer-generated images (screenshots, drawings...).  

Note that JPEG compression is lossy while PNG is 
lossless, so PNG retains crystal clear quality, but the 
downside of PNG is that it does not compress well with 
pictures (very big file size) and the decoding (when 
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viewing) is slower than JPEG. However, screenshots 
are compressed better with PNG, the file has small size 
and there is no loss of quality. 

Optimization 
Level  

None 

Low 

Normal 

High 

Ultra 

These are relative compression levels. Note that the 
higher the compression level, the longer it takes to 
export.  

 Select None when testing the output. 

 Select Ultra or High when exporting the final 
result. 

This option is only available if the PNG image format is 
selected. 

Quality Range: 1% to 100% The higher the quality, the larger the output file size. 

This option is only available if the JPEG image format is 
selected. 

Output location 

Template Location of the template file, which the file has to use 

Output File Specify the file path and name of exported presentation. 
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Advanced Options 

 

These are SCORM-related options. 

Parameter Options Remarks 

Generate 
SCORM 
Package 

No 

SCORM1.2 

SCORM 2004 

If your LMS supports both 1.2 and 2004 versions of SCORM, 
please choose 2004 version (the latest version). 

Package 
Version  

 
Specify a version that can be used to differentiate manifests 
with the same identifier. For example, if you are uploading the 
same project after modifying it, provide a different version 
number. 

Identifier  Specify a name used by the LMS to identify different 
manifests. (This value is generated automatically by 
ActivePresenter but you can change it if needed.) 

Organization  Specify a title for the organization which this item belongs to. 
(ActivePresenter automatically generates this value from 
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Title project name. However, you can enter a difference text.) 

Item Title  Specify a title for the item. (ActivePresenter automatically 
generates this value from project name. However, you can 
enter a difference text.) 
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Exporting To HTML5 Simulation 

HTML5 Simulation is introduced in ActivePresenter 4.0. Below are its main advantages: 

1. Learner/viewer can view the same content on various devices (PC, tablet, mobile…) or 
platforms (Windows, MacOS, Linux, iOS, Android…). 

2. The content can run on any HTML5 supported browsers such as Internet Explorer 9 (or 
newer), Mozilla Firefox, Google Chrome, Apple Safari… without using plugin (Flash or 
Silverlight player). 

3. It can also run on old browsers (Internet Explorer 7 and 8) if the appropriate plugin (Adobe 
Flash Player or Microsoft Silverlight) is installed. 

Note that due to the limitation of Internet Explorer 7 and 8, the rotation of objects will be ignored 
when displaying the HTML5 content on these browsers. 

To export the project to HTML5 Simulation, click EXPORT > HTML5 Simulation . 

The Export To HTML5 Simulation dialog has three groups of options: General, Advanced and 
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Misc (Miscellaneous). 

General Options 

 

Template Options 

HTML5 Simulation is an interactive presentation, which is delivered through a browser. A control 
toolbar is provided at the bottom the screen, which allows the user to play/pause/stop the 
presentation, hide closed captions, change volume, or jump to a particular slide. 

In this context, a template is a design pattern that is applied to this toolbar to change its 
appearance.  

If you do not want to provide any control to the user, you can opt for No_Toolbar option. 

ActivePresenter offers four default options, which can be customized further:  

Black 

Ocean 

http://atomisystems.com/tutorials/


ActivePresenter User Manual  Version 5.5 

Exporting The Project> Exporting To HTML5 Simulation 139 

Silver 

Standard 

First, select any one of the main options and then click on the Settings... button. The Template 
parameters window opens: 

 

The window shows a preview of the layout of exported project. 

This window works as follows: 

1. This drop-down list offers further presets within the selected template type. The Custom 
option allows you to customize all settings and save it as a preset. From now on, the newly 
defined preset will be available to you from the Preset drop-down list. 

2. A preview window shows the effect of your customization on the toolbar. 

3. To customize the toolbar, click on any parameters listed here, and adjust its value. The 
changes are reflected in the toolbar sample (2). 
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4. This area shows the explanation of the parameter selected above. 

Operation Modes 

In this section, there are four controls: 

Modes You can select what modes would be available to the users: Demonstration, 
Tutorial, Practice and Test. 

Recall that you can customize each object whether it can appear in each of 
these modes. Thus the same presentation can behave in totally different 
manner in different modes. 

Total max 
time  

(in minutes)  

This is the total time: The time taken by all objects to complete their lifecycle, 
plus the time allowed for the student to answer while the presentation pauses 
and waits for the answer. 

 

Interaction 
flashing 

This is the speed (milliseconds) for flashing/blinking the interaction object (for 
attracting viewer attention). 

Generate 
Index Page 

Select this option to generate the HTML index page which contains the entries 
to open all selected modes. 

Edit Output 
Language 

ActivePresenter provides ready translated texts for output (name of elements of 
toolbar and messages) for all supported languages. If you want to modify the 
translation or add the support for your language, click Edit Output Language 
button to open Output Language Editor. The Output Language option in 
ActivePresenter 3.x or older is now obsoleted. That means you can not specify 
the language for the output but the Project Language will be used for output. 

Image Options 

Parameter Options Remarks 

Size Range: 10% to 150%  

(in steps of 10%) 

The size is relative to canvas size selected at the 
beginning of the project (you can check this out at any 
time by using the ACTIVEPRESENTER > Project 
Information menu option) 

Note that ActivePresenter only works with logical size 
(i.e. pixels). However, when displayed/printed, the 
physical size depends on pixels and the dpi (dots-per-
inch) setting of the displaying printing device.  

Color Depth True Colors (24 bit) 

256 Colors (8 bit) 

Grayscale (8 bit) 

Higher color depth makes the presentation look 
stunning. But it also increases the file size. When the 
images are inserted in other files, that file also will 
become large. 

Format  JPEG Due to their specs and compression algorithms, JPEG is 
best suited for pictures while PNG is best suited for 
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PNG computer-generated images (screenshots, drawings...).  

Note that JPEG compression is lossy while PNG is 
lossless, so PNG retains crystal clear quality, but the 
downside of PNG is that it does not compress well with 
pictures (very big file size) and the decoding (when 
viewing) is slower than JPEG. However, screenshots are 
compressed better with PNG, the file has small size and 
there is no loss of quality. 

Optimization 
Level  

None 

Low 

Normal 

High 

Ultra 

These are relative compression levels. Note that the 
higher the compression level, the longer it takes to 
export.  

 Select None when testing the output. 

 Select Ultra or High when exporting the final 
result. 

This option is only available if the PNG image format is 
selected. 

Quality 
Range: 1% to 100% 

The higher the quality, the larger the output file size. 

This option is only available if the JPEG image format is 
selected. 

Fallback Media Player 

The audio/video in the HTML5 Simulation output still can be viewed normally on older browsers 
(such as Internet Explorer 7 and 8) if the required plugin is installed. This section allows you to 
choose either Adobe Flash Player or Microsoft Silverlight plugin for audio/video playback on older 
browsers which do not support HTML5. 

Output Location 

Location Location where the exported files will be placed. 
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Advanced Options 

 

Annotation Contents 

Choose between the following options: 

Convert to 
image 

ActivePresenter will convert the annotations to images so it will be displayed 
just as you see it in the ActivePresenter's Editor window. The converted output 
is browser-independent.  

However, its downside is the output size will be a little bigger and the 
annotations lose some of HTML features like clickable hyperlinks. So we 
recommend that you should not choose this feature if you have hyperlinks in 
your annotation contents. 

As HTML ActivePresenter will preserve the annotation contents as HTML so some of 
HTML features like clickable hyperlinks are preserved.  

But please note that different web browsers may render the HTML content a 
little differently. 
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SCORM Options 

Parameter Options Remarks 

Generate 
SCORM 
Package 

No 

SCORM1.2 

SCORM 2004 

If your LMS supports both 1.2 and 2004 versions of SCORM, 
please choose 2004 version (the latest version). 

Package 
Version  

 
Specify a version that can be used to differentiate manifests 
with the same identifier. For example, if you are uploading the 
same project after modifying it, provide a different version 
number. 

Identifier  Specify a name used by the LMS to identify different 
manifests. (This value is generated automatically by 
ActivePresenter but you can change it if needed.) 

Organization 
Title 

 Specify a title for the organization which this item belongs to. 
(ActivePresenter automatically generates this value from 
project name. However, you can enter a difference text.) 

Item Title  Specify a title for the item. (ActivePresenter automatically 
generates this value from project name. However, you can 
enter a difference text.) 

Report Options 

These options let you decide how to report the results of test taken by the student. 

Method Choose between- 

 No Report: Do not send report 

 Email: Send report through email 

 HTTP: Send report through HTTP request 

Format Choose between the reporting formats- 

 XML Document 

 JSON (JavaScript Object Notation) 

Email/HTTP 
address to 
receive 

This is the HTTP URL or email address that receives the report. If the method 
is HTTP, this is the address of a server side script that will process the report 
data (the data is either in XML or JSON format). 

For more details, see Appendix Reporting Options. 

Pass Condition 

This condition is used to determine the overall pass/fail result of the student when he takes a test. 
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Condition Choose between- 

 Percents of correct answers 

 Points gained 

 Number of correct answers 

Due to SCORM specifications, please take following note when a SCORM 
option is selected: 

 In SCORM 1.2, the raw score submitted to LMS is a normalized value 
in range 0-100. 

 In SCORM 2004, the raw score submitted to LMS is a normalized value 
in range 0-100 if the first condition (Percents of correct answers) is 
chosen. Otherwise, it is an absolute value. 

Minimum 
value 

Set a numerical value (no range- Free setting) 

 Note that if you select percentage, then this value cannot exceed 100. 
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Misc Options 

 

In this tab, define how the presentation would end, and whether accessibility features are enabled. 

Presentation End Behavior 

The following options are offered: 

Ask to restart or 
close presentation 
in Demonstration 
and Tutorial mode 

Whether asking viewers to restart or close at the end of presentation or 
not. When unselected, the exported presentation will stop silently at the 
last slide and the window is left open. This behavior is applicable only in 
Demonstration and Tutorial modes. 

Show report in 
Practice and Test 
mode 

If this option is unselected, then the presentation will end without 
presenting you with test result (applicable only for Practice and Test 
modes). 

Accessibility 

These options allow you to enable or disable accessibility features: 
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Enable 
accessibility text 

If this option is selected, slide and object accessibility text is exported. 
When a slide or an object is displayed, its accessibility text will be read out 
by the screen reader. 

Enable keyboard 
navigation 

If this option is selected, viewer can navigate between focusable objects 
using the Tab key. Please note that any Key Stroke object that handles 
the Tab key will not work anymore if this option is selected. 

Enable visual 
focus indicator 

If this option is selected, an outline is displayed for the object having 
focus. 
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Exporting To Flash Simulation 

To export the project to Flash Simulation, click EXPORT > Flash Simulation . 

The options here are very similar to those of HTML5 simulation. 

This has three options: General, Advanced and Misc (miscellaneous). 

The options are explained below: 

General Options 

 

Template Options 

Flash simulation is interactive presentation, which is delivered through a browser. A control toolbar 
is provided at the bottom the screen, which allows the user to play/pause/stop the presentation, 
hide closed captions, change volume, or jump to a particular slide. 

In this context, a template is a design pattern that is applied to this toolbar to change its 
appearance.  

If you do not want to provide any control to the user, you can opt for No_Toolbar option. 

ActivePresenter offers four default options, which can be customized further:  
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Black 

Ocean 

Silver 

Standard 

First, select any one of the main options and then click on the Settings... button. The Template 
Parameters window opens: 
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The window does not show a preview of the project itself.  

This window works as follows: 

1. This drop-down list offers further presets within the selected template type. The Custom 
option allows you to customize all settings and save it as a preset. From now on, the newly 
defined preset will be available to you from the Preset drop-down list. 

2. A preview window shows the effect of your customization on the toolbar. 

3. To customize the toolbar, click on any parameters listed here, and adjust its value. The 
changes are reflected in the toolbar sample (2). 

4. This area shows the explanation of the parameter selected above. 

Operation Modes 

In this section, there are four controls: 

Modes You can select what modes would be available to the users: 
Demonstration, Tutorial, Practice and Test. 

Recall that you can customize each object whether it can appear in each 
of these modes. Thus the same presentation can behave in totally different 
manner in different modes. 

Total max time 

(in minutes)  

This is the total time: The time taken by all objects to complete their 
lifecycle, plus the time allowed for the student to answer while the 
presentation pauses and waits for the answer. 

Interaction flashing This is the speed (milliseconds) for flashing/blinking the interaction object 
(for attracting viewer attention). 

Generate Index 
Page 

Select this option to generate the HTML index page which contains the 
entries to open all selected modes. 

Edit Output 
Language 

ActivePresenter provides ready translated texts for output (name of 
elements of toolbar and messages) for all supported languages. If you 
want to modify the translation or add the support for your language, click 
Edit Output Language button to open Output Language Editor. The 
Output Language option in ActivePresenter 3.x or older is now obsoleted. 
That means you can not specify the language for the output but the 
Project Language will be used for output. 

Flash Options 

Parameter Options Remarks 

Size Range: 10% to 150%  

(in steps of 10%) 

The size is relative to canvas size selected at the 
beginning of the project (you can check this out at 
any time by using the ACTIVEPRESENTER > 
Project Information menu option) 

Note that ActivePresenter only works with logical 
size (i.e. pixels). However, when displayed/printed, 
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the physical size depends on pixels and the dpi 
(dots-per-inch) setting of the displaying printing 
device. 

Image Color Depth True Colors (24 bit) 

256 Colors (8 bit) 

Grayscale (8 bit) 

Higher color depth makes the presentation look 
stunning. But it also increases the file size. When 
the images are inserted in other files, that file also 
will become large. 

Frame rate  Set between 1 and 30 fps (frames per second). 

Compression level Choose from- 

None 

1-8 (select a 
number) 

Maximum 

Select the compression level you want. 

Output Location 

Location Location where the exported files will be placed. 
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Advanced Options 

 

These are SCORM-related options. 

SCORM Options 

Parameter Options Remarks 

Generate SCORM 
Package 

No 

SCORM1.2 

SCORM 2004 

If your LMS supports both 1.2 and 2004 versions of 
SCORM, please choose 2004 version (the latest version). 

Package Version   
Specify a version that can be used to differentiate 
manifests with the same identifier. For example, if you are 
uploading the same project after modifying it, provide a 
different version number. 

Identifier  Specify a name used by the LMS to identify different 
manifests. (This value is generated automatically by 
ActivePresenter but you can change it if needed.) 
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Organization Title  Specify a title for the organization which this item belongs 
to. (ActivePresenter automatically generates this value 
from project name. However, you can enter a difference 
text.) 

Item Title  Specify a title for the item. (ActivePresenter automatically 
generates this value from project name. However, you 
can enter a difference text.) 

Report Options 

These options let you decide how to report the results of test taken by the student. 

Method Choose between- 

 No Report: Do not send report 

 Email: Send report through email 

 HTTP: Send report through HTTP request 

Format Choose between the reporting formats- 

 XML Document 

 JSON (JavaScript Object Notation) 

Email/HTTP 
address to receive 

This is the HTTP URL or email address that receives the report. If the 
method is HTTP, this is the address of a server side script that will process 
the report data (the data is either in XML or JSON format). 

For more details, see Appendix Reporting Options. 

Pass Condition 

This condition is used to determine the overall pass/fail result of the student when he takes a test. 

Condition Choose between- 

 Percents of correct answers 

 Points gained 

 Number of correct answers 

Due to SCORM specifications, please take following note when a SCORM 
option is selected: 

 In SCORM 1.2, the raw score submitted to LMS is a normalized 
value in range 0-100. 

 In SCORM 2004, the raw score submitted to LMS is a normalized 
value in range 0-100 if the first condition (Percents of correct 
answers) is chosen. Otherwise, it is an absolute value. 

Minimum value Set a numerical value (no range- Free setting) 

 Note that if you select percentage, then this value cannot exceed 
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100. 

Misc Options 

In this tab, define how the presentation would end.  

 

The following options are offered: 

Ask to restart or 
close presentation 
in Demonstration 
and Tutorial mode 

Whether asking viewers to restart or close at the end of presentation or 
not. When unselected, the exported presentation will stop silently at the 
last slide and the window is left open. This behavior is applicable only in 
Demonstration and Tutorial modes. 

Show report in 
Practice and Test 
mode 

If this option is unselected, then the presentation will end without 
presenting you with test result (applicable only for Practice and Test 
modes). 
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Reporting Options 

The reporting option is designed for publisher who does not have a SCORM-compliant LMS. It 
provides an alternative way for publisher to collect test results from learners via HTTP or Email 
protocol. 

Content Of The Report 

The report can be formatted in various ways but the content generally consists of the following: 

Name Presentation name (also project name). 

Description Presentation description (also project description). 

Date The local time (based on user computer date time setting) when the report 
is created. 

UserID  Identity of the user who takes the practice or test. When user logged in to 
take practice or test, server side script should store a cookie which its 
name is "userid" and value is the id of the user to the client computer. If no 
"userid" named cookie is found, the user will be prompt to input his/her 
identity before sending report. 

TotalTime The duration in seconds which user used to take the practice or test. 

SlideCount Number of slides in the presentation. 

Taken Number of slides which user has taken. 

Correct Number of slides which user has performed action correctly without any 
help. 

Wrong Number of slides which user has performed action incorrectly or using 
help. 

Points Points (mark) user has gained through the practice or test, only correct 
action gains points. 

MaxPoints Maximum points which user can gain in the practice or test (by taking 
correctly all slides). 

Percent Points over MaxPoints in percentage (Points/MaxPoints*100). 

Result The practice or test assessment based on pass condition. 
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 For human readable: passed or failed 

 For computer: true or false 

User passes the practice or test if his/her result greater than or equal the 
minimum required result. The result can be points which user gained, 
points gained over maximum points in percentage, or number of correct 
answer.  

Details  Detail result for each slide, consists of slide index, number of user 
attempts for the slide, and slide result. 

Report Formats 

Report formats are chosen based on how they are transmitted: 

 Plain text or CSV for email sending 

 XML or JSON for HTTP sending. 

Report In Plain Text  

Report data is formatted in plain text for human reading. 

The language can be selected when exporting. Below is an example of plain text report in English: 

Here is a sample: 

Presentation: Demo 

Description: Project for Demonstration 

Date: Fri May 25 11:28:31 GMT+0700 2012 

UserID: test 

Total Time: 0 h : 0 m : 30 s 

Total Slides: 2 

Taken Slides: 2 

Total Interactions: 2 

Taken Interactions: 2 

Correct: 2 

Points: 2 / 2 

Percentage: 100% 

Result: Passed - At least 80 % required 

 

1. Slide: 1, ID: 1_4, Attempts: 1, Points: 1, Max Points: 1, Result: Correct, 

Interaction Type: Text Box, Answer: demo 

2. Slide: 2, ID: 2_1, Attempts: 1, Points: 1, Max Points: 1, Result: Correct, 

Interaction Type: Multiple Choice, Answer: 1 
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Report In CSV Format 

The report is formatted as CSV (Comma-Separated Values). This format is suitable for importing 
into MS Excel.  

Here is a sample: 

"Presentation","Description","Date","UserID","Total Time","Total Slides","Taken Slides","Total 

Interactions","Taken Interactions","Correct","Points","Max Points","Percentage","Result" 

"Demo","Project for Demonstration","Fri May 25 11:46:11 GMT+0700 

2012","test","30","2","2","2","2","2","2","2","100","Passed" 

 

"#","Slide","ID","Attempts","Points","Max Points","Result","Interaction Type","Answer" 

"1","1","1_4","1","1","1","Correct","Text Box","demo" 

"2","2","2_1","1","1","1","Correct","Multiple Choice","1" 

Report In XML Format 

The report is formatted as XML (eXtensible Markup Language).  

Here is a sample: 

<?xml version="1.0" encoding="UTF-8"?> 

<Content> 

<Report> 

<Name>Demo</Name> 

<Description>Project for demonstration</Description> 

<Date> Fri May 25 11:28:31 GMT+0700 2012</Date> 

<UserID>test</UserID> 

<TotalTime>30</TotalTime> 

<SlideCount>2</SlideCount> 

< TakenSlide>2</ TakenSlide> 

< InteractionCount>2</ InteractionCount> 

<TakenInteraction>2</TakenInteraction> 

<Correct>2</Correct> 

<Points>2</Points> 

<MaxPoints>2</MaxPoints> 

<Percent>100</Percent> 

<Result>true</Result> 

<Details> 

<Interaction> 

<SlideIndex>1</SlideIndex> 

<ReportID>1_4</ReportID> 

<Attempts>1</Attempts> 
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<Points>1</Points> 

<MaxPoints>1</MaxPoints> 

<Result>Correct</Result> 

<Type>Text Box</Type> 

<Answers>demo</Answers> 

</Interaction> 

<Interaction> 

<SlideIndex>2</SlideIndex> 

<ReportID>2_1</ReportID> 

<Attempts>1</Attempts> 

<Points>1</Points> 

<MaxPoints>1</MaxPoints> 

<Result>Correct</Result> 

<Type>Multiple Choice</Type> 

<Answers>1</Answers> 

</Interaction> 

</Details> 

</Report> 

</Content> 

Report In JSON Format 

The report is formatted in JSON (JavaScript Object Notation) format.  

Here is a sample: 

{ 

"Name":"Demo", 

"Description":"Project for demonstration", 

"Date":" Fri May 25 11:46:11 GMT+0700 2012", 

"UserID":"test", 

"TotalTime":"30", 

"SlideCount":2, 

"TakenSlide":2, 

"InteractionCount":2, 

"TakeInteraction":2, 

"Correct":2, 

"Points":4, 

"MaxPoints":4, 

"Percent":"100", 

"Result":true, 

"Details": [ 

{ 

"SlideIndex":1, 

"ReportID":"1_4", 

"Attempts":1, 

"Points":1, 
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"MaxPoints":1, 

"Result":"Correct", 

"Type":"Text Box", 

"Answers":"demo" 

}, 

{ 

"SlideIndex":2, 

"ReportID":"2_1", 

"Attempts":1, 

"Points":1, 

"MaxPoints":1, 

"Result":"Correct", 

"Type":"Multiple Choice", 

"Answers":1 

} 

] 

} 

Transmission Of Report 

The report can be sent to a valid email or HTTP address.  

In case of sending via HTTP protocol, POST method is used, where the key is "report" and the 
value is the report content with format specified when exporting to HTML5 presentation.  

The server-side script at the HTTP address must handle and process the report.  

For example, suppose that the HTTP address is "http://atomisystems.com/reportreceiver.php". The 
following is a trivial sample code in reportreceiver.php file to receive and process report: 

<?php 

if (isset($_POST["report"])) 

{ 

//read report data 

$report = $_POST["report"]; 

//process report, e.g. append to a text file here 

$report_file = fopen("report.txt", "a"); 

if($report_file) 

{ 

fwrite($report_file, $report); 

//separate this report from others 

fwrite($report_file,"\n\n---------\n\n"); 

fclose($report_file); 

} 

} 

?> 

 

 

http://atomisystems.com/tutorials/


ActivePresenter User Manual  Version 5.5 

Other Uses Of ActivePresenter> ActivePresenter As Image Editor 159 

Other Uses Of 
ActivePresenter 

So far we have seen how to use ActivePresenter for presentations of various types (images, 
documents, videos and interactive learning courses with scoring facility). 

But ActivePresenter can also be used for many other purposes:  

1. Image editor 

2. Image format converter 

3. Screenshot software 

4. Audio/video editor (trimming, cutting, splicing/joining, adding titles) 

5. Text to speech (TTS) generator 

6. Image/Audio/video format converter 

ActivePresenter cannot edit the object directly like a dedicated software: You have to first insert the 
object in a new/existing project, and then edit it. This main editing process is very similar to the 
process flow in a dedicated software. Once you have finished editing the object, you can close the 
host project without saving it. 

Let us see each function in more detail: 

ActivePresenter As Image Editor 

You can edit and/or annotate an image with ActivePresenter. 

While ActivePresenter is not as powerful as GIMP or InkScape, you can do a lot with it. 

Actually ActivePresenter has a built-in Image Editor but it is not accessible directly. So you have 
insert the image in a new project (or existing project) in order to access it. Once you have finished 
editing the image, you can close the host project without saving. 

This is a five-step process:  

1. Open a project of any type, or open an existing project. 
Don't worry about its parameters, because the project will not be changed in any way. 

2. Insert the image in any slide. Again, don't worry about how this affects the slide: We are 
not going to save the project. 

3. Right-click on the image in the Canvas pane (or its time bar in the Timeline pane). From 
the context menu that appears, select the Edit image... option. The Image Editor pops up 
and lets you edit the image. 

4. After editing, you can directly save the image as a file using the ACTIVEPRESENTER > 
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Save as... menu option. 

5. Close the project without saving. 

 

ActivePresenter As Image Format Converter 

This is a four-step process:  

1. Open a project of any type, or open an existing project. 
Don't worry about its parameters, because the project will not be changed in any way. 

2. Insert the image in any slide. Again, don't worry about how this affects the slide: We are 
not going to save the project. 

3. Right-click on the image in the Canvas pane (or its time bar in the Timeline pane). From 
the context menu that appears, select the Export To File... option. A dialog pops up. In its 
“Save as type” drop-down list, select your desired format (png / jpeg / bmp). 

4. Close the project without saving. 

ActivePresenter As Screenshot Software 

This is a five-step process (ActivePresenter cannot snap and save a screenshot image directly): 

1. Open a project of any type, or open an existing project. 
Don't worry about its parameters, because the project will not be changed in any way. 

2. Take a screenshot (any window, object, whole screen or a rectangular area on screen). 

When taking a screenshot in Application or region mode, be sure to select the Insert as 
image to current slide check box. ActivePresenter inserts it as an image in the current 
slide. 

3. Right-click on the image in the Canvas pane (or its time bar in the Timeline pane). From 
the context menu that appears, select the Edit image... option. The Image Editor pops up 
and lets you edit the image. 

4. After editing, you can directly save the image as a file using the ACTIVEPRESENTER > 
Save as... menu option. 

5. Close the project without saving. 

ActivePresenter As Audio Editor 

This is a five-step process:  

1. Open a project of any type, or open an existing project. 
Don't worry about its parameters, because the project will not be changed in any way. 

2. Insert the audio that is to be edited. 

3. Now you can edit this track in one or more of the following: 
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1. Edit the track using the Range-Edit commands 

2. Insert silence of any duration you want. 

3. Adjust the volume of the track between any selected moments 

4. Join the track with other audio tracks 

4. Right-click on the  icon in the Canvas pane (or its time bar in the Timeline pane). 
From the context menu that appears, select the Export To File... option.  

If you had split the audio track in Step-3, you can save any (or all-) of those parts 
individually. 

5. Close the project without saving. 
 

ActivePresenter As TTS Generator 

This is a five-step process: 

1. Open a project of any type, or open an existing project. 
Don't worry about its parameters, because the project will not be changed in any way. 

2. Select the ANNOTATION > Audio > Create New... menu option.  

3. In the Audio window that pops up, type some text (or copy from another document) in its 
Text To Speech section (at bottom), and press the Generate button. This converts the text 
to speech and inserts a new audio track in the slide. 

4. Right-click on the  icon in the Canvas pane (or its time bar in the Timeline pane). 
From the context menu that appears, select the Export To File... option. 

5. Close the project without saving.  

ActivePresenter As Video Editor 

This is a five-step process: 

1. Open a project of any type, or open an existing project. 
Don't worry about its parameters, because the project will not be changed in any way. 

2. Click on the ANNOTATION > Video tool . Select the video that is to be edited. 

3. Now you can edit this track in one or more of the following: 

1. Edit the track using the Range-Edit commands 

2. Freeze the frame (insert a pause) for any duration you want. 

3. Adjust the volume of the track between any selected moments 

4. Join the track with other video tracks 

4. Right-click on the video frame in the Canvas pane (or its time bar in the Timeline pane). 
From the context menu that appears, select the Export To File... option.  
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If you had split the video track in Step-3, you can save any (or all-) of those parts 
individually. 

5. Close the project without saving. 

ActivePresenter As Format Converter 

ActivePresenter can convert the formats of an image, audio or video. 

In fact, whenever you edit image, audio or video (as explained above), you have the choice to save 
the resultant object in a different format. 

All you have to do is in the Export To File... dialog, click on the Save as type drop-down list, and 
select the desired format.  Then press OK. 

ActivePresenter saves the file in the new format.
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Appendices
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Using ActivePresenter 
Windows 

In this Appendix, we will see how to use the various windows in ActivePresenter. 

Using The Capture Profile Editor 

The Capture Profile Editor window is launched when you launch a new profile or edit an existing 
profile from the New Project window. 

 If you have launched a new profile, ActivePresenter allows you to copy settings from an 
existing capture profile, by launching the following window. 

 

Select “None” if you want to build a new profile from scratch. 

The Capture Profile editor has five different tabs, each dealing with a specific area. The values set 
in all these tabs are saved in the current profile. 

The Save and Cancel buttons at the bottom are common between the five tabs. The new settings 
do not take effect till you have saved the profile. 

Once you create a new profile, it will be available in the Capture New Project window. 

The tabs are described below: 
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The General Tab 

This tab allows you to make generic choices for the capture settings. 

 

It has three sections: Capture Profile, Capture Type and Automatic Panning. These are explained 
below: 

Capture Profile 

This section records the name and description for the profile. 

Parameter Remarks 

Profile Name  The name must be indicative of the end-purpose of the project. 

Description Describe the end-purpose and your strategy for the project. 

(Note that each different end-purpose calls for a different project-settings, and 
also different approaches for capturing, annotation and interaction. The end-
purpose will also affect the format of the video and/or documentation.) 
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Capture Type 

Here, choose between two main capture modes: Smart Capture and Full Motion Recording (FMR).  

 The FMR mode is like recording a movie with a fixed rate of frames per second. It does not 
respond to any mouse/keyboard inputs. Therefore there are no further choices in this 
mode. 

 If you choose the Smart Capture mode, ActivePresenter offers further choices:  

Option Remarks 

Automatically 
use FMR for 
Drag and Drop 
Actions  

Captures the target screen when you drag any item with LMB or RMB. The 
entire dragging action will be captured in FMR mode (with a fixed frame rate). 
When the drag action is over, ActivePresenter will switch back to the Smart 
Capture mode. 

Automatically 
use FMR for 
Mouse Wheel 
Actions 

Captures the target screen in FMR mode (with a fixed frame rate) when you 
scroll the mouse-wheel up or down.  

The FMR mode will last as long as you scroll the wheel. After that, 
ActivePresenter will switch back to the Smart Capture mode. 

Automatic Panning 

This facility is useful only when your capture frame is smaller than the target application's screen, 
and if you want to freely move (“pan”) that frame to any part of the screen. 

But if you are anyway capturing the entire screen of the target application (or the whole desktop 
screen), then this technique is not applicable. 

 

Usually you use this feature when the target application has many controls, and you want to zoom 
in to a certain part of the screen at a time, but keep your option open to move to any other part of 
the screen, as required. 

Option Remarks 
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Make Capture 
Window 
Follow Mouse 
Cursor 

When this option is selected, the capture frame follows the mouse pointer 
around the screen. 

As long as the pointer is within the capture frame, the frame does not move. 
But when the mouse pointer crosses any side of the frame, the frame starts 
following it. 

Panning 
Speed 

Set the speed (in pixel/s) at which the frame will start following your mouse 
pointer. 

Note that very high speeds are unsettling for the viewers, because the small 
capture frame presents a blinkered view to begin with, and at high pan 
speeds, the user won't realize which area of the screen you are at!  

Use this facility sparingly, because the viewer will get a blinkered view of the target application, 
which is often irritating. Instead of this feature, consider using the pan-n-zoom feature, which 
zooms in from full-screen view to a small area, and zooms back as soon as the detail is shown.  
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The Audio & Video Tab 

This tab provides more choices for the Full Motion Recording (FMR) mode and audio. 

 

It contains two sections: 

1. Video Settings 

2. Audio Settings 

Both sections are unrelated, but placed on the same tab for convenience. 

These sections are explained below: 

Video Settings 

The video settings section has three options: 

Option Remarks 

Video codec ActivePresenter offers a choice of four video codecs: 

1. Flash Screen Video (lossless) 
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2. MPEG1 (lossy) 

3. MPEG2 (lossy) 

4. H264/MPEG-4 AVC (lossy) 

When the flash codec is selected, ActivePresenter uses the lossless algorithm 
in encoding to preserve the quality. But when you select the MPEG1 or 
MPEG2 or H264 codec, ActivePresenter down-samples the video data, 
resulting in reduced file size but at the cost of irreversible loss of video detail. 

Frame rate A higher frame rate would increase the size of the recorded video. It may also 
overload simpler computers, because the computer not only has to run all the 
applications, but capture those screens in real time. In the worst case, you will 
see dropped frames in the captured video. 

On the other hand, a lower frame record will appear jerky.  This especially 
happens with rates lower than 15 frames/s. Besides, you may miss capturing 
some low-duration events (something that just flashes on the screen and 
vanishes). 

The most commonly used range is 20-30 frames/s. 

Key frames 
every x frames 

This is the number of continuous non-key frames between key frames. When 
recording video, ActivePresenter will automatically place a key frame every X 
frames. 

When you change the frame rate, ActivePresenter automatically adjusts this 
setting so that the video will have exactly one key frame every four seconds. 
But you can manually change this rate. 

Key frames are full frames that video player can jump directly to, a higher 
value results in a (little bit) smaller video size, but will make seeking less 
accurate. Also, in case of corruption, lesser number of frames are lost 
because the key frames are spaced closer. 

As a compromise, the [4 - 400] range is used. 

Quality When you select one of the lossy codecs, ActivePresenter allows you to select 
a quality level between 1 (min) and 100 (max). The higher the number you 
select, the better is the video quality and the larger is the file size. 

Audio Settings 

This section contains three options to balance between the audio quality and storage size: 

Option Remarks 

Audio Codec ActivePresenter offers a choice of three audio codecs: 

1. 16-bit PCM (lossless) 

2. Vorbis (lossy) 

3. MP3 (lossy) 

When the 16-bit PCM is selected, ActivePresenter uses the lossless algorithm 
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in encoding to preserve the quality. But when you select the Vorbis or MP3 
codec, ActivePresenter use the lossy algorithm in encoding, resulting in 
reduced file size but at the cost of irreversible loss of audio quality. 

Sample Rate The incoming analog sound is first converted into digital form and then stored 
on the disk. This digital sound is not the exact replica of the original: Some 
fidelity is always lost. The fidelity of the digital sound depends on the sample 
rate and bit rate: Higher the sampling and bit rate, better the fidelity. 

However, higher fidelity also increases the file size, as more data needs to be 
stored. 

The most popular sampling rates are listed here. 

Channels Choose from Mono and Stereo. Unless you are opting for a studio-recorded 
sound track, Mono is sufficient. (During playback, the sound card feeds the 
same sound in left and right channels). 

Stereo recording needs double the storage size as compared to Mono.  

Bit Rate This is the amount of compressed data needed to store one second of sound. 
Higher the bit rate, better the audio quality and larger the file size. 

This option is only available if the MP3 audio codec is selected because 
ActivePresenter encodes the MP3 audio in constant bit rate mode.  

Quality ActivePresenter allows you to select a quality level between 1 (min) and 100 
(max). The higher the number you select, the better is the audio quality and 
the larger is the file size. 

This option is only available if the Vorbis audio codec is selected because 
ActivePresenter encodes the Vorbis audio in constant quality mode. 
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The Cursor Tab 

 

The options in the Cursor tab apply for both cursors in recorded video and the cursors of cursor 
path object. The Cursor tab contains the following options: 

Option Remarks 

Record Mouse 
Cursor 

It is common that you want to record the cursors in a software 
demonstration video, so this option is selected by default. Sometimes, you 
don’t want the cursors appear in recorded result, for example, when 
recording movies or slide-based materials for assessments. In these 
cases, you should deselect this option. 

Make Cursor 
Editable for Full 
Motion Recording 

ActivePresenter allows you to edit the cursor highlight, mouse click sounds 
and effects in recorded video if this option is selected before recording. 
De-select this option if you want the cursors are rendered directly into 
video.  

More Settings… Click this button if you want to customize the cursor highlight, mouse click 
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sounds and effects. This will open up the Cursor Path settings page of 
program if you are creating a new project or the Cursor Path settings 
page of the current project if you are inserting additional content by 
capturing. 

The Annotation Tab 

This tab controls the annotations and interactions that are automatically added during the capture 
mode. (These are distinct from the annotations and interactions added during the editing of 
the captured project.) 

The options on this tab get activated only when you select the Smart Capture mode (in the 
General tab). If you select the FMR mode, none of the options apply. 

 

The annotation tab has two main sections, one for the mouse and the other for the keyboard.  
Both sections have identical options, as follows: 

Option Remarks 

Annotation To introduce an annotation (mouse/key) that is about to occur or to guide the 
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learners how to operate. Annotation is usually used for demonstration and 
training. 

Correct 
Message 

Incorrect 
Message 

Hint 
Message 

Correct, Incorrect and Hint message are feedback objects: ActivePresenter 
presentations can provide a feedback to the viewer's action when he interacts 
with the HTML5/Flash simulation (in Tutorial, Practice or Test mode; but not in 
Demo).  

The Correct Message is displayed if user action is correct.  

Conversely, the Incorrect Message is displayed if user action is incorrect. 

The Hint Message is displayed when user hovers the mouse over the interactive 
object (Mouse Click, Key Stroke).  

See the demo for an example of interactive objects and feedback messages.  

When the Use OLE Automation for Microsoft Office option is checked, ActivePresenter can get 
more precise size and location of captured interactions when capturing MS Office. But sometimes 
it causes MS Office working improperly (e.g. MS Excel 3D references). If this happens, just 
disable this option. 

For capturing other applications, ActivePresenter just ignores this option. 
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The Hotkeys Tab 

 

The Hotkeys tab lets you set the keyboard shortcuts for various functions. 

The Restore defaults button at the bottom restores the values to their default values. This is 
useful if you have experimented with the controls far too much and want to start over. 

ActivePresenter allows you to define hot keys for seven functions, as shown above. The Capture In 
Advance function is similar to Manual Capture except the captured screenshot will be used as 
background for next step. This function may be useful in some circumstance, for example when 
you want to capture a button in normal state, not in hover state. 

Sometimes the target application also needs the same hot keys. In such cases, you can disable 
the Use hot keys check box or define different ones for ActivePresenter. 

To change any hot key, just click inside the box, and press the new combination of keys on your 
keyboard. Immediately that combination appears in the box. 

The new combination does not take effect till you click the Save button. 
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Using The Event Editor 

The event editor defines the behavior for each interaction. 

Each type of interaction can handle certain events (trigger conditions), by taking one or more 
actions. It is the job of the Event Editor to define the actions to be taken for each event. 

To launch the Event Editor window, use any of the following methods: 

1. In the context menu of any interactive object, select the Event Properties option (at the 
top). 

2. Double-click on the main object in the main window. 
(Careful! If you double-click on an element of the object, this editor will not pop up!) 

3. Select the object in Canvas pane or Timeline pane, and then go to the INTERACTION tab 

and click Event . 

In case of drop targets, you have only one option to launch the Event Editor window: edit the 
Accept List property of the drop target from the Drag-n-Drop page in Properties pane. 

For each type of interaction, the Event Editor will have to define different behaviors. Each aspect of 
the behavior is covered by a separate tab. The structure of a given tab does not change from 
object to object. 

Thus the Event Manager employs a different set of tabs for each interaction.  

The tabs are described below: 

Tab Defines- 

Mouse Click Defines correct mouse activities (e.g. single left-click, double left-click, right-
click, etc.; with or without modifier keys, such as SHIFT, CTRL and ALT), and 
optionally score, actions to be taken for each specific activity. 

Key Stroke Defines correct hot keys, and optionally score, actions to be taken for each hot 
key. 

Text  Defines the reference text strings against which the user's input is to be 
compared. And optionally defines score, actions to be taken for each specific 
text string. 

Accepted 
Drag Sources 
(for Drop 
Target) 

Defines drag sources that can be dropped onto the drop target, and optionally 
actions to be taken for each dropped source. 

Also defines maximum number of accepted drag sources that can be dropped 
onto the drop target. 

Accepted 
Drag Sources 
(for Drop 
Area) 

Defines drag sources that can be dropped onto the drop area, and optionally 
score, actions to be taken for each dropped source. 
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Choice (for 
Multiple 
Choice 
Question) 

The tab checks whether the user has chosen the correct option; and also 
optionally responds to each option chosen (for example, display a hint 
message as to why this is not the correct choice, and ask the user to try again.) 

Choice (for 
Multiple 
Response 
Question) 

The tab allows the user to select multiple responses, and optionally allocate 
different point for each response. 

Answer (for 
Drag-n-Drop 
Question) 

Defines correct answer for the Drag-n-Drop Question. The answer consists of 
multiple drag source – drop target pairs. 

Also defines overall score for the question, or partial score for each drag source 
– drop target pair. 

Settings Defines the behavior of the interactive presentation when the user is not 
responding well. It defines the maximum allowable number of attempts, 
whether to pause the presentation to wait for the user's input, and the 
maximum allowed time-limit. 

On Correct Defines the action to be taken when the user gives a correct response. 

On Incorrect Defines the action to be taken when the user gives an incorrect response. 

On 
Incomplete 

Defines the behavior of the interactive presentation when the user has not 
completed his answer.  

On Timeout Defines the behavior of the interactive presentation when the user fails to 
respond within the time limit defined in the Settings tab. 

On Rollover Defines the behavior of the interactive presentation when the user rolls the 
mouse over the main area of the interaction. 

On Rollout Defines the behavior of the interactive presentation when the user rolls the 
mouse off the main area of the interaction. 

On Accept Defines actions to be taken when the drop target accepts a drag source. 

On Reject Defines actions to be take when the drop target rejects a drag source. 

 

The Mouse Click Tab 

The Mouse click tab provides interaction and point-allocation for mouse clicks (optionally, with 
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modifier keys, such as SHIFT, CTRL and ALT). 

 

The GUI works as follows: 

1. The Points assigned here are common for any of the events listed below. (For this option to 
work, the Score by event check box must be cleared. In that case the Points column 
below is removed.) 

In this example, if the user any of the combinations listed below, he will earn 5 points. 

2. The Score by event check box allows you to specify different scores for different events. 
(When you click in this check box, the Points column is activated in the pane below; and at 
the same time the Points control at the top is disabled.) 

Now you can double-click in any cell in this column, and enter any number. 

In this example, if the user clicks (or double-clicks) the LMB, he will earn 4 points. If he 
clicks CTRL+Left click or ALT+Right click, he will earn 3 points. 

3. The Action by event check box allows you to add multiple actions for each event. (When 
you click in this check box, the Actions column is activated in the pane below.) 

Now you can double-click in any cell in the Actions column, and select an action from the 
drop-down list. 

In our example, the first two events trigger two actions each:  

 If the user left-clicks, ActivePresenter will open a website and then continue the 
presentation. 

 If the user CTRL+Left-clicks, ActivePresenter will send an email and the end the 
presentation. 
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4. These buttons are used to organize the entries in the bottom pane: 

The  button adds a new action to the selected row. 

 If you had clicked in the Event column, this button adds an event. 

 If you had clicked in the Action column, this button adds an action within the same 
event. (In this way you can associate multiple actions with a given event.) 

The  button removes the selected row. 

 If you had clicked in the Event row, this button deletes the event and all its actions. 

 If you had clicked in the Action column, this button removes the action, but does not 
affect the Event row. 

The  and  buttons move the selected row up and down in the stack. 

 If you had clicked in the Event row, these buttons move the event and all its actions 
together (as a set). 

 If you had clicked in the Action column, these buttons move the Action row, but do 
not affect the Event row. 
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The Key Stroke Tab 

The Key stroke tab provides interaction and point-allocation for keyboard activities. 

The tab for keyboard entries is shown below: 

 

As can be seen above, these events are keyboard-based (either a single key or a combination of 
any number of keys; but not a text string). 

The GUI works as follows: 

1. The Points assigned here are common for any of the events listed below. (For this option to 
work, the Score by event check box must be cleared. In that case the Points column 
below is removed.) 

In this example, if the user presses any of the combinations listed below, he will earn 4 
points. 

2. The Score by event check box allows you to specify different scores for different events. 
(When you click in this check box, the Points column is activated in the pane below; and at 
the same time the Points control at the top is disabled.) 

Now you can double-click in any cell in this column, and enter any number. 

In this example, if the user presses CTRL+P, he will earn 3 points. If he presses the Space 
bar, he will earn 2 points, etc. 

3. The Action by event check box allows you to define a different action for each event. 
(When you click in this check box, the Actions column is activated in the pane below.) 
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Now you can double-click in any cell in the Actions column, and select an action from the 
drop-down list. 

In this example, note that the first two events will trigger two actions each: 

 If the user presses CTRL+P, ActivePresenter will first display the Correct message 
object, and then pause the presentation. 

 If the user presses CTRL+SHIFT+L, the presentation will jump forward by 10 slides 
and then pause. 

4. These buttons are used to organize the entries in the bottom pane: 

The  button adds a new action to the selected row. 

 If you had clicked in the Event column, this button adds an event. 

 If you had clicked in the Action column, this button adds an action within the same 
event. (In this way you can associate multiple actions with a given event.) 

The  button removes the selected row. 

 If you had clicked in the Event row, this button deletes the event and all its actions. 

 If you had clicked in the Action column, this button removes the action, but does not 
affect the Event row. 

The  and  buttons move the selected row up and down in the stack. 

 If you had clicked in the Event row, these buttons move the event and all its actions 
together (as a set). 

 If you had clicked in the Action column, these buttons move the Action row, but do 
not affect the Event row. 

The Text Tab 

The Text tab checks whether the user has entered the correct text string in response to a Text 
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Box, an essay question or a fill in the blank type question. 

 

The GUI works as follows: 

1. The Points assigned here are common for any of the events listed below. (For this option to 
work, the Score by event check box must be cleared. In that case the Points column 
below is removed.) 

In this example, if the user enters Bangalore, Mumbai, Hanoi or London, he will earn 5 
points. 

If he enters anything else, he will not earn any points. 

2. The Score by answer check box allows you to specify different scores for different 
answers. (When you click in this check box, the Points column is activated in the pane 
below; and at the same time the Points control at the top is disabled.) 

Now you can double-click in any cell in the Value column, and enter any string. In this 
example, if the user enters Bangalore, he will earn 5 points; and if he enters London, he will 
earn 4 points. 

3. The Action by answer check box allows you to define a different action for each answer. 
(When you click in this check box, the Actions column is activated in the pane below.) 

Now you can double-click in any cell in the Actions column, and select an action from the 
drop-down list. 

Notice that our example shows three actions if the user enters Bangalore: 

 First, execute a specified JavaScript 
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 Jump to slide#3, and then 

 Pause the presentation. 

4. These buttons are used to organize the entries in the bottom pane: 

The  button adds a new action to the selected row. 

 If you had clicked in the Event column, this button adds an event. 

 If you had clicked in the Action column, this button adds an action within the same 
event. (In this way you can associate multiple actions with a given event.) 

The  button removes the selected row. 

 If you had clicked in the Event row, this button deletes the event and all its actions. 

 If you had clicked in the Action column, this button removes the action, but does not 
affect the Event row. 

The  and  buttons move the selected row up and down in the stack. 

 If you had clicked in the Event row, these buttons move the event and all its actions 
together (as a set). 

 If you had clicked in the Action column, these buttons move the Action row, but do 
not affect the Event row. 

5. Choose how the user will submit his answer: 

If you select the Auto option, the answer is checked each time the text in the field is 
changed (i.e. ActivePresenter checks as you type). 

If you select the Press key option, you have to click in the input box and press a hot key. 
The user will have to press the same hot key to submit his answer. 

 It is your responsibility to convey to the user which hot key is defined (use a 
message, for example). 

6.  If you click in this check box, the answer will be case-sensitive. So if the user enters london 
(instead of London), he will not earn any points. 

The Choice Tab 

There are two different tabs named “Choice”: One is used in the Multiple Choice interaction, and 
the other is used in the Multiple Options interaction. 

This section describes them both. 

For Multiple Choice Question 

The Choice tab checks whether the user has chosen the correct option; and also optionally 
responds to each option chosen (for example, display a hint message as to why this is not the 
correct choice, and ask the user to try again.) 

Note that before coming to the Event Editor, you must enter the text for all options. The Choice 
column reflects this text. (You cannot edit this column in the Event Manager). 
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The GUI works as follows: 

1. Enter the points to be earned.  (For this option to work, the Score by event check box must 
be cleared. In that case the Points column below is removed.) 

If the user selects the correct option, he earns these points. 

If he selects the incorrect option, he earns no points. 

2. Click on the radio button of the correct option. 

In this example, Answer 1 is the correct option. 

3. Sometimes, the answers are not strictly right/wrong: Even the other answers may be 
partially right; but some of them may be preferable. 

To handle such situation, select the Score by choice check box. This activates the Points 
column in the pane below. Now, allocate different points to each option to differentiate 
between non-preferable and preferable answers. 

In each row, double-click in the cell in the Points column, and enter points. 

4.  Apart from allocating the points, you may also want to respond to the user (e.g. You can 
state why his answer is wrong, followed by the “try again!” message). 

To do this, click on the Action by choice check box. Immediately the Actions column 
appears in the pane below. 

Now double-click in each row in this column, and from the drop-down list that appears, 
select an action. 

You can enter multiple actions for any given choice. This example shows two actions for 
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each answer. 

5. These buttons are used to organize the Action rows within a given answers. (You cannot 
change the order of the answers, simply because the answers need not be in a particular.) 

 Click in the Action column first and then click on  button to add an action. (In this 
way you can associate multiple actions with a given event.) 

 The  button removes the selected action. 

 If a given answer contains multiple actions, the  and  buttons move the selected 
actions up and down in the stack within the answer. 

For Multiple Response Question 

The Choice tab allows the user to select multiple options, and optionally allocate different points 
for each option. 

 

The GUI works as follows: 

1. Enter the points to be earned. 

(For this option to work, the Partial score check box must be cleared. In that case the 
Points column below is removed.) 

To earn these points, the user has to select all the correct answers, and avoid selecting any 
of the wrong answers. If he misses any of the right answers, or selects any of the incorrect 
answers, he will earn no points. 

In other words, this is “all or nothing” strategy. 
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2. Place a tick against all correct answers. There may be more than one correct answers. 

If the user selects these options, the action(s) defined in the On Correct tab will be 
executed. If he selects the other options, the action(s) defined in the On Incorrect tab will 
be executed. 

3. Partial scores 

This strategy allows the user to earn some points for each correct answer. To achieve this, 
select the Partial score option. Now the Points (1) control is disabled, and a Points 
column is activated in the table below. Assign points to each answer.  

 Sometimes all answers are not of equal merit: You may want to give less points if 
the answer is more obvious than the others. 

When the user selects a correct answer, he earns the points assigned to that particular 
answer. As he chooses more correct answers, these partial scores are added up. 

However, if he chooses any of the wrong answers, then the whole answer is considered 
incorrect, and he will lose all the partial points earned in this question. 

Note that this interaction cannot have a response action per answer, because there are multiple 
correct answers; and there is no way to predict which ones are attempted by the user; and which 
answers are correct. Thus it is virtually impossible to set a trigger condition. 

The Accepted Drag Sources Tab 

There are two different tabs named “Accepted Drag Sources”: One is used in the Drop Area 
interaction, and the other is used in the normal drop target object. 

This section describes them both. 

For Drop Target Object 

This tab defines drag sources that can be dropped onto the drop target, and optionally actions to 
be taken for each dropped source. It also defines maximum number of accepted drag sources that 
can be dropped onto the drop target. 
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The GUI works as follows: 

1. Specify the number of drag sources that can be accepted by the drop target. If the number 
is finite, you can define what happens when users drop more drag sources (that are in the 
accept list specified in the second step) than this number: 

 Reject: The drop target does not accept the new dropped object. The dropped 
object is sent back to its original position, and the On Reject event is triggered. 

 Replace the Last: The last dropped object is sent back to its original position, the 
new dropped object is accepted. Of course, the On Accept event is triggered in this 
case. 

2. Specify drag sources that can be accepted by the drop target. You can select/deselect the 
Accept All checkbox to select/clear all accepted drag sources. 

 When a non-accepted drag source is dropped, it is sent back to its original position, 
and the On Reject event is triggered. 

 When an accepted drag source is dropped, if the number of already dropped object 
is smaller than the maximum accepted objects specified in the first step, the drag 
source is accepted, and the On Accept event is triggered. Otherwise, the output 
simulation acts as described in the first step. 

3. Specify actions to be taken when each drag source is accepted. When the user drops a 
drag source and it is actually accepted (i.e. not rejected as described in the first step), these 
actions are executed first, before executing the actions in the On Accept tab. 
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4. These buttons are used to add/remove/order the actions for each accepted drag source. 
(You cannot change the order of the accepted drag sources, simply because they need not 
be in a particular, and they are displayed here based on their z-index.) 

 Click in the cell in the Actions column first and then click on the  button to add an 
action. (In this way you can associate multiple actions with a given drag source.) 

 Select actions and click on the  button to removes them. 

 If a given drag source contains multiple actions, the  and  buttons move the 
selected actions up and down. 

For Drop Area Interaction 

This tab defines drag sources that can be dropped onto the drop area, and optionally score, 
actions to be taken for each dropped source. 

 

The GUI works as follows: 

1. The Points assigned here are common for any of the accepted drag sources listed below. 
(For this option to work, the Score by Object check box must be cleared. In that case the 
Points column below is removed.) 

2. Specify drag sources that can be accepted by the drop area. 

 When a non-accepted drag source is dropped, it is sent back to its original position, 
and the On Incorrect event is triggered. 

 When an accepted drag source is dropped, it will be accepted and the On Correct 
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event is triggered. If the drop area already contains a dropped object, it will be sent 
back to its original position before the new dropped object is accepted. (The drop 
area behaves similar to the drop target with the settings: Max Accepted Objects: 1, 
On Max Accept: Replace the Last.) 

3. The Score by Object check box allows you to specify different scores for different 
accepted drag source. When you select this check box, the Points column is displayed; 
and at the same time the Points control at the top is disabled. 
In this example, the “Hexagon” drag source is correct, but it is not good as the “Regular 
Hexagon” one, so it gains lesser score. 

4. The Action by Object check box allows you to add multiple actions for each accepted drag 
source. When you select this check box, the Actions column is displayed. These actions 
will be executed when the drag source is accepted, before executing the actions in the On 
Correct tab. 
In this example, a shape is displayed when the user drops the “Hexagon” to suggest that 
the “Regular Hexagon” is more suitable. 

5. These buttons are used to add/remove/order the actions for each accepted drag source. 
(You cannot change the order of the accepted drag sources, simply because they need not 
be in a particular, and they are displayed here based on their z-index.) 

 Click in the cell in the Actions column first and then click on the  button to add an 
action. (In this way you can associate multiple actions with a given drag source.) 

 Select actions and click on the  button to removes them. 

 If a given drag source contains multiple actions, the  and  buttons move the 
selected actions up and down. 

The Answer Tab (for Drag-n-Drop Question) 

This tab defines correct answer for the Drag-n-Drop Question. The answer consists of multiple 
drag source – drop target pairs. It also defines overall score for the question, or partial score for 
each drag source – drop target pair. 
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The UI works as follows: 

1. Specify the Points for the question. (For this option to work, the Partial score check box 
must be cleared. In that case the Points column below is removed.) 

2. Specify correct drag source – drop target pairs. The question is considered correct if all 
drag sources in this list are dropped into correct drop targets. 

 To add a pair of drag source – drop target, click on the  button, or double click on 
empty area of the list. 

 To change a pair of drag source – drop target, double click on the drag source or 
the drop target. 

 To remove drag source – drop target pairs, select them and click on the  button. 

 One drag source can be mapped to multiple drop targets. When taking the output 
simulation, users can drag the source to one of the targets. 

 Multiple drag sources can be mapped to one drop target. When taking the output 
simulation, users must drag all of the sources to the drop target. 

3. The Partial score check box allows you to specify score for each pair of drag source – 
drop target. When you select this check box, the Points column is displayed; and at the 
same time the Points control at the top is disabled. 

 When the user drops a drag source to the correct drop target, he earns the points 
assigned to that particular pair. When he maps more correct drag source – drop 
target pairs, the score is added up. 

 However, if he maps a drag source – drop target pair incorrectly (the pair is not in 
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the list specified in the second step), then the whole answer is considered incorrect, 
and the score will be zero. 

4. Use the ,  button to add, remove drag source – drop target pairs. 

The Settings Tab 

This tab defines the behavior of the interactive presentation when the user is not responding well: 

 

It has three sections, as shown above: 

1. Attempts 

Max Attempts After the user makes the predefined number of attempts, the interactive object will 
be disabled: The user can't interact with it anymore.  

Infinite This check box overrides the number of attempts defined at the left. 

2. Pause 

Pause 
presentation 
to wait for 
user input 

This is indefinite pause: All objects stop playing as seen on the Timeline pane. 
However, the user can still interact with the interactive objects. The presentation 
resumes when one of the following actions is executed: Continue Presentation, 
End Presentation, Go to Slide, Go to Slide at Index, Go Forward, or Go Backward.  

So if the author selects this option, he must define one of above actions in the On 
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Correct tab, and in the On Incorrect tab (for the Last attempt). In fact, when the 
author inserts a new interactive object, ActivePresenter provides default actions. 

After showing 
object xxx 
milliseconds  

This time is relative to the Starting instant for the interactive object. For example, if 
xxx is 1000 ms, the presentation is paused when the interactive object is displayed 
for 1000 ms. 

Just before 
hiding object 

Here, the presentation is paused just before the hiding transition of an object 
begins. In other words, when the presentation is resumed, the first thing to happen 
will be the exit of this particular object. 

 

3. Timeout 

Enable time 
limit 

You can disable the time limit by unchecking this check box. 

When timeout is active, if the user does not respond within the defined time limit, 
the interactive object is disabled. 

Time Timeout is defined in terms of HH:MM:SS 

The On Correct Tab 

This tab is used in all interactions except the Mouse hover interaction. It defines the action to be 
taken when the user gives a correct response. 
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The GUI works as follows: 

1. The actions are listed in a stack. 

They are executed in the order of appearance (top-to-bottom). 

In this example: 

 The presentation will show the correct message#11 (ActivePresenter provides internal 
reference numbers to each message. This particular message is the Correct message 
for this particular interaction.)  
Note that the Show Object action doesn't control the display duration of the message. 
To change the display duration of the message, select the message in the Canvas and 
change its duration in the Properties pane. 

 After that, ActivePresenter will continue the presentation. 
If the presentation is playing, this action does nothing. 
If the presentation had paused (because a Pause is set in an interactive object or if an 
object takes the Pause Presentation action in response to a trigger event), the 
Continue Presentation action will continue playing the presentation from the time it is 
paused. 

2. These buttons are used to organize the list of actions: 

The  button adds a new entry in the pane. 

The  button removes the selected entry. 

The  and  buttons move the selected row up and down in the stack. 
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The On Incorrect Tab 

This tab is used in all interactions except the Mouse hover interaction. It defines the action to be 
taken when the user gives an incorrect response. 

 

The GUI works as follows: 

1. The actions are listed in a stack. 

The attempt is classified into various groups: It can be specific (First, Second, Third, 4th, 
5th ..) or special (All, Last...) The actions for each group are listed in a stack and executed in 
the order of appearance (top-to-bottom).  

If a certain attempt belongs to multiple attempt groups, the actions are executed from group 
to group in this order: specific group→All→All but Last→Last→Others. For example, if 

maximum attempt is 3, and user gives incorrect answer in the third attempt, the actions of 
the Third attempt will be executed first, then the actions of All attempt, then the actions of 
the Last attempt. 

In this example,  

 If the user gives incorrect answer in his last attempt (recall that the number of 
attempts is defined in the Settings tab), then ActivePresenter will display Incorrect 
message (All attempt action), then continue the presentation (Last attempt action).  

 In all the attempts (including the last attempt), if the user has provided an incorrect 
answer, ActivePresenter will display the Incorrect message. 

2. These buttons are used to organize the list of actions: 
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The  button adds a new entry in the pane. 

The  button removes the selected entry. 

The  and  buttons move the selected row up and down in the stack. 

The On Incomplete Tab 

This tab is used in the Text Box, True/False, Multiple Choice, Multiple Response, Essay, Fill in 
Blank, and Fill in Multiple Blank interactions. 

 

It defines the behavior when the user has not completed his answer.  

The GUI works as follows: 

1. The actions are listed in a stack.  

They are executed in the order of appearance (top-to-bottom). 

In this example, if the user has provided an incomplete answer, ActivePresenter will display 
the Incomplete message #54. (ActivePresenter provides internal reference numbers to 
each message. This particular message is the Incomplete message for this particular 
interaction.) 

2. These buttons are used to organize the list of actions: 

The  button adds a new entry in the pane. 

The  button removes the selected entry. 
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The  and  buttons move the selected row up and down in the stack. 

 

The On Timeout Tab 

 

This tab is used in all interactions except the Mouse hover interaction. 

It defines the behavior when the user fails to respond within the time limit defined in the Settings 
tab. 

The GUI works as follows: 

1. The actions are listed in a stack.  

They are executed in the order of appearance (top-to-bottom). 

In this example, if the user has failed to respond within the time limit, ActivePresenter will 
continue with the presentation. But you may choose to display a “Sorry, you have exceeded 
the time limit!” message and then continue (or even end-) the presentation.  

2. These buttons are used to organize the list of actions: 

The  button adds a new entry in the pane. 

The  button removes the selected entry. 

The  and  buttons move the selected row up and down in the stack. 
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The On Rollover Tab 

This tab is used by the Mouse Click, Text Box, Key Stroke, and Mouse Hover interactions. It 
defines the behavior when the user rolls the mouse over the main area of the interaction. 

 

The GUI works as follows: 

1. The actions are listed in a stack.  

They are executed in the order of appearance (top-to-bottom). 

In this example, the ActivePresenter will display message#87 when the user rolls his mouse 
on the main box of the interaction. (ActivePresenter provides internal reference numbers to 
each message.) 

2. These buttons are used to organize the list of actions: 

The  button adds a new entry in the pane. 

The  button removes the selected entry. 

The  and  buttons move the selected row up and down in the stack. 

The On Rollout Tab 

This tab is used by the Mouse Click, Text Box, Key Stroke, and Mouse Hover interactions. It 
defines the behavior when the user rolls the mouse off the main area of the interaction. 
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The GUI works as follows: 

1. The actions are listed in a stack.  

They are executed in the order of appearance (top-to-bottom). 

In this example, the ActivePresenter will display message#87 when the user rolls his mouse 
off the main box of the interaction. (ActivePresenter provides internal reference numbers to 
each message.) 

2. These buttons are used to organize the list of actions: 

The  button adds a new entry in the pane. 

The  button removes the selected entry. 

The  and  buttons move the selected row up and down in the stack. 

The On Accept Tab 

This tab is used by drop target objects. It defines actions to be taken when the drop target accepts 
a drag source. 

http://atomisystems.com/tutorials/


ActivePresenter User Manual  Version 5.5 

Using ActivePresenter Windows> Using The Event Editor 198 

 
 

The GUI works the same way as other action tabs, such as the On Correct tab, the On Rollover 
tab… 

The On Reject Tab 

This tab is used by drop target objects. It defines actions to be taken when the drop target rejects a 
drag source. 
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The GUI works the same way as other action tabs, such as the On Correct tab, the On Rollover 
tab… 

Using The Image Editor 

Before we proceed, it is important to understand that the Image editor is meant to be a quick-and-
dirty raster editor. It is not designed for extensive editing of images. 

The shapes you add to the image (e.g. line, polygon, etc.) are immediately merged with the 
existing image. You can not select them later and change their properties (that is possible in a 
vector editor like InkScape).  

 If you want to be able to edit the objects later, insert shapes directly on the slide, rather 
than editing the image. 

 If you need fine control on the editing process, use a full-fledged editor like GIMP (a raster 
editor) or InkScape (a vector editor), and then insert the edited image into the slide. 

The image editor in ActivePresenter follows the layout of main editor but all tools are placed in a 
unique tab DRAWING. The image to be edited is placed in the center Canvas pane. 
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Beside the common clipboard tools (cut, copy, paste) and the Quick Access Toolbar, the image 
editor has following tools: 

 

Tool Effect 

 Lets you select a rectangle for moving, deleting or copying. 

 Crop 

 Scale image 

A window pops up: 

 

You can specify the target width and height. (If the Width/Height ratio is not same as 
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Tool Effect 

original, the image will get stretched.) 

Alternatively, tick in the Lock ration check box, and then specify only one of the 
dimensions. ActivePresenter maintains the original aspect ratio, and rescales the 
image. 

The Reset button restores the original size of the image. 

The quality of the rescaled image depends upon the algorithm used. ActivePresenter 
offers a choice of algorithms: 

 Box 

 Bilinear 

 Bicubic 

 4th order b-spline 

 Catmull-Rom spline 

 Lanczos3 

The Box algorithm is the simplest one and usually gives the lowest quality. Lanczos3 
is an advanced algorithm and is commonly used in popular image editor, it usually 
gives the best quality. 

However, choosing the most suitable algorithm also depends on the image 
content, so you can use try-and-error tactic to choose the most suitable one. 

 Insert image 

 Autoshape 

This is a drop-down list of shapes. 

 Rotate right 

 Rotate left 

 Flip horizontally  

 Flip vertically 

 Toggles antialiasing. Sometimes you need to turn it off. For example, if you want to 
draw a polygon and flood fill it, you need a shape with a clear border (not anti-
aliased border). 

 Draw a line 

 Draw a polygon.  

As you click at various spots, those points are added to the current polygon. On the 
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Tool Effect 

last point, double-click to finish the polygon-creation mode. 

 Draw a spline. 

As you click at various spots, those points are added to the current spline. A double-
click ends the spline-creation mode. 

 Pencil tool.  

Draw freehand with this tool. 

 Airbrush tool. 

Create spray with a color. 

 Eraser tool. 

Image editor in ActivePresenter supports transparency, so when you erase an area, 
it will turn transparent. 

 Flood fill tool. 

When you click anywhere in the image, it finds contiguous area with the same color, 
and then fills it with the current pen color. 

 Text 

This tool has its own word editor window. You can create rich text with its own 
attribute (color, italics, bold, underline, font size, font type, superscript, subscript, 
etc.) 

 Blur 

Blur/Obfuscate selected area. 

 
Blur radius 

The larger the radius, the more obfuscated the image. 

 Pen color. 

This selects a pen color for pending or next drawing command. 

 
Pen opacity (0=fully transparent, 255=fully opaque) 

 Pick pen color 

After selecting this tool, click on any area, and the pen tool will assume that color 
(hue and saturation) and opacity. 
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Tool Effect 

 Fill color 

Sets the color filled inside a shape.  

 
Fill opacity (0=fully transparent, 255=fully opaque) 

 Pick fill color 

After selecting this tool, click on any area, and the fill color tool will assume that color 
(hue and saturation) and opacity. 

 Line width 

Sets the line width for the outline of a shape, or for the pencil tool. 

 Line style 

Sets the type of line for the outline of a shape, or for the pencil tool. 

 Zoom 

Set the zoom level for the Canvas panes. 

 Zoom Fit 

Adjust the zoom level automatically to fit the Canvas to the available space. 

Using Image Resource Properties Window 

This window allows you to view and edit the properties of various balloons that are available in the 
Library pane. 

A window pops up when you double-click on any balloon in the Library pane. The window contains 
two tabs: General and Text Margin. 
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General Tab 

The general tab has the following controls: 

 

The controls work as follows: 

1. This section contains the Name field.  

This is just the name of the resource for easy remembering and handling.   

You can enter any name you want, and change it at any time, without affecting any 
functionality. 

2. The type of resource. 

You can tag the image resource as slide background, object background and/or cursor. 
(You can apply multiple tags to any resource.) 

Later, you can use these tags to filter (shortlist) images of certain type(s). 

3. Define the group and hotspot 

If you want to use the image for annotation during capturing, you should add multiple 
versions of the image, each having its hotspot (=anchor point) in a different direction; so 
that ActivePresenter can automatically select a variant that does not cross the slide canvas. 

This is done by entering a new group name, or selecting an existing name from the drop-
down list. All images that have a common group name are considered interchangeable, and 
ActivePresenter will automatically select the image that fits inside the canvas even when 
the click-spot is close to the boundary of the slide canvas. 

4. Define the cursor hotspot. 
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This is the hotspot position (not direction) for the cursor. The x and y dimensions are from 
the origin point (x=0, y=0) of the image, which is located on the top-left corner of the 
shape, as shown below: 

The anchor point (=hotspot) is shown as (x,y) vis-a-vis the origin (0,0). 
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The Text Margin Tab 

The Text Margin tab has the following controls: 

 

1. This drop-down menu has two settings for the zoom level: Actual size (100%) and fit to 
window. 

2. The margin between the image and the nearest text is defined here. (If the image is 
surrounded by text, then the distance between the image and the text would be 
automatically maintained as per these limits.) 

 

Using The Properties Pane 

The Properties pane is where you can view and change all common properties of selected objects 
or slides. Please note that you can select multiple objects or slides to change their properties at 
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once. 

A screenshot of the Properties pane for the selected shape is shown below. 

 

 

As you can see, the Properties pane consists of many sections. Each section displays several 
properties that are related to each other. You can freely expand or collapse any section by clicking 
on the section title.  

It’s quite straightforward to get familiar with the Properties pane, so this manual only describes 
some sections that are a bit complex. 

The Fill Section 

In this section, you can customize the body of the object. 

You can choose from the following options: 

Option Remarks 

No fill The object's body becomes transparent (no solid color or gradient of colors). 
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Solid fill 

 

Fills the shape with a single color. 

1. Click on the drop-down arrow. A color swatch appears. Select a color. 

2. Move the slider to set the opacity, or enter the value directly in the input box 
at right (255=fully opaque) 

Gradient fill Fills the shape with a gradient of colors. 

We will see how to create the following gradient: 
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The actual controls adjusted to create this particular gradient are shown below: 

 

The Gradient strip (3) is at the heart of the controls. It shows a “live” sample of the 
gradient, and lets you make changes to it in a visual manner. 

Choose between Linear and Radial gradients using the Gradient type drop-down 
list (1). 

 In Linear, the shades vary in a straight direction. 

 In Radial, the shades are in concentric circles 

Our example calls for Linear type gradient. 

Choose the Inclination angle of the gradient using the input box/spinners (2). (The 
angle is relevant for linear gradient only.) In our example, we have chosen a 45-
degree angle. 

The triangular “stops” at the bottom of the strip show how many colors are used to 
compose the gradient. This example shows four stops, which means it uses four 
colors. However, observe that the two stops in the middle use the same (white) 
color! (That is to ensure that the white band in the middle is of sufficient width.)  

Click anywhere in the strip (3) to add a new stop at that spot.  

You can click on any stop to make it active. An active stop has a red border. The 
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controls 5, 6 and 7 are meant to edit the properties of this active stop.  

In our example, the right-most stop is active (shown with red border). The triangle 
shows its color (green). The Position control (5) shows 86%, meaning this stop is at 
86% of the total length. You can drag the stop with mouse. The Position box (5) will 
reflect the new position of the stop. 

The Color (6) shows the current color of the stop. To change the stop's color, click 
on the drop-down arrow, and from the swatch that appears, select another color. 

The opacity of the stop can be changed with the controls 7a (slider) and 7b (input 
box). 

To delete any stop, first select it and then click on the  button. 

Image fill 

 

This option fills the shape with an image. 

The controls are as follows: 

First, select how the shape is to be filled (1): 

 Tile means the image will be replicated in x- and y-axis to fill up the space. If 
the image is larger than the shape, it is clipped. 

 Stretch means the image will be stretched in height and/or width to fill up the 
available space. If the image is larger than the shape, it is rescaled to fit the 
available space. 

Next, select an image from either library or from your file collection (2). 

You can change the opacity of this image with the Opacity slider (3), or enter the 
value in the input box (255=fully opaque). 

You can colorize the image (superimpose a color) by using the hue slider (4) or 
enter the value in the input box. 

Inherit From 
Base Style 

The style is copied from the template style supplied with ActivePresenter. 

ActivePresenter comes with multiple base styles. You can switch to any of them.  
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To change the base style, click on the Change Base style... button. The following 
window pops up: 

 

Select any style and press OK. 

Using your 
own style 

In the Select Base style window (see above), you can opt to create your own style: 

Just click on the  button. 

A new Properties window appears. Now set all properties and save under a new 
style name. From this moment, this new style will be available. 

Be careful about where you are adding this style: Style added in Project will not be 
available to other projects. If you add the style in Library, it will be available to other 
projects. 

The Line Section 

In this section, you can customize the outline of the shape. 

You can select from the following options: 

Option Remarks 
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No line There is no line at all. 

Solid line 

 

This option lets you customize the line. 

You can set the following: 

 Line width (1) (in pixels). 

 Cap type: Round/square (2). 

(Note: This property matters only in an open curve, where you can see the end 
of a line. At present, ActivePresenter has only closed shapes). 

 Join type: Round/Bevel/Miter (3). 

This property changes the look-and-feel of joints. See how a call out looks different 
with these joints: 
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 Dash pattern: Solid/dot/dash/dot-dash (4). 

 Arrow type and size (5). These properties are only available for Line and Arrow 
shape. 

 Color of the line (6). 

 Opacity (7) (move slider or enter the number) 
(255=fully opaque). 

Inherit 
from the 
base 
style 

See the discussion in the Fill section. 

The Text Section 

This section customizes the text placed in the object. 

You have the following options: 

Option Remarks 

Custom style This section provides multiple formatting options for the text. 

Inherit from 
base style 

See the discussion in the Fill section. 

The Shadow Section 

This section customizes the shadow of the object. 

You have the following options: 

Option Remarks 

No shadow The shape has no shadow 
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Custom 
shadow 

The following options are available: 

 Blur radius: The larger the radius, the more the diffused the shadow. 

 Angle: Angle is measured clockwise, with +ve x-axis as reference. 

 Distance: Distance from the main shape. Longer distance creates the 
illusion that the shape is located higher from the slide. 

 Color: You can select any color, but a dark color is best 

 Opacity: move slider or enter the number 
(255=fully opaque) 

Inherit from 
base style 

See the discussion in the Fill section. 

The Audio Section 

ActivePresenter allows you to associate a sound with almost all types of objects.  

 For Mouse Click object, the attached sound is played when user clicks on the object.  

 For other types of objects, the attached sound is played when the object starts showing. 

The Audio section looks like this: 

 

The controls work as follows: 

1. This is the general section. 

The Name box shows the name of the audio resource. 
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The  and  buttons add the audio resource from Library or disk, respectively. 

The  button removes the loaded resource. 

The playback controls play this audio. 

2. The Recording section offers a third alternative source for the audio. 

Here, you can record your own audio track. 

Select the Input device using the drop-down lists. (The list changes based on your 
hardware). 

Now press the Record button  to capture the sound. Adjust the Volume control button  

and adjust the recording volume. When done, press the Stop button . 

 Optionally, you can calibrate the sound level before starting the recording, to make 
sure that the sound level is strong enough, but there is no distortion. 

To calibrate the sound level, click the Calibrate Input... button. The actual 
calibration is described here. 

Now proceed with the recording as explained earlier. 

3. This section provides the fourth alternative source of sound: A text to speech sound of the 
text that is entered in the box. 

By default, ActivePresenter copies the text that is entered in the shape into this box. 
However, you can edit the text or enter your own text. 

 To adjust the TTS settings, click on the Settings button. 

The following window pops up: 

 

Select the TTS voice (all the installed voices are displayed in the drop-down list).  
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Adjust the speed and volume, and check out the overall effect by clicking on the 
Speak button. Repeat the cycle till you are happy, and then press the OK button to 
exit. 

 To generate the TTS audio, click the Generate button. 

4. This section provides options to control how the audio is played. These options are 
available only for audio object, not for the audio attached to other types of objects. 

Using The Resources Pane 

The Resources Pane provides you with the images, audio clips, video clips and object styles that 
are available in the Library and also in the current project. 

There are two benefits of using resources from the Library: 

1. ActivePresenter does not need a local copy of the resource: It simply links the object. As 
you use the resource in more and more projects, the total saving in storage area become 
significant. 

2. If you use a resource directly from disk, ActivePresenter stores a local copy of it. If you use 
the same resource at multiple places within a project, ActivePresenter will not maintain a 
common copy of the object (it has no way to compare the incoming objects). As a result, 
the same object will be stored multiple times. On the other hand, if the object is used from 
the Library, all this storage area is freed. 

The Resource pane has three tabs: 

1. Images:  Provides Images from Library and current project. 

2. Audio & Video:  Provides audio clips and video clips from Library and current project. 

3. Styles:  Provides default styles provided in ActivePresenter, and your own 
customized styles from the current project. 

Let us see these tabs in more details. 
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The Images Tab 

 

This tab has three sections (as marked above):  

1. This is the Toolbar to manage image resources. The buttons work as follows: 

Button Function 

 Selects to view resources either as thumbnails or as items. 

 Adds an image from the computer (or LAN, etc.)  

 Selects the resources that are unused in the current project. 

 Removes the resource from the Library/Project storage area. 

 Saves the image as a file. 

 Launches the Image Editor and loads the image in it. 

 This button triggers the Image Resource Properties dialog. 
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 Show/hide (toggle) the Slide background type of images (visual filter) 

 Show/hide (toggle) the Object background type of images (visual filter) 

 Show/hide (toggle) the Cursor type of images (visual filter) 

 Show/hide (toggle) the deprecated images (balloons) in the Library (visual filter) 

2. This section shows the resources (images). The currently selected image has a dark blue 
border around it. 

You can drag any image from here into the slide. 

3. You can choose between Library resources or Project resources.  
Keep in mind that initially a new project does not have any internal resources (till you add 
them). 

The Audio & Video Tab 

 

 

This tab has three sections (as marked above): 

1. This is the Toolbar to manage the audio and video resources. The buttons work as follows: 

Button Function 

 Selects to view resources either as thumbnails or as items.  
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 Adds an audio/video clip from the computer (or LAN, etc.)  

 Selects the resources that are unused in the current project. 

 Removes the resource from the Library/Project storage area. 

 Exports (saves) the media as a file. 

 This button triggers the Audio/Video Resource Properties dialog. 

 Show/hide (toggle) the Audio type of media (visual filter) 

 Show/hide (toggle) the Video type of media (visual filter) 

2. This section shows the resources (audio and video clips). The currently selected resource 
has a dark blue border around it. 

You can drag any resource from here into the slide. 

3. You can choose between Library resources or Project resources.  
Keep in mind that initially a new project does not have any internal resources (till you add 
them). 
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The Style Tab 

 

This tab has three sections (as marked above): 

1. This is the Toolbar to manage the styles. The buttons work as follows: 

Button Function 

 Launches the Style Editor to compose a new base style. 

 Selects the styles that are unused in the current project. 

 Removes the selected style from the Library/Project storage area. 

 Launches the Style Editor to edit the selected style. 

2. This section shows the styles. The currently selected style has a dark blue border around it. 

You can drag any style from here into the slide. ActivePresenter creates a call out shape 
with the selected style. 

For example, in the following screenshot, we have dragged the preset style used for Hint-
type messages into the slide. This action has created a call out with the Hint style.  
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Now you can right-click on this call out and change it into any other shape. The new shape 
will retain the style. 

3. You can choose between Library styles or Project styles.  
Keep in mind that initially a new project does not have any internal styles (till you add 
them). 

 

Using The Selection Pane 

The Selection pane shows all objects in a given slide by theirs stacking orders (z-orders). The 
Selection pane is hidden by default. To show the Selection pane, click the VIEW > Selection tool 
on the toolbar.  
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You can do the following tasks with the Selection pane: 

1. Select slide objects: If a slide has many overlapping objects, it can be very tricky to select 
them by using Canvas. With the Selection pane, simply click a line in the pane to select 
the corresponding object on the slide. You can hold the Ctrl key when clicking mouse to 
select multiple objects or hold the Shift key to select a range. You can also right-click on 
selected objects and select one from following operations: Cut, Copy, Delete, Bring 
Forward, Bring to Front, Send Backward, Send to Back. 

2. Rename objects in the Selection pane: Double-click on the name part of an object in the 
Selection pane and type a new name. In general, you probably won’t need to bother 
renaming slide objects. But giving them unique names can be helpful when you are 
adjusting theirs timing values in Timeline or writing custom script which refers to object by 
name.  

3. Turn visibility state on or off: The Visibility button  controls whether to display the object 
in the Canvas pane. 

Click on it to toggle its state (a closed eye  means the object becomes invisible.) 

The best use of this control is to turn an element off to edit the overlapped object easier. 
Note that this control is applicable only during editing; not during playback. 

It also does not affect the output when exporting: The objects which are hidden by this 
button will still display normally in the exported materials. 

The  button in the first line is the Master Visibility Button: It toggles the visibility of all 
objects at once. 

4. Turn lock state on or off: The Lock button  controls whether you can edit the object. 

Click on this control to toggle its state.  

A closed lock  means that the element is “locked”: You cannot edit this object. In fact, you 
cannot select its shape by using any panes. 
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The  button in the first line is the Master Lock Button: It toggles the lock status of all 
objects at once. 

5. The Expand/Collapse button  only available for object which contains the sub-objects 
controls whether to display the sub-objects of this object.  

 

Using The Timeline Pane 

The Timeline pane shows how the objects in a given slide are displayed against time without 
depending on user’s interactions and other events. The sub-objects and objects which are shown 
by event are not displayed in Timeline. 

In addition, the following editing tasks are possible in the Timeline pane: 

1. Edit the timings (start-point and/or end-point) of the objects.  

2. Split any audio/video objects at the desired instant. 

3. Join selected audio/video objects 

4. Split the slide into two at the desired instant. 

5. Play the slide and record your commentary in real time.  
(You can also use this feature to dub your presentation in different languages) 

6. Adjust the relative volume of audio/video objects in the selected range of time. 

7. Freeze (pause) a video object for desired time while the other objects are played out 
normally. 

8. Change the playback speed of media (keeping audio pitch is not supported yet). 

9. Preview the slide. 

Important note: 

From ActivePresenter 5.5, the Selection pane is introduced that allows viewing all objects 
including sub-objects and objects which are shown by event in a slide, so the View All Objects 
tool in Timeline is removed. 

A screenshot of the Timeline pane is shown below. 
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The various parts work as follows: 

1. The Toolbar contains controls to play and edit the objects in the slide. We will see its 
functions later. 

2. The Time Ruler shows the time axis in mm:ss format.  
(For duration longer than 1 hour, the display changes to hh:mm:ss format.) 

The time axis starts with 0. This is the instant when the slide starts playing. 

3. This is the Start marker. 

4. This is the End marker. 

The slice of Timeline between the start marker (3) and the end marker (4) is known as 
“selected range” (often called just “range”). It is shown darkened in the Timeline pane. 

A range has two main purposes: 

 You can check out a range by playing the contents repeatedly and making small 
adjustments till things become perfect.  

 Range-Editing functions like cut range, copy range, delete range, and crop to 
range work only when a range is defined first. 

5. This is the playhead (the position at which ActivePresenter will play the slide). Notice that 
a vertical line runs across the pane. 

By default, the Timeline pane does not display the start marker (3), the end marker (4) or 
the playhead (5). To create them, click anywhere on the Ruler (2). ActivePresenter creates 
all three at the same spot on the Ruler. 

Now drag the markers to any desired position to set the range. 

You can click on the playhead and drag it horizontally to play the slide at different moments. 
This is called “scrubbing the Timeline”. It gives you an instant rough idea about how the 
slide will play at normal speed.  
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6. This area displays the names of objects or the text “Objects” in the case of a line of 
objects. You can display the name of objects in its Time Bars by right-clicking Timeline 
then select Show Object Names. 

7. This is the Time bar of an object. (Think of this as a lifeline for the object: The object is 
active only for the duration of this bar.) We will see how to use the Time Bars later. 

8. This is the Time bar for the entire slide.  

By default, is end is automatically synchronized with the last element in the slide. (In our 
example, Question5 is the last element. If you extend its bar, the slide's bar also extends 
automatically.) 

However, you can stretch this bar. During the stretched portion of the Time bar, the canvas 
will display only the slide background color, and/or the slide background image (if any). 

9. This is the end-time for the slide. 

The slide will end at this instant, and the next slide (if any) will start its entry transition. 

10. The Visibility button controls whether to display the element in the Canvas pane. Its 
function is similar to the Visibility button in the Selection pane. 

11. The Lock button controls whether you can edit the element. Its function is similar to the 
Lock button in the Selection pane. 

The Toolbar In Timeline 

The toolbar provides most of the functions in the Timeline. 

Button Name Shortcut Function 

 Single Slide / 
All Slides 

 Toggles between Current slide and All slides 
view. 

The All slides display mode shows all slides on 
the Timeline. This mode is useful to see the 
objects that span across multiple slides. 

 Snapping  If this is selected, the dragged object snaps to the 
features of other objects and also to certain parts 
of the Timeline pane. See Snapping in Timeline 
for more details. 

 Loop  If this is selected, the range will be played 
endlessly (in a loop). When the playhead reaches 
the end of the range, it will return to the beginning 
and continue playing. 

 Preview Space Bar Plays the slide once, starting from the current 
position of the playhead. At the end of the play, the 
playhead returns to the Start marker of the range. 

While the selection is being played, the button 

turns to Pause . When you click this button, the 
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Button Name Shortcut Function 

play pauses, and the button turns to Resume . 
The playhead stays at its current position. 

Clicking on the Resume button starts the play from 
the Playhead's current position, and the button 

turns to Pause  again. 

After this, successive clicks on the button toggles it 
between  

Pause  and Resume . 

Tip: Instead of clicking these buttons, it is far 
easier to simply press the Space Bar to 
play/pause/resume. 

If you click the drop-down arrow of this tool, a 
menu will show up with two options: 

 Preview all: Select this option to preview 
from the first slide to the last slide in the 
project which similar to viewing the video 
output. 

 Preview from current slide: This option is 
similar to Preview all, except the preview 
will start from the current slide. 

 Stop  If you click this button while the Timeline is playing, 
ActivePresenter stops playing, and the playhead 
stays at its current position. 

 If you click this button when the Timeline is 
not playing, then ActivePresenter removes 
the selection markers (3 and 4). In other 
words, use this button to clear the selection 
range. 

 Record 
Narration 

 Records your voice even as you play the slide 
simultaneously. 

This allows you to watch the slide's playback, and 
time your voice perfectly with the action on the 
screen. 

To stop recording, press the Stop  button. 

This also allows you to dub your slide in another 
language. 

Tip: To synchronize your voice-over perfectly, 

press the  button to select the loop mode. 
Play the range repeatedly for a few times and 
practice speaking in perfect sync. Once your 
timing is right, start recording.  
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Button Name Shortcut Function 

 Zoom Out 
Timeline 

 Click this button to reduce the time scale of 
Timeline 

 Zoom In 
Timeline 

 Click this button to expand the time scale and see 
more details.  

 Zoom Fit 
Timeline 

 Click this button to automatically adjust the zoom 
factor to fit the entire slide's duration in the 
available pane width. 

 
Cut Range CTRL+SHIFT+X 

Cuts the range, and places it in the clipboard. 

 The slide duration is shrunk by the duration 
of the range. 

 If the Time Bar of any object extends on 
both sides of the range, the remainder parts 
on both sides of the range are joined 
(spliced together). 

This command is activated only when a range is 
defined. The range-edit commands are explained 
in more details here. 

 
Copy Range CTRL+SHIFT+C 

Copies the range into clipboard.  
The original contents of the slide are not affected. 

This command is activated only when a range is 
defined. The range-edit commands are explained 
in more details here. 

 
Delete 
Range 

CTRL+Del 
Deletes the range.  
Nothing is placed in clipboard (compare with the 
Cut command). 

This command is activated only when a range is 
defined. The range-edit commands are explained 
in more details here. 

 Crop to 
Range 

SHIFT+Del Everything in the slide is deleted except the 
content that falls within the range. 

After this command is executed, the duration of the 
slide is reduced to the range. 

This command is activated only when a range is 
defined. The range-edit commands are explained 
in more details here. 

 Insert Time  This command is primary used for inserting a 
Freeze-frame control in the selected audio/video 
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Button Name Shortcut Function 

track at the position of Playhead. 

To keep annotations in sync with the audio/video, 
you should make sure that they are selected when 
using this command.  

You can select nothing to expand the slide at the 
position of playhead by specified duration. 

Important note: 

In the older versions of ActivePresenter, you can 
insert Freeze-frames into an audio/video by using 
the Insert Silence/Freeze-Frame tool in Timeline. 
From version 5.5, this tool is superseded by the 
Insert Time tool 

 Split 
Audio/Video 
Objects 

 Splits the selected audio/video object at the 
Playhead position. 

 The Timeline shows the latter part as a new 
object, which is added to the top of the 
object pile. 

 The split parts are treated as new Project-
level resources (which appear in the 
Resources pane), and can be further used 
in other slides within the project. 

 In case audio object, each split part is 

shown with a separate  icon in the 
Canvas pane. However, all these icons are 
stacked together, so you cannot tell them 
apart. Only when you drag them apart can 
you see them individually.  

 Join 
Audio/Video 
Objects 

 Joins the selected audio objects (or video objects).  

This command is explained later. 

 Change 
Playback 
Speed 

 Speed up or slow down the selected range of 
selected audio/video track, as explained here. 

 Adjust 
Volume 

 Adjusts the relative volume of the selected range of 
selected audio/video track, as explained here. 

 Insert 
Caption 

 Insert a Closed Caption (CC) object or insert a 
CC line into an existing CC object. 
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Button Name Shortcut Function 

 Split Slide  Splits the slide at the Playhead position.  

The slide is sliced vertically at the playhead 
position, and a new slide is created from the 
second part. This newly created slide is inserted 
immediately after the current slide. 

 Any content in the slide that is in the right 
side of the playhead position is transferred 
to the second (new) slide.  

 If the playhead position lies in the middle of 
a time bar of an object, that time bar is split 
at the playhead position, and the latter part 
is transferred to the second (new) slide. 

The Time Bar 

The time bar of an object represents its existence along the time axis. 

 

For example, the screenshot above shows that Shape 1 will appear on the canvas at 4th second 
after the current slide starts playing. It will be displayed till the 10th second (which happens to be till 
the end of the slide). On the other hand, the closed captions (the first object in the list) appears 
for just four seconds and vanishes. 

The length of a Time Bar represents the duration of the corresponding object. 

There are some exceptions: 

 The background image has no Time Bar because it remains unchanged – You cannot 
vary its properties over time. 

 The objects which are show by event. Although they have duration but they have no 
specified start time, so they are not represented in Timeline. 

 The sub-objects of composite objects have no Time Bar. They use the timing values from 
top level parent. 

 

 

  

Changing The Timing/Duration Of An Object 

You can change the timing and duration of any element: 
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 Moving just one end of a Time Bar changes the duration of that object.  

◦ To change the start moment, move the left-side edge of the bar horizontally by clicking 

on it and dragging the mouse.  

◦ To change the end moment, move the right-side edge of the bar horizontally by clicking 

on it and dragging the mouse.  

 You cannot change the duration of audio/video clips, because their duration depends on 
the content. 

 To shift an element on the time scale without changing its duration, click anywhere in the 

middle of its Time Bar and drag horizontally.  The entire Time Bar moves 
along the time axis. Drop it wherever required. 

 You can also shift multiple elements simultaneously in such a way that their relative timing 
remains undisturbed. To do this, first select multiple elements, and then drag the entire 
group horizontally. 

To make a group of objects, press CTRL and then go on clicking on the objects' names (6) 
or Time Bars (7).  

To select contiguous objects, first click on the first object, and then SHIFT+Click on the last 
object to be selected. All the objects between these two objects will be selected.  

To deselect any object from the group, press CTRL and click on that object. 

 While you drag a border, ActivePresenter provides precise timing information (in 
milliseconds). 

◦ For the start edge, it shows the start time. 

◦ For the end edge, it shows the end time (on the Ruler) and the duration of the time bar 
(next to the bar), as shown below.  

 

You can use either value to drag the edge. 

Using The Markers On Time Bar 

The Time Bars of all objects contain some markers and annotation, which are useful for specific 
purposes: 

 
Transition effects 

You can use the Properties pane to add transition effects to an object's 
entrance/exit. These effects are visually shown with diamonds in Time Bars 
of the object. 

 The green diamond shows the Entrance transition effect. The effect 
starts at the starting-point of the object (i.e., the left edge of the Time 
Bar), and ends at the diamond. 

 The red diamond shows the Exit transition effect. The effect starts at 
the diamond and ends at the end-point of the object (i.e., the right 
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edge of the Time Bar). 

The light blue shaded ramps at both ends signify that the object is 
undergoing the transition effect during this time. (The “pure” object can be 
seen only between the two diamonds). 

You can drag both diamonds in the Timeline to adjust the durations of the 
transitions. 

ActivePresenter shows precise timing information and other information 
about the marker, as shown below: 

 

In this example- 

1. Is the position (mm:ss, with a resolution of 1 millisecond) of the 
green diamond (end of the entrance effect) 

2. Is the gap between the start edge and the green diamond 
(mm:ss, with a resolution of 1 millisecond) 
This means the entrance effect will last for 500 ms (½ second) 

3. Is the tooltip that shows the overview of the shape it belongs to. 
You can easily see that this is Shape 1, which starts at 4s from the 
start of the slide. It has a duration of 2.920 seconds. It has entrance 
and exit effects, and both are set to “fade” (fade in, fade out). 

You can also change the durations in the Properties pane. 

To remove the effect, click on the diamond and drag it downward out of the 
Time Bar. Keep dragging till the diamond turns gray, and then release the 
LMB. The effect will be removed. 

 Audio 

ActivePresenter displays the audio waveform on the time bars of all 
audio/video objects, to alert you that the object has an audio attached to it, 
and therefore you should be careful in placing another audio during the 
same period. 

 If multiple audios are inserted during the same time, you have to 
make sure that they do not interfere. For example, one speech and 
one background music go well together; but not two speech tracks.  

 The relative volume of these tracks is important (The volume of the 
background music must be much below the volume of the speech.)  
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In the following screenshot, the audio in stretch 1-2 is completely muted, 
while the volume is only lowered in the 3-4 stretch. 

 

As a general rule, in any given stretch of time, only one audio track should 
be dominant, and the others should be lowered/silenced. 

You can change the heights of time bars which contain audio by right-
clicking the Timeline and selecting an option in the Waveform Bar Height 
menu as shown in below screenshot: 

 

 

 
Pause 

The orange stripe shows the pause mark. When the Playhead reaches this 
marker, the presentation will pause and wait for the user input. 

A pause mark can be seen in the Time Bars of Interaction-type objects 
only. 

The placement of this mark is decided by the time you set in the Settings 
tab of the Event Editor to pause the presentation. (You cannot drag this 
mark in the Timeline to change its timing.) 

Note that the length of the Time Bar after the pause mark is only nominal, 
because you cannot predict how long the user will wait before responding. 
Therefore the longer the actual pause, the longer the Time Bar actually gets. 

 
Freeze-frame 

The Freeze-frame control is superimposed on the time bar of an audio/video 
object. 

 In case of a video object, the yellow diamond shows the onset of 
frame freeze in case of a video object, and the yellow band shows 
the duration of the pause (during which the last frozen frame will be 
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displayed).  

 In case of an audio object, the yellow diamond shows the onset of 
silence; and the yellow band shows the duration of the silence. 

For details, Refer to the Objects appendix. 

Putting Multiple Objects In A Line In Timeline 

You can organize multiple objects which are displayed sequentially in a line in Timeline. This is 
especially useful when you annotating a long video with dozens of shapes. 

 

Note that all objects in a line have successive z-orders, the object on the left has smaller z-order 
compare with the one on the right. You cannot swap the z-orders between two objects in a line 
without changing their start times. 

To move an object to an existing line, you just need to select the object, drag and drop it to the 
appropriate time in the line. 

To move an object from an existing line to a new line, you can right-click the object in Timeline 
then select the item Move Up into a New Line or Move Down into a New Line from menu. 

If there is any editing operation which make the duration of object greater than available time in its 
line, the object will be moved to a new line. 

Inserting Object Using Playhead 

Note that the following description doesn’t apply for Cursor Path, Closed Caption, and Zoom-n-
Pan. 

When you insert an object without Playhead is present on Timeline, the start time of object is set 
to 0 and the object is placed above existing objects in the slide. But when the Playhead is present, 
the scenario is different: 

 The start time of object is set to the value at the position of Playhead. 

 If the inserting object is an interaction, it will be placed above existing objects in the slide 
(highest z-order). 

 If the inserting object is not an interaction, it will be placed at the lowest existing line which 
doesn’t contains any object that is overlapped in time with it. The rule is similar to the Tetris 
game as shown in below image:  
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Snapping In Timeline  

Often you need to align different objects precisely. ActivePresenter facilitates this by providing a 

snap mode. Click on the  button or the VIEW > Timeline snapping tool to toggle the snap mode 
on/off. 

When the snap mode is on, you can temporarily disable the snapping by pressing CTRL as you 
drag the element. 

When the snap mode is on, as soon as a moving “snappable” element comes in the vicinity of 
another “snappable” element, it will make a tiny jump to match the time stamp of the other element.  

 Note that this “other” element may be anywhere in the Timeline pane: Right from the Ruler 
to the lowest object's time bar. (The vertical separation between the elements does not 
matter at all.) 

 Also note that we may not be dragging the “snappable” element itself. For example, when 
we drag a time bar of an object, all the “snappable” elements in the bar are moving 
simultaneously. Any of these elements can snap to another snappable element. 

The snap mode applies to the following elements: 

 In Ruler area: Playhead, start marker of the range, end marker of the range 

 In the Time Bars of objects: Starting edge, ending edge, all markers inside the bar 

 Others: beginning of slide, slide's duration as entered in the Properties pane, actual end of 
slide.  

When a snapping takes place, ActivePresenter shows an orange vertical line at that point of time, 
to draw your attention. Now it is up to you whether to drop the dragged element there or keep 
dragging. 

This helps us to synchronize the dragged element precisely with some other element in the 
Timeline. 

The following experiment shows what happens when I drag the object's time bar from right to left.. 

Figure 1 highlights all elements that are snappable (The red marker in the slide's time bar marks 
the original duration of the slide, and it is a snappable element too. However, the slide's actual 
duration appears to extend beyond this red marker, because as soon as I dragged the object's 
time bar to the right for this experiment, ActivePresenter automatically extended the slide's 
duration to accommodate this object.) 

In the subsequent figures, different elements snap together, as shown with an orange vertical line. 
The object's time bar gives little jumps at these points. If you release the LMB, it will lock there.  
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Using The Range-Edit Commands 

The Timeline pane has four Range-edit commands  that work only when a range is 
defined first.  

Let us understand their working with a few examples, in which we will use each command in two 
different circumstances: (a) when none of the objects are selected, and (b) when some objects are 
selected. 

Each set has three screenshots: (1) The original objects, (2) result when none of the objects are 
selected, and (3) result when some objects are selected.  
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The Cut Command 

The Cut command places the cut contents on the clipboard. You can paste that content in a new 
slide. 

The following example shows the effect of the Cut command when no objects are selected in the 
slide. 

 

The original slide 

 

No object selected: 

The slide and all objects 
are edited. The entire slice 
of the range (with the parts 
of objects enclosed in it) is 
cut away. 

Thus the slide duration is 
reduced by the duration of 
the range. 

If an object spans on both 
sides of the range, its 
remaining parts are joined. 
(e.g. Shape 1). 

Shape 4 was deleted, 
because it was completely 
inside the range. 

When some objects in the slides are selected, the command behaves differently, as shown with 
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the following example. 

 

The original slide. 

Here, we have two identical 
sets of objects (1-6; 7-12). 

Only one of the two sets is 
selected to show the 
difference. 

At least one object 
selected: 

Only the selected objects 
are edited. The slide itself 
and unselected objects (7-
12) are not affected at all. 

For the selected objects 
only: The range is folded 
up and then removed. Any 
object parts that lie in the 
range are deleted (e.g. 
Object 5 and 3. Also, 
shape 4 was deleted, 
because it was completely 
inside the range.) 

Objects/parts that follow 
the range are shifted to the 
left by the duration of the 
range (e.g. Objects 3,2,1).  

If a selected object spans 
on both sides of the range, 
its remaining parts are 
joined (e.g. Shape 1). 

 

The Delete Command 

The Delete command works just like the Cut command, except for one difference: The Cut 
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command places the cut contents on the clipboard; whereas the Delete command does not. 

The Crop Command 

The crop command simply deletes everything other than what is there in the range. 

 

The original slide. 

 

No object selected: 

Only the contents of the 
range are retained, and the 
rest is deleted. Thus the 
slide duration is reduced to 
the duration of the range. 

If any object does not have 
any part inside range, it is 
dropped. (e.g. Shapes 6, 
2). 
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When some objects in the slides are selected, the command behaves differently, as shown with 
the following example. 

 

The original slide. 

Here, we have two identical 
sets of objects (1-6; 7-12). 

Only one of the two sets is 
selected to show the 
difference. 

At least one object 
selected: 

Only the selected objects 
are edited. The slide itself 
and unselected objects (7-
12) are not affected at all. 

Those parts of the selected 
objects that lie inside the 
range are retained. 

If any selected object does 
not have any part inside 
range, it is deleted entirely 
from the slide. (e.g. Shapes 
6, 2). 

The Copy Command 

The Copy command copies those parts of objects that fall inside the range, and puts them on 
clipboard. 

 If no objects are selected, the Copy command checks all objects in the slide. 

 If any objects are selected in the slide, the Copy command checks only these selected 
objects. 
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If any object does not have any part inside the range, it is not copied. 

The following diagram illustrates these conditions. 

Note that the lower figures show fresh slides into which the clipboard contents are pasted.  

Just imagine that a slice is taken out of the original slide, and placed at Playhead position in 
another slide. 

 If no objects are selected in the source slide, ActivePresenter will slice through all objects. 

 If some objects are selected, ActivePresenter will slice through only these selected objects. 
Obviously, if any object has no content inside the slice, it won't be pasted. 

Using The Join Command 

The Join command  joins the selected objects (either audio or video).  

You can join an audio object with other audio objects; and a video object with other video objects. 
You cannot join an audio object with a video object. 

When you select audio/video for joining, here's how ActivePresenter handles the job: 

1. In the background, ActivePresenter maintains four separate lists of selected audio/video 
objects: 
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a. Selected audio objects in current slide,  

b. Selected video objects in current slide,  

c. Selected audio objects that show over multiple slides, 

d. Selected video objects that show over multiple slides.  

2. Within each list, ActivePresenter sorts the objects by their Start Time in ascending order.  

◦ If two or more objects (in each list) have the same Start Time, ActivePresenter sorts 
them by their Z-Index in ascending order (i.e. bottom-up order in Timeline).  

3. For each list that contains at least two objects, ActivePresenter joins the objects in the order 
of their sorting. 

4. The combined track is assigned to the first object in the list.  
All the other objects in the list are deleted. 

5. If any of the tracks has effects applied to it (e.g. freeze frame, silence, volume change), 
they are burned in before joining it with the other resources. 

6. If the source audio/video resource is logical (that is, created by any of the following 
operations: Cut, Crop, Delete, Paste, Join, Split, Insert Freeze-Frame/Silence, or Adjust 
Volume) and not used by any object, it will be deleted from the Resource pane. If it is a 
physical resource, or is used by any object, it still shows in the Resource Pane. 

In addition, the newly joined track also is added to the Resource Pane.  

7. The original audio/video objects may not have identical properties (e.g. height, width, 
aspect ratio, resolution, fps, bit rate). ActivePresenter solves this problem by using all 
parameters of the first resource for its output. 

Within a project, the resources are joined only virtually: The actual joining of the objects 
takes place only when the presentation is exported (rendered), at which time 
ActivePresenter converts all objects from their respective formats into the desired format 
and joins them directly. 

Using The Adjust Volume Control 

If the slide has multiple concurrent audio tracks, you will have to ensure that only one of those 
tracks is dominant at any time, and the other tracks are either muted or with lowered volumes. This 
balance keeps changing: In other parts of the slide, you may have to give dominance to other 
track(s). 

This is where the Adjust Volume control is helpful. 

When you click on the  button, the following window pops up: 

 

http://atomisystems.com/tutorials/


ActivePresenter User Manual  Version 5.5 

Using ActivePresenter Windows> Using The Timeline Pane 242 

Note that this is a relative volume scale, with a default value of 100% (=original volume). It can 
adjust the volume from 0 (= mute) to 500% (= original volume x 5). You can use the Mute check 
box to quickly silence the track. 

 The original track is not affected at all: You can revert to the original volume at any time. 

 If this control is used to mute a track, it does not affect the original duration of the track, 
because unlike the Freeze-frame control, this control does not insert an additional period of 
silence. 

In short, the trick is to first set a range, and then select each of the audio/video objects and adjust 
their volumes individually. Only the dominant track will retain its full volume (or it may even be 
boosted), while you will lower the volume for the non-dominant tracks (or even mute them 
altogether). 

These adjustments would be applied within the range only. 

Set another range in another part of the time axis and repeat this. This time a different track may 
be dominant. 

ActivePresenter displays the audio waveform proportional to its actual volume. So if you have 
applied volume control within a range, or muted the track within a range, it will be displayed as 
shown below: 

Here, a silence is inserted in the 1-2 stretch (note the straight line in place of the audio waveform).  
In the 3-4 stretch, the volume is lowered (note the signal has become weaker in that range). 

In both cases, the start and end points are marked with red vertical marker lines. Note that these 
markers cannot be moved within the time bar, because they actually denote the range in which the 
volume is altered. 

If you want to reverse the effect (i.e. make the volume normal), follow this procedure: 

1. Click on the  button to turn on the snap mode  

2. Click anywhere on the Ruler, which starts a new range. 

 

3. Now drag it to the red mark on the left  
(thanks to the snap mode, it will snap to the marker) 

 

4. Now drag the End marker of the range to the red marker on the right. 
(thanks to the snap mode, it will snap to the marker) 
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5. Click on the arrow in the  button, and select the Restore Original Volume option. 
The effect of the Adjust Volume control is removed, and the original sound is restored. 

Using The Change Playback Speed Command 

In a screencast, sometime you can see a long scene but it doesn’t convey much information such 
as: downloading a file, waiting for the completion of a process. You can use the Change Playback 

Speed  command in Timeline to make that scene runs faster. That will save the duration and 
the file size of video and provide better viewer’s experience. 

Sometimes, you can also use the Change Playback Speed  command to make your video look 
professional like the slow motion scene on TV. 

The Change Playback Speed command is only active when there is a selected audio/video object 
or a selected range of audio/video object in Timeline.  

When you click the Change Playback Speed  command, the following dialog appears. 

 

The input is a relative value in range 10%-1000%. ActivePresenter will scale the current speed of 
selected range using this value. You can use the Reset to original speed check box to quickly 
reset the original speed of selected range. 

Productivity Tips For Timeline 

Most of the editing work is accomplished in the Canvas and Timeline panes. Therefore it is 
important to learn some productivity tricks. 

First, force yourself to use and memorize the hotkeys. Although this may look difficult at the 
beginning, it will be very rewarding on long term, as you will be able to work in Timeline at much 
higher speeds. 

Here is a summary of hotkeys used in Timeline:  

Hotkey Function 

Home Moves the Playhead to the beginning of slide 
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End Moves the Playhead to the end of slide  

LeftArrow  When no objects are selected: Moves the Playhead to the 
left  

 When objects are selected: Moves the selected objects to 
the left 

CTRL+LeftArrow  Same as above, but 10 times faster. (the CTRL key is x10 
accelerator) 

RightArrow  When no objects are selected: Moves the Playhead to the 
right  

 When objects are selected: Moves the selected objects to 
the right 

 CTRL+RightArrow  Same as above, but 10 times faster. (the CTRL key is x10 
accelerator) 

[ Moves the Playhead to the starting marker of the selection range 

] Moves the Playhead to the end marker of the selection range 

SHIFT+[ Sets the start marker of the selection range at the Playhead 
position  

SHIFT+] Sets the end marker of the selection range at the Playhead position  

SHIFT+LeftArrow  When no objects are selected: Moves the start point of the 
range to the left 

 When objects are selected: Reduces the selected objects' 
duration 

CTRL+SHIFT+LeftArrow Same as above, but 10 times faster (the CTRL key is x10 
accelerator) 

SHIFT+RightArrow  When no objects are selected: Moves the end point of the 
range to the right 

 When objects are selected: Increases the selected objects' 
duration 

CTRL+SHIFT+RightArrow Same as above, but 10 times faster (the CTRL key is x10 
accelerator) 

 

The following are Customizable hotkeys (to change their settings, use the Preferences > Hotkeys 
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tab). 
The following are their default values: 

Hotkey Function 

CTRL+SHIFT+X Cuts the range (Range-edit command) 

CTRL+SHIFT+C Copies the range to clipboard (Range-edit command) 

CTRL+DEL Deletes the range (Range-edit command) 

SHIFT + DELETE Crops to range (Range-edit command) 

Also keep in mind the following tips: 

 Use CTRL+Scrolling mousewheel to zoom in/out quickly 

 Use SHIFT+Scrolling mousewheel to scroll horizontally in the Timeline. 
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Using Calibrate Audio Input dialog 

The Calibrate Audio Input dialog allows you to select appropriate level of input volume for 
recording audio: 

 

This dialog can be used in two different modes: 

Manual calibration: 

1. Keep the microphone in its normal position, and speak in your normal volume. 

2. Click on the  button, and read a sentence into your microphone.  
At the same time, move the slider to right and increase the gain till the LED bar at the right 
shows yellow bars intermittently. If the bar starts showing red LEDs, move the slider a bit to 
the left (otherwise the voice will be clipped).  

3. When you are satisfied with the gain setting, press the  button to stop the recording. 

4. Now press the  button to play your recorded voice. If the sound has any defects (e.g. 
breathing noise), take care of the problem and repeat steps 1-4. (Sometimes the problem 
may be in positioning of the microphone.) 

Automatic calibration: 

1. Press the Auto Calibrate button, and use the microphone normally. 
The Auto Calibrate button turns into Stop Calibration. You can press it to stop the 
calibration any time. 

2. Continue speaking so that ActivePresenter can automatically optimize the gain. 
After a few seconds, the button reverts to Auto Calibrate button. 
This indicates that the calibration is over. 

Regardless of the calibration method, the volume adjustment is accepted only when the OK button 
is pressed. If you press the Cancel button, the new value will be discarded and the old value will 
continue. 
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Using Output Language Editor 

The Output Language Editor window is shown when you click the Edit Output Language button 
in the Export To HTML5/Flash Simulation dialog. It allows you to modify the current translation of 
texts in the output or add the translation for non-supported languages. 

 

The editor provides following: 

1. This displays the language of opening project. You can change the Project Language in the 
Project Properties dialog. 

2. The Name column displays the texts in the current user interface language of 
ActivePresenter so you can know their original meanings. 

3. The Value column displays the texts in the language which is set in Project Language if it is 
supported. You can modify the texts in this column by double-clicking in each row. 

4. The Reset button allows you to restore the original translation of texts. 

The following screenshot shows how these texts are displayed in the HTML5 Simulation output: 
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Objects 

In this appendix, you will learn the best uses of each type of object in a presentation, and also how 
to control its properties. 

Overview Of Objects 

In ActivePresenter, the objects belong to two different categories: 

 Objects that are used for annotation 

 Objects that are used to interact with the user. 

Annotation Objects 

The annotation objects add value to the slide visually, but they do not interact with the user by 
responding to his different actions. Thus they do not change the course of the presentation in 
response to the user-inputs; such as going to a certain slide, pausing/resuming, etc. 

They are as follows: 

Object Typical uses 

Screenshot Adds a screenshot of anything on the screen. This could be a website, a TV 
grab, a still from a movie, etc.  

The screenshot can be inserted as an object in a slide, or as background of 
the slide. 

Shape Adds a shape on/around the point of interest.  

ActivePresenter offers a choice of 44 shapes (rectangle, oval, arrows, cross, 
diamond, call outs, etc.). 

Text Caption Adds text to explain/highlight something. 

Highlight Overlays a colored semitransparent area on some part of the screen to highlight 
it. 

Spotlight Overlays a dark screen on the display area, and allow only a certain area to be 
fully visible. This creates an effect like we are watching a dark screen with a 
search light. 
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Feedback Adds a widget that displays the user's activity on screen (only applicable in an 
interactive presentation).  

Cursor Path Manipulates the movement and clicks of the mouse to simulate that the user of 
the application is using his mouse in that manner. 

Zoom-n-Pan During rendering, zooms in the virtual camera on some interesting part of the 
screen to show in more detail. 

Closed 
Caption 

Closed Captions are like subtitles on a movie (text that can be read at the 
bottom of the screen). It is optional: The viewer has the control whether to 
display CC on his screen. 

Image Adds an image in the slide. 

Audio Adds an audio clip in a slide. 

Video Adds a video clip.  

Note that the video can be re-sized to cover the whole screen or projected on a 
part of the screen. 

Interaction Objects 

The interactive objects are designed to respond to user inputs. They not only change the course of 
the presentation based on user-input, but also keep a track of user activity (for example, assess his 
performance in a test). 

The interactive objects are as follows: 

Object Typical uses 

Mouse Click Responds when the user clicks in a pre-defined area. Use of modifier keys 
(ALT, CTRL, and SHIFT) is also allowed.  

Text Box Responds when the user enters specific text (string). 

Key Stroke Responds to an individual key on the keyboard or a hot key (such as 
CTRL+SHIFT+P). 

Mouse Hover Has two different types of responses: 

 When the user hovers his mouse over a certain area. 

 When the user moves his mouse away from the area. 

This interaction is different from others, it does not assess correctness of user 
response. Therefore, it does not have common interactive properties such as 
score, pause, time limit, On Correct, On Incorrect. 
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Drop Area Responds when the user drops a drag source onto it. 

Question ActivePresenter allows you to insert eight different types of questions 
(True/False, Multiple Choice, Multiple Response, Essay, Fill in Blank, Fill in 
Multiple Blank, Sequence, and Drag-n-Drop) 

The question and options appear on screen, and the viewer is expected to 
respond within a predefined time. ActivePresenter can be programmed to take 
various different actions depending on whether the response is correct or 
incorrect; or if the viewer fails to respond within the time limit. 

 

General Properties Of Objects 

In general, any object's properties can be divided into three categories: 

1. Properties that define the object physically  
(size, position, rotation, color, transparency, start/end time, etc.)  

2. Properties that deliver the core function of the object  
(each object has a unique purpose.) 

3. Properties that define response to the user-action (Interaction)  
(Some objects don't have interactive properties: They provide only annotations to the 
presentation.)  

Most of these objects are made up of multiple parts (“elements”). Each element has its own 
properties.  

You can tweak these properties to such as extent that the object may not be recognizable! 

You can visually adjust some physical properties with mouse.  

1. Most rectangular shapes have nine handles. Drag these handles to change the size, aspect 
ratio, rotation of the rectangle. 

 

2. Most shapes have one adjustment point which is rendered as a yellow diamond . Slide 
the yellow diamond to change the form of the shape.  

Different positions of the diamond results in drastic change in the shape, as shown below: 
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3. Double-click on any text to edit it. 

4. You can use the context menu to any rectangle to apply a different style (changing the 
stroke and fill colors, text, shadow, etc.). 

The behavioral properties are accessible only through the Properties pane, or the 
ACTIVEPRESENTER > Preferences… menu option, where you have to enter values and then 
check how that has changed the behavior of the object. 

In the following sections, we will take up all objects one by one and understand their properties. 

Since the physical properties are similar in all objects, we will check them out first. 

 

Property Remarks 

Name Name of the element. This is simply a unique name generated by 
ActivePresenter. 

Report ID This unique reference number is used for reporting the test result. Only 
text contains alphanumeric characters (A-Z. a-z, 0-9) and underscore (_) 
are allowed (maximum length=250 characters) 

Password Field This property is only available for Text Box. It is used to simulate the 
typing in a password field in the video or simulation outputs. 

Transform The size and position of the frame that is used to define the shape, 
measured from the top-left corner of the canvas. 

Left Left edge of the frame. 

Top Top edge of the frame. 

Width Width of the frame. 
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Height Height of the frame. 

Rotation Rotate the object by specified degree in slide coordinates. The rotation 
center is the center point of the frame that is used to define the shape. 

Keep Aspect Ratio Keep the ratio between the width and the height of frame unchanged 
when resizing the frame. 

Text margin Minimum margin between the frame and the text around it.  

Left Minimum margin on the left side. 

Top Minimum margin on the top side. 

Right Minimum margin on the right side. 

Bottom Minimum margin on the bottom side. 

AutoFit Text  When this option is selected, the frame automatically changes its size to 
fit the text. 

Timing & Animation Define when and how the object will start showing in the presentation; 
and when and how it will stop showing. 

Start Time The starting time of the object (vis-a-vis starting time of the slide) 

Duration The duration for which the object is to be displayed. 

Set it to -1 to display the object till the end of slide.  

 If the duration of the slide increases for any reason (e.g. you 
added another object; or increased the duration of other objects), 
this object's duration will be automatically increased. 

 If the duration of the slide decreases for any reason, the duration 
of this object will be decreased automatically. 

Entrance Type: Select from None, Fade in, Fly in, Peek in and Wipe. 

Duration: Set a duration of the effect (in ms)  

Direction: Select the direction for Fly in, Peek in or Wipe effect. Available 
directions are From Left, From Top, From Right, From Bottom, From 
Top-Left, From Top-Right, From Bottom-Left, From Bottom-Right. 

Exit Select from None, Fade out, Fly out, Peek out and Wipe. 

Duration: Set a duration of the effect (in ms)  

Direction: Select the direction for Fly out, Peek out or Wipe effect. 
Available directions are To Left, To Top, To Right, To Bottom, To Top-
Left, To Top-Right, To Bottom-Left, To Bottom-Right. 

Show In Mode Put a click in the four check boxes.  
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Demonstration  The object will be visible in a given mode if there is a tick in its 
check box. 

 In case of interactive object, if the object is invisible in a specific 
mode except the Demonstration mode, it is still functional. 

 

Tutorial 

Practice 

Test 

Audio/Video/Click 
Sound 

This property refers to the media associated with the object.  

 For Mouse Click object, the property is named “Click Sound”, the 
attached sound is played when user clicks on the object.  

 For Video object, the property is named “Video”. 

 For others types of objects, the property is named “Audio”, the 
attached sound is played when the object starts showing. 

Base Style If the fill, line, or text properties are not set, the object will use the 
corresponding properties in the base style. When you click the Change 
Base Style… button, a style selector window pops up.  

Fill The fill properties 

Line The outline properties 

Text The text properties 

Shadow The shadow properties 

Drag-n-Drop The drag-n-drop properties. See the Creating Drag and Drop 
Interactions section for more details. 

Accessibility Define properties that make the object accessible by viewer with 
disabilities when viewing the project output. 
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Focusable Define whether the object can receive focus when viewer navigates 
using the Mouse or the Tab key. This property is available only for 
Mouse Click and Mouse Hover object (Text Box is always focusable). 

If this property is enabled, in the HTML5 output: 

 The object gains focus automatically when it is displayed, if no 
object in the content has focus at that time. 

 When the object has focus, pressing the Enter or Space key is 
the same as clicking on the object; i.e. actions for Left click event, 
that are defined in the object’s Event Editor, will be executed. 

 When the object has focus, the object outline (yellow, dotted by 
default) will be displayed if the Enable visual focus indicator 
option is selected when exporting to HTML5. 

 Viewer can navigate between focusable objects by pressing the 
Tab key, if the Enable keyboard navigation option is selected 
when exporting to HTML5. 

Auto Label If this property is selected, accessibility text will be generated 
automatically from the text that the object displays, or the object name if 
it doesn't contain any text. 

Name Accessibility name of the object. Screen reader will read this text aloud 
when the object appears. 

Description This provide more information about the object. Screen reader will read 
this text aloud when the object appears, after reading the accessibility 
name. 

Object Styles 

By default, each type of object has a separate look-and-feel (see below). 

This is achieved by setting a different color, transparency, text, shadow, and line thickness for each 
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type of object.  

The combination of all these attributes is called Style.  

You can edit the default styles (all objects using those styles will take the new look), and create 
new styles, and apply to any of the objects. 

You can change the style of object using the fill, line, and text tools in the toolbar or using the 
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Properties pane. 

Introduction To Objects 

In this section we will see the properties that are unique to each object. 

Mouse Click 

The Mouse click is an interactive object. 

 

By default, a Mouse click object consists of three separate elements, as shown below: 

You can optionally add a Hint message and a Timeout message. 

The object works as follows: 

When the interactive presentation is played, this object displays only the Target area element (1) 
and waits for the user to click anywhere in the slide.  

You can prompt the user to click in a specific area by inserting a shape with some guidance. 

Change the Show in Mode property of the object to make it invisible in unchecked modes; by 
default, the object is invisible in Practice and Test mode. You can also change the object's style 
(Fill, Line, Text, and Shadow) to make it always invisible in all modes. 

The User action must be the same as one of events defined in the Mouse Click tab of the Event 
Editor, otherwise On Incorrect message is displayed.  

For example, if the predefined event is CTRL+Left Click, but user clicks on the Target area without 
holding down the CTRL key, he is doing it incorrectly. 
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Apart from this primary behavior, the object also has secondary behaviors. 

To set up all behaviors of the object, double-click on the Target area. This launches Event Editor 
with the object's current settings in the following tabs: Mouse click, Settings, On Correct, On 
Incorrect, On Timeout, On Rollover, and On Rollout. 

Note that you can make the Target area invisible (by setting the line to “None” in the Properties 
pane) if you don't want to reveal the correct click area to the user. However, this is not 
recommended: Use the Show In Mode property of the object. That is more flexible and useful, 
especially when you want to show the object in some modes (e.g. Demonstration and Tutorial) but 
hide the object in other modes (e.g. Practice and Test). 

For example, suppose you want to show a world map and quiz the user about where a certain city 
is. For this, place the Target area on that city, and make it invisible. Now the user can only see the 
map. If the user clicks on the correct area, the object shows him the On Correct message. If he 
clicks at a wrong location on the map, the object shows him the On incorrect message.  

Text Box 

The Text Box is an interactive object.  

The default Text Box object consists of three separate elements, as shown below: 

 

You can optionally add a Hint message and a Timeout message. 

The object works as follows: 

When the interactive presentation is played, this object displays only the Target area element (1) 
and waits for the user to enter text.  

 If the user enters text, it appears in real time in the Target area (1).  

 If the entered text exceeds the area, the text is shifted so that the insertion point is always 
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visible. You will have to resize the area manually. 

 If the Submit button is enabled, the entered text is validated when the user presses the 
Submit button, 

 If the Submit button is not set, the text is validated whenever the user presses any key. As 
long as the entered text is a partial match for the reference text, ActivePresenter will wait 
for the user to input more text. However, the moment the last entered character is found to 
be different, it will be deemed as incorrect. 

 If the entered text matches the reference text, ActivePresenter displays the On Correct type 
message (2).  

 If the entered text does not match the reference text, ActivePresenter displays the On 
Incorrect type message (3). 

Apart from this primary behavior, the object also has secondary behaviors. 

To set up all behaviors of the object, double-click on the Target area. This launches Event Editor 
with the object's current settings in the following tabs: Text, Settings, On Correct, On Incorrect, On 
Incomplete, On Timeout, On Rollover, and On Rollout. 

Key Stroke 

The Key Stroke is an interactive object. 

By default, a Key Stroke object consists of three separate elements, as shown below: 

 

You can optionally add a Hint message and a Timeout message. 

The object works as follows: 

When the interactive presentation is played, this object displays nothing initially, and waits for the 
user to enter a hot key (such as CTRL+SHIFT+P). It ignores text strings entered by the user. 
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(You can change the Show in Mode property to choose in which modes the Target Area (1) 
should be displayed.) 

 If the entered hot key matches the reference, ActivePresenter displays the On Correct type 
message (2).  

 If the entered text does not match the reference, ActivePresenter displays the On Incorrect 
type message (3). 

Apart from this primary behavior, the object also has secondary behaviors. 

To set up all behaviors of the object, double-click on the Target area. This launches Event Editor 
with the object's current settings in the following tabs: Keystroke, Settings, On Correct, On 
Incorrect, On Timeout, On Rollover, and On Rollout. 

Mouse Hover 

The Mouse Hover is an interactive object. 

It consists of two separate elements, as shown below: 

 

In a rendered interactive presentation, the object functions as follows:

 

When the mouse rolls over the Target area (1), the object displays the Hint message (2). 

Apart from this primary behavior, the object can execute any number of additional tasks as defined 
in its interaction tabs. (It responds to two events: mouse rollover and rollout.) 

Apart from this primary behavior, the object also has secondary behaviors. 

To set up all behaviors of the object, double-click on the Target area. This launches Event Editor 
with the object's current settings in the following tabs: On Rollover and On Rollout. 

Drop Area 

You should read Creating Drag and Drop Interactions to have basic concepts about drag and 
drop before reading this section. 

You can insert Drop Area from the HOME > Interaction menu or the INTERACTION tab, or 
convert it from a drop target. If it is inserted from the menu, a correct drag source and feedback 
messages are also inserted automatically. You can remove them if not needed or change their 
shapes and styles as. 
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To edit event – actions of a Drop Area object, refer to the section for the Accepted Drag Sources 
tab in the Event Editor window. 

Question – True/False 

The True/False type Question is an interactive object. 

By default, this object consists of seven separate elements, as shown below: 

 

However, you have the option to add a Hint message, and three buttons: Clear, Skip and Back, 
which function as follows: 

Clear Clear all user input on the question, e.g. make text fields empty, uncheck radio 
button/check box. 
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Skip Go to the next slide. 

Back Go to the previous slide. 

Submit Get user input, evaluate, and execute suitable actions. 

User can change these default behaviors by editing On Click actions of these buttons from the 
Event Editor window. (Select the question, then double click the button to launch the Event Editor.) 

In the rendered presentation, the object functions as follows: 

Only the question (2), the True/false radio button options (3) and the Submit button (7) are 
displayed.  

When the user responds, the presentation compares the answer with the reference answer (which 
is previously defined by the author). 

 If the answer is correct, the actions defined in On correct tab are taken.  (which typically is 
to display the On correct response (4)) 

 If the answer is incorrect, the actions defined in On incorrect tab are taken. (which typically 
is to display the On incorrect response (5)) 

 If the user tries to leave the answer incomplete, the actions defined in the On incomplete 
tab are executed. (which typically is to display the On incomplete response (6)) 

Apart from this primary behavior, the object also has secondary behaviors. 

To set up all behaviors of the main object, double-click on the frame (1). This launches Event 
Editor with the object's current settings in the following tabs: Settings, On Correct, On Incorrect, 
On Incomplete and On Timeout. 

You have to set up the behavior of each button separately. Double-click on the button to launch 
Event Editor with the button's current settings in the following tabs: On Click, On Rollover, and On 
Rollout. 

Question – Multiple Choice 

The Multiple choice type Question is an interactive object. 
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The default Multiple choice object consists of seven separate elements, as shown below: 

 

However, you have the option to add/remove answers, add a Hint message, and three buttons: 
Clear, Skip and Back, which function as follows: 

Clear Clear all user input on the question, e.g. make text fields empty, uncheck radio 
button/check box. 

Skip Go to the next slide. 

Back Go to the previous slide. 

Submit Get user input, evaluate, and execute suitable actions. 

User can change these default behaviors by editing On Click actions of these buttons from the 
Event Editor window. (Select the question, then double click the button to launch the Event Editor.) 

In the rendered presentation, the object functions as follows: 

Only the question (2), the answer options (3) and the Submit button (7) are displayed. The user is 
expected to select any one answer. 

When the user responds, the presentation compares the answer with the reference answer (which 
is previously defined by the author).  

 If the answer is correct, the actions defined in On correct tab are taken.  (which typically is 
to display the On correct response (4)) 

 If the answer is incorrect, the actions defined in On incorrect tab are taken. (which typically 
is to display the On incorrect response (5)) 
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 If the user tries to leave the answer incomplete, the actions defined in the On incomplete 
tab are executed. (which typically is to display the On incomplete response (6)) 

Apart from this primary behavior, the object also has secondary behaviors. 

To set up all behaviors of the object, double-click on the Target area. This launches Event Editor 
with the object's current settings in the following tabs: Choice, Settings, On Correct, On Incorrect, 
On Incomplete, and On Timeout. 

You have to set up the behavior of each button separately. Double-click on the button to launch 
Event Editor with the button's current settings in the following tabs: On Click, On Rollover, and On 
Rollout. 

 

Question – Multiple Response 

The Multiple response type Question is an interactive object. 

The default Multiple response object consists of seven separate elements, as shown below: 

 

However, you have the option to add/remove answers, add a Hint message, and three buttons: 
Clear, Skip and Back, which function as follows: 

Clear Clear all user input on the question, e.g. make text fields empty, uncheck radio 
button/check box. 

Skip Go to the next slide. 
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Back Go to the previous slide. 

Submit Get user input, evaluate, and execute suitable actions. 

User can change these default behaviors by editing On Click actions of these buttons from the 
Event Editor window. (Select the question, then double click the button to launch the Event Editor.) 

In the rendered presentation, the object functions as follows: 

Only the question (2), the answer options (3) and the Submit button (7) are displayed. The user is 
expected to click one or more check boxes. 

When the user responds, the presentation compares the answer with the reference answer (which 
is previously defined by the author).  

 If the answer is correct, the actions defined in On correct tab are taken.  (which typically is 
to display the On correct response (4)) 

 If the answer is incorrect, the actions defined in On incorrect tab are taken. (which typically 
is to display the On incorrect response (5)) 

 If the user tries to leave the answer incomplete, the actions defined in the On incomplete 
tab are executed. (which typically is to display the On incomplete response (6)) 

Apart from this primary behavior, the object also has secondary behaviors. 

To set up all behaviors of the object, double-click on the Target area. This launches Event Editor 
with the object's current settings in the following tabs: Choice, Settings, On Correct, On Incorrect, 
On Incomplete, and On Timeout. 

You have to set up the behavior of each button separately. Double-click on the button to launch 
Event Editor with the button's current settings in the following tabs: On Click, On Rollover, and On 
Rollout. 

Question – Essay 

The Essay type Question is an interactive object.  

This object should only be used for taking a survey from users, not for assessment. (We cannot 
expect that a descriptive answer will match the stored model answer exactly.) 

Currently, ActivePresenter doesn't support survey question explicitly, but you can create a survey 
question by leaving blank the Value, On Correct and On Incorrect tabs. 

By default, it consists of seven separate elements, as shown below: 
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However, you have the option to add a Hint message, and three buttons: Clear, Skip and Back, 
which function as follows: 

Clear Clear all user input on the question, e.g. make text fields empty, uncheck radio 
button/check box. 

Skip Go to the next slide. 

Back Go to the previous slide. 

Submit Get user input, evaluate, and execute suitable actions. 

User can change these default behaviors by editing On Click actions of these buttons from the 
Event Editor window. (Select the question, then double click the button to launch the Event Editor.) 

In the rendered presentation, the object functions as follows: 

Only the question (2), the answer options (3) and the Submit button (7) are displayed. The user is 
expected to enter a descriptive text in response. 

When the user responds, the presentation compares the answer with the reference answer (which 
is previously defined by the author).  

Apart from this primary behavior, the object also has secondary behaviors. 

To set up all behaviors of the object, double-click on the Target area. This launches Event Editor 
with the object's current settings in the following tabs: Value, Settings, On Correct, On Incorrect, 
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On Incomplete, and On Timeout. 

You have to set up the behavior of each button separately. Double-click on the button to launch 
Event Editor with the button's current settings in the following tabs: On Click, On Rollover and On 
Rollout. 

Question – Fill In The Blank 

The Fill in the blank type Question is an interactive object. 

By default, it consists of seven separate elements, as shown below: 

 

However, you have the option to add a Hint message, and three buttons: Clear, Skip and Back, 
which function as follows: 

Clear Clear all user input on the question, e.g. make text fields empty, uncheck radio 
button/check box. 

Skip Go to the next slide. 

Back Go to the previous slide. 

Submit Get user input, evaluate, and execute suitable actions. 

User can change these default behaviors by editing On Click actions of these buttons from the 
Event Editor window. (Select the question, then double click the button to launch the Event Editor.) 
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In the rendered presentation, the object functions as follows: 

Only the question (2), the answer box (3) and the Submit button (7) are displayed. The user is 
expected to click inside the box and enter some text. 

When the user responds, the presentation compares the answer with the reference answer (which 
is previously defined by the author).  

 If the answer is correct, the actions defined in On Correct tab are taken.  (which typically is 
to display the On Correct response (4)) 

 If the answer is incorrect, the actions defined in On Incorrect tab are taken. (which typically 
is to display the On Incorrect response (5)) 

 If the user tries to leave the answer incomplete, the actions defined in the On Incomplete 
tab are executed. (which typically is to display the On Incomplete response (6)) 

Apart from this primary behavior, the object also has secondary behaviors. 

To set up all behaviors of the object, double-click on the Target area. This launches Event Editor 
with the object's current settings in the following tabs: Value, Settings, On Correct, On Incorrect, 
On Incomplete and On Timeout. 

You have to set up the behavior of each button separately. Double-click on the button to launch 
Event Editor with the button's current settings in the following tabs: On Click, On Rollover and On 
Rollout. 

Question – Fill In Multiple Blank 

The Fill in multiple blank type Question is an interactive object. 

By default, it consists of seven separate elements, as shown below: 
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However, you have the option to add/remove answers, add a Hint message, and three buttons: 
Clear, Skip and Back, which function as follows: 

Clear Clear all user input on the question, e.g. make text fields empty, uncheck radio 
button/check box. 

Skip Go to the next slide. 

Back Go to the previous slide. 

Submit Get user input, evaluate, and execute suitable actions. 

User can change these default behaviors by editing On Click actions of these buttons from the 
Event Editor window. (Select the question, then double click the button to launch the Event Editor.) 

In the rendered presentation, the object functions as follows: 

Only the question (2), all answer statements (3a) with their corresponding input boxes (3b) and the 
Submit button (7) are displayed.  

The user is expected to click in these input boxes and type his answers. 

 Note that although this example shows the answer boxes at the end, you can easily place 
them in the middle of the sentences: Just type a few spaces in the middle of the answer 
sentence, and then drag the input box over this blank area of the answer. Re-size the input 
box size, position, text style, etc as required. When the user responds, the presentation 
compares the input text strings with the reference answers (which are previously defined by 
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the author).  

 If the answer is correct, the actions defined in On Correct tab are taken.  (which typically is 
to display the On Correct response (4)) 

 If the answer is incorrect, the actions defined in On Incorrect tab are taken. (which typically 
is to display the On Incorrect response (5)) 

 If the user tries to leave the answer incomplete, the actions defined in the On Incomplete 
tab are executed. (which typically is to display the On Incomplete response (6)) 

Apart from this primary behavior, the object also has secondary behaviors. 

To set up the general behaviors of the object, double-click on the Target area. This launches 
Event Editor with the object's current settings in the following tabs: Settings, On Correct, On 
Incorrect, On Incomplete and On Timeout. 

To set up the reference text for each answer, double-click on each input box. 

(Note: To reach the input box, you may have to click on the answer first, and then click on the input 
box. Once the input box is selected, you can double-click on it.) 

This launches Event Editor with the current settings for this specific answer. Each tab of the 
Event Editor defines the object's response to a different event, as shown below: Value, On 
Rollover and On Rollout. 

Repeat this for each input box (for each answer). 

You have to set up the behavior of each button separately. Double-click on the button to launch 
Event Editor with the button's current settings in the following tabs: On Click, On Rollover and On 
Rollout. 

Question – Sequence 

The Question-Sequence is an interactive object. 

The default Question-Sequence object consists of six separate elements, as shown below: 
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However, you have the option to add/remove answers, add a Hint message, and three buttons: 
Clear, Skip and Back, which function as follows: 

Clear Clear all user input on the question, e.g. make text fields empty, uncheck radio 
button/check box. 

Skip Go to the next slide. 

Back Go to the previous slide. 

Submit Get user input, evaluate, and execute suitable actions. 

User can change these default behaviors by editing On Click actions of these buttons from the 
Event Editor window. (Select the question, then double click the button to launch the Event Editor.) 

In the rendered presentation, the object functions as follows: 

The question (2), all answers (3) and the buttons (6) are displayed. The answers are shuffled 
randomly each time the question shows. The user is expected to drag and drop the answers so 
that they have the same order as the author placed them. 

Apart from this primary behavior, the object also has secondary behaviors. 

To set up all behaviors of the object, double-click on the Target area. This launches Event Editor 
with the object's current settings in the following tabs: Settings, On Correct, On Incorrect and On 
Timeout. 

You have to set up the behavior of each button separately. Double-click on the button to launch 
Event Editor with the button's current settings in the following tabs: On Click, On Rollover and On 
Rollout. 
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Question – Drag-n-Drop 

You should read Creating Drag and Drop Interactions to have basic concepts about drag and 
drop, as well as useful tips before reading this section. 

As mentioned, Drag-n-Drop Question is a type of Question that includes multiple drag sources, 
drop targets and require learners/viewers (who take the output simulation) to map them correctly.  

 

To insert new shapes, images, drag source – drop target pairs, feedback messages or buttons, 
select the question then click on the corresponding tools on the right side of the question. 

To edit event – actions of the question, refer to the section for the Answer tab in the Event Editor 
window. 

You can also edit event – actions for each drop target, refer to the section for the Accepted Drag 
Sources tab in the Event Editor for more details. 
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Shape 

 

ActivePresenter offers five shape groups with many shapes in each group. You can insert any of 
them.  

After inserting a shape, you can do the following: 

 Click the text area of the shape and enter text. If the shape has no text, you can right-click 
the shape then select the Edit item from the popup menu. You can also select the shape 
then press F2 to start editing the text. 

 Drag the shape to a new position. 

 Drag the handles to resize the shape.  
If you make the shape too small, some text may be clipped or hidden. Therefore be careful 
while resizing the frame. 

 Drag the yellow diamond  to change the dimensions/appearance of the shape. 

 Use the Fill, Line, Shadow tools in the toolbar to change the shape style. 

 Arrange the shape with Order, Align tools in the toolbar. 

 Use the FORMAT > Change Shape tool and change the shape type. 

 Use the Timeline pane to change the timing and animation of the shape.Use the 
Properties pane to edit most of the properties. 
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Text Caption 

A Text Caption object is a rectangular shape that can contain multi-line formatted text. 

In fact, the Text Caption is a variant of the Shape object, where only the text is given prominence, 
and the Fill and Line attributes of the shape are muted.  

Therefore the discussion for shapes applies here too. 

Highlight 

A Highlight object is used to draw the attention of the viewers to a certain part of the screen. 

Think of a Highlight as a variant of Shape object, where the text and border line are removed and 
the background is made semi-transparent (50% transparency). 

Therefore the discussion for shapes applies here too. 

Spotlight 

A Spotlight object retains the original brightness within the shape, and darkens the rest of the 
screen. Thus it is able to instantly draw your attention irresistibly to even a tiny part on the screen. 

A Spotlight is a more aggressive version of Highlight, where the rest of the screen is not 
darkened. 

 

Like the other objects, a spotlight too is a Shape object with special attributes. Therefore all the 
discussion of the shapes applies here too. There are two exceptions: 

 The Properties pane actually shows the property of the area that lies OUTSIDE the shape 
(not inside it). 

 The Spotlight object doesn’t have the rotation property. 
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Feedback 

The Feedback object shows the user's mouse and keyboard activity when the rendered 
presentation is playing. 

When the interactive presentation is run, any keyboard or mouse inputs provided by the user are 
displayed as follows: 

CTRL+P  
 

CTRL+Left-click 
 

This is useful in on-screen demonstration of any software, where the audience can clearly see the 
actions of the presenter. 

Therefore it is placed where it will not obstruct the parts of the screen where action is going on; but 
at the same time it should not be placed too much away from action, because in that case your 
eyes would have to constantly flit to-and-fro between the action and the indicator, which is very 
tiring. 

The Feedback object doesn’t have the rotation property. 

Gesture Effect 

The Gesture Effect object is usually used in demonstration mode which shows how the viewer 
interacts with software on the touch screen. Basically, it looks like an animated GIF image. 
ActivePresenter provides fourteen gesture effect types.  

 Single Tap. 

 Double Tap. 

 Hold. 

 Two Fingers Single Tap. 

 Two Fingers Double Tap. 

 Swipe Up. 

 Swipe Right. 

 Swipe Down. 

 Swipe Left 

 Rotate Left 

 Rotate Right 

 Pinch In 
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 Pinch Out 

 Fingers. 

You can insert any gesture effect from the ANNOTATION > Gesture Effects menu. 

The Gesture Effect object doesn’t have the rotation property. 

Cursor Path 

This object represents the mouse movement and clicking. 

 

In practice, this object gets generated in two different ways: 

 During the capture phase, ActivePresenter records your mouse-movements and converts 
them into such paths. (The figure above shows only one segment. In real life, 
ActivePresenter creates a complex path with multiple segments.) 

 During the edit phase, you can edit the captured path or insert a new cursor path object by  
using the ANNOTATION > Cursor path tool. 

In general, the idea is to add/delete nodes in the path, and to drag them to place them over buttons 
or other clickable objects in the canvas. Optionally you can add click points, where ActivePresenter 
produces the clicking sound in the rendered presentation. 

Tip: When you insert a Cursor Path object, the whole object is selected so that you can move it to 
another position in the canvas. If you want to change the shape of the path, you will have to select 
its individual elements and drag. To do so, first click anywhere in the canvas. This deselects the 
path. Now click on any element of the path and drag. 

When you add a Cursor Path object, ActivePresenter inserts a Start point (1), an End point (2) 
and a dotted line (3) that represents the movement path of the pointer between these two points. 
The dotted circles mark the end-points (these markers are useful because you may want to turn off 
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the mouse pointer during some segments, in which you need a handle and a positional reference 
to manipulate the path). 

The line has green color at start, which changes to red at the end-point. A red arrow also shows 
the direction of cursor-movement. The spacing between the dots indicate the speed of the cursor 
on screen: Closely spaced dot means slower speeds. (Imagine the dots to be plotted at regular 
intervals of time; so the faster the cursor moves across the screen, the farther are the dots.) If the 
dots are too closely spaced, the line appears as solid instead of dotted. 

Note that a square denotes that Point#1 is selected at present.  

This is more or less a straight line. But you can add more points by clicking anywhere on the dotted 
red/green line. At this moment, the pointer turns into a pencil. After inserting any point, you can 
drag that point to a new position. This gives the path a new shape. 

Any given path segment can be made a curve or a straight line. Just select the start-point and from 
the context menu, select the Straight cursor path or Curved cursor path options (or click  

FORMAT > Straight Cursor Path  or FORMAT > Curved Cursor Path ).   

When you select (click on-) the start-point of a segment, ActivePresenter shows a Control point 
(4) associated with the end-point. In the example above, we had clicked on point (1), so 
ActivePresenter shows the control point (4), which is associated with Point (2). This control point is 
always tangent to the curve. You can change the shape of the curve by moving the control point.  

The following figure shows two sets of experiments: 

 Within each row, the diamond  is shifted more and more away from the end-point.  
(See the progression between figures 1→2→3 and figures 4→5→6) 

 Within each column, the diamond is rotated around the end-point by 45°. 

(Compare figures 1-4, 2-5 and 3-6) 

Observe that- 

1. As the yellow diamond  is moved away from the end-point, the path becomes more 
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curved. (Observe the progression in figures 1→2→3 and also figures 4→5→6).  

2. As the diamond is turned away from the straight line connecting the start-point and the end-
point, the curve also moves away from the center line. This shift is even more pronounced 
when the diamond is farther away from the end-point. (Compare figures 1-4, 2-5 and 3-6) 

To replace the original pointer with other shapes, double-click on any end-point. ActivePresenter 
pops up a cursor-selector window. 

 

Make sure that Library option is selected at the bottom (the project is not likely to have any shape 
resources). Select any shape pointer and press OK. 

In the following example, we have added a few points to the original line, and also changed the 
cursor for each of those interim points. When rendered, this line will keep changing the cursor 
shape along the way. 
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Also note how graceful the movement is, thanks to use of four control points. 

Now let us manipulate the same cursor movement in time. 

The following screenshot shows the actual movement on the screen and corresponding Timeline 
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view. 

 

The screenshot shows the 3rd segment with four instants 1-4 marked on both the canvas and the 
Timeline. 

From the Timeline, we can see that- 

1. The purple vertical line starts the life of the segment. 

2. The instant when the cursor starts moving is marked with a red vertical line. 

During the 1→2 gap, the cursor is at rest (there is no movement), this is the Start Duration 

of the cursor. 

The green line spans the duration of cursor movement.  

3. The instant when the cursor stops moving is marked with a second red vertical line. 

During the 3→4 gap, the cursor is at rest (there is no movement), this is the End Duration of 

the cursor. 

4. The second purple vertical line denotes the end of the segment. 
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Adding A Click Point 

The diamond  on the Timeline shows a click-point. This is where ActivePresenter simulates a 
click by producing a “click” sound and click effect. 

Any point on the cursor path can be converted into a click-point.: Just select the point by clicking 
on it, and then in the Properties pane, in the Cursor page, click in the Click-point check box. 

Composing A Mouse Path 

Here are a few tips for composing a realistic-looking path: 

1. Avoid showing mouse all the time. It is OK if the mouse vanishes from the scene for a 
while. 

2. Remove aimless wandering of the mouse: It is too much distracting. Replace them with 
straight segments. 

3. Avoid using the mouse as a presentation pointer. 

Jabbing the pointer at something may be OK for live demo, but in an annotated 
presentation, this is a sure sign of laziness! Instead, use shapes, zoom-n-pan or spotlight. 

4. The resting periods are important in realistic depiction of the mouse-movement. In fact, they 
contain the clicking points (you cannot click while the mouse is moving).  

5. When you are narrating something, keep the mouse at rest. 

6. Before clicking any important control, first prepare the viewer, by (a) describing which 
control you are going to click, and (b) what will be the consequence of that action. That 
way, he will be able to observe the action closely and correlate the happenings on the 
screen. 

It is a poor practice to first do something and then tell the viewer about what you did. While he 
struggles to make sense of what you said, he would lose track of what you say next! 

Continuation Of Cursor Path Between Slides 

Normally, when you drag the end-points of a cursor path, ActivePresenter will also move 
appropriate end-point in previous or next slide to ensure a smooth non-abrupt movement of the 
cursor in the rendered presentation.  

Let us understand this with an example: In the following figure, the end-point of the cursor path (1) 
on one slide has the same coordinates as the start-point of the cursor path (2) in the next slide. 

As result, when the rendered presentation transitions from the first slide to the next slide, the 
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movement of the cursor appears to be continuous (without any jerks). 

If you move the end-point (or the start-point) in any one slide, ActivePresenter automatically moves 
the corresponding matching point in the other slide, to again match their coordinates: 

However, in rare cases, the cursor path is out of sync (e.g. when you delete a slide that is in the 
middle, or delete the cursor path in that slide). This results in an abrupt movement of the mouse 
cursor in the rendered presentation when the slide changes. 

To avoid this, you can again “stitch together” the ends of cursor paths of adjoining slides, using the 

FORMAT > Snap To Previous  and FORMAT > Snap To Next  tools (or by r-clicking on the 
start/end point and using the context menu options). 

This will snap the start/end-point of the cursor path in current slide to the appropriate end/start-
point of cursor path in previous or next slide. 

Zoom-n-Pan 

The zoom-n-pan object shows ActivePresenter where to zoom during playback.  

This is a re-sizable rectangle that must always match its aspect ratio to the project's aspect ratio. 

Let us understand this with an example: 

In the following screenshot, the image of the Taj Mahal occupies the entire screen. Now imagine 
you were standing on the right minaret; and therefore you would like to zoom in that minaret. 
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To do this, insert a zoom-and-pan object, and move it over the minaret. Make it small enough so 
that the zoomed in view focuses there. 

 

In the Timeline, adjust the onset and duration of the Zoom-and-pan object. 

 The zoom should not be too fast, otherwise it becomes nauseating. 

When this slide is rendered, the camera shows the entire scene, and then zooms in and 
simultaneously pans sideways to the minaret. 

Note that the zoom-n-pan object has a one-way effect: When it ends, it does not restore the zoom 
back to normal. So the camera will keep looking at the minaret till the slide ends. 

If this were a movie (instead of an image), this would not be acceptable at all! 
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Fortunately, there is a trick: Use another zoom-n-pan object to zoom back to normal.  

Re-size it to cover the entire canvas. On the Timeline, place it apart so that you have a few 
seconds of close up at the minaret (the camera should not start zooming out abruptly). Set its 
duration so that the zooming out is smooth and unhurried (it should not be too fast). 

The combined effect of the two zoom-n-pan objects will be what you need.   

Closed Caption 

The closed captions (“CC”) are exactly like subtitles you see during a movie. Actually the key 
term is Captions. The qualifier term “closed” means that the user (and not the author-) has the 
power to display or hide the CC lines. 
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The above screenshot shows only one CC line, which typically lasts for a few seconds on screen. 
A typical slide would have tens (or hundreds) of such CC lines. 

The screenshot below shows three CC lines in the Timeline pane. The duration of each line is 
shown with a yellow rectangle (time bar). 

 

A CC object is quite different from other object types: 

1. A slide may have no CC line or multiple CC lines. All CC lines in a slide are considered as a 
CC object. 

2. The CC lines are arranged in time order and there is no overlapping in time between CC 
lines. That means only one CC line can be displayed at a time. 

3. You can not change the position of the CC lines. 

4. You can only toggle the lock and visibility of all CC lines at a time by clicking the and  
icons on the left side of Timeline. 

5. The visual attributes for all CC objects can be only set globally in the project: You cannot 
set a different visual attribute for each CC object. 

In other words, if you change the style of the CC on one slide, it will be applied to the CC in 
all other slides of that project. 

6. Usually a CC line is also converted into speech.  

When converted, all lines of a CC object produce a combined single audio object. 
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To add a CC line to slide, you can follow below steps: 

 Place the playhead in Timeline at the timestamp that you want to add the CC line. If the 
timestamp is not specified, ActivePresenter will append the new CC line to the end of all 
CC lines 

  Click the ANNOTATION > Closed Caption tool  in the Tabbed Toolbar or click the 

Insert Caption tool  in Timeline. 

You can also select multiple CC lines and press the Delete key to remove them from slide. 

To edit the text of a CC line, you can to follow below steps: 

 Place the playhead at the timestamp that the CC line is displayed in Timeline (1). 

 Click the object in Canvas to start the editing (2). 

 

In Timeline, you can also select one or multiple CC lines, the Caption page will be shown in the 
Properties pane: 

 

 The Timing section allows you specify the exact start time and duration of selected CC line 
in millisecond.  

 The Text To Speech section allows you to specify the properties for converting the text in 
selected CC line(s) to audio. 
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Adjusting Closed Captions In The Slide 

If you have annotated the slide with shapes and zoom-and-pan, your captions (and TTS speech) 
must refer to the feature that is being highlighted at that particular moment. 

However, this does not happen automatically. There may be several sync problems:  

 The CC may run into the subsequent scene which has no relation to what the CC is talking 
about.  

 The converted audio may interfere with an audio embedded in the slide during capturing 
phase. 

 The converted audio may overlap with TTS audio of other objects (shapes, for example) 

 The converted audio may overlap with other stand-alone audio/video objects  

You will have to check the presentation for these problems and sort them out. 

To synchronize the captions with your annotations, go back to the slide and look at the Timeline. 
Each caption appears in the Timeline as a separate bar. Look at its relationship with the other 
objects in the Timeline, and adjust the bars. 

 Display each caption for adequate time so that your audience can read it comfortably. So 
longer captions need more display time. 

 If you have used TTS narration, it needs to be read fully while the corresponding feature is 
still highlighted. 

This is not a problem for most objects, as you can simply lengthen their bars in the Timeline. In 
case of a video, you can freeze the frame for a few moments till the narration and caption play out. 
After that, resume the play. 

When you adjust the caption bars in the Timeline, these changes are reflected in the Closed 
Caption Editor. 

Let us see all this with an example: 

The following screenshot shows our Taj Mahal project. It shows three bars in the Closed Caption 
row, which means there are three captions. 
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The bars in Timeline were adjusted as follows: 

1. The first caption introduces the Taj. Therefore it must start after a couple of seconds. 
Therefore the start point of this bar was pushed back by 2 seconds. 

The duration of the bar was adjusted so that the audience can read the text comfortably. 

2. The intent was to zoom-n-pan to a minaret (2a), and reveal an amazing fact that the 
minarets are intentionally built tilted, so that from afar, they actually look perfectly vertical. 

So the zoom-n-pan (2b) takes the viewer to the minaret.  

3. Once the view is zoomed in, the caption is displayed. 

Since this is a longer sentence, more time is given to it. 

4.  Another zoom-n-pan brings the view back to normal. This is intentionally done at a faster 
pace, because we are only reverting to the full view that was already there. 

After this, a small gap is allowed so that the audience can reorient itself. 

5. Now the final caption begins. Adequate time is given so that the audience can read it 
comfortably. 
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Here are some tips for manipulating CC lines allows you to position the CC bars correctly (e.g. to 
synchronize with the audio):  

1. You can select multiple CC time bars using SHFT+click (to select all adjoining bars) and/or 
CTRL+Click (to select all non-adjoining bars). 

2. You can shift multiple selected CC time bars simultaneously by dragging with mouse. 

Converting All Closed Captions To Speech 

ActivePresenter provides a batch operation to convert all CC objects into speech in one stroke. 

Click SLIDE > Batch Operations > Convert Closed Captions to Audio. 

The following window pops up: 

 

1. In the top section (1), define the slides where you want this convert CC to speech. 

 You can do the conversion in all slides of the project, current slide or specific slides. 

 To limit the conversion only to specific slides, enter the comma-separated list in the 
input box. 
You can enter a range by separating the slide numbers with a hyphen. For example, “3-
6” means slide# 3, 4, 5 and 6. 

2. Next, set the TTS parameters by clicking on the Settings button (2). 
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 The following window appears: 

 

Select the TTS voice, adjust the speed and volume. 

To check the settings, enter a test sentence in the Preview input box, and click on the Speak 
button. 

If your results are not OK, change the parameters and try again. Repeat this cycle till you are 
satisfied. 

If your settings are too unsatisfactory, click on the Reset button and start over. 

When you are satisfied, press OK to return to the main window. 

3. In the main window, the check box at the bottom (3) extends the duration of each CC object to 
match the duration of the converted speech.  

This may cause sync problems:  

 The CC may run into the subsequent scene which has no relation to what the CC is 
talking about.  

 The converted audio may interfere with an audio embedded in the slide during capturing 
phase. 

 The converted audio may overlap with TTS audio of other objects (shapes, for example) 

 The converted audio may overlap with other stand-alone audio/video objects  

You will have to check the presentation for these problems and sort them out. 

Note that even if you have already converted the captions for many CC objects, you can still 
launch this operation safely, without any adverse effects. 
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Miscellaneous Tips 

Here are some general tips for using Closed Captions: 

 Always ensure correct spellings! 

 Use words that match the actual voice narration. Do NOT try to paraphrase. 
Otherwise the audience may find it very hard to read the Closed Captions. 

 Use punctuation to clarify the meaning. 

If a sentence ends normally, use the appropriate mark (.?!) at the end. However, a 
sentence that is left unfinished should end with an ellipsis (…). 

 Translate foreign words in parenthesis ( ). 

 Use italics (or ALLCAPS) to denote a new word or heavily emphasized part in speech. 

 Show music or other sound effects in square brackets, such as [music], [door slams], 
[crowd at the bar], or [laughter]. 

 Use square brackets to describe any mood conveyed through voice-modulation, such as 
[whispers], [shouts], [menacingly], [croons], [sobs]. 

Always use the appropriate word to convey the degree of intensity of an action. 

For example, chuckles, smiles, laughs and guffaws are all different! 
Similarly, “door closes” and “door slams” convey entirely different moods. 

 When the speaker is off screen, identify him/her by name. 

 When more than one persons are on screen, identify the speaker by name. 

 As a rule, show only one line of Closed Caption at a time. 

An exception is when multiple people speak simultaneously: In this case, it is OK to show their 
sentences together; but always maintain the correct sequence (a sentence that starts first should 
be listed at the top of the Closed Caption stack). 

Another exception is when one person is interrupted by another. Here, end the first (interrupted) 
sentence with a dash “–“; and place the second (interrupting) sentence in the second line. 

Image 

You can insert an image in the ActivePresenter presentation by clicking ANNOTATION > Image 

. 

Depending upon the context of the presentation, images are screenshots of applications, drawings 
(electrical, civil, mechanical, etc.) or photos of persons, products, places, buildings, etc. 

After placing the image, you can place other annotations and explain the image (or parts of it). 

Screenshot 

ActivePresenter has a built-in facility to capture screenshots. 

A typical application has a top level window, which in turn may have child windows that pop up to 
accomplish different tasks. The windows form a hierarchical tree. A window at any level (top/child) 
has objects (menus, panes, toolbars, controls, etc.). ActivePresenter allows you to take a 
screenshot of any of these windows/objects, which is then inserted in the current slide of your 
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presentation. 

ActivePresenter has four different ways of taking a screenshot, which can be selected by clicking 

ANNOTATION > Screenshot , and then selecting a sub-option. 

The screenshot modes are described below: 

Capturing A Window 

To capture a screenshot of the target window or any object in it, select the  Window option. 
ActivePresenter can capture a window at any level of the application. 

Use the mouse to select a window or its object (e.g. toolbar, pane, menus, etc.).  

You can use the mouse click on the target applications normally (it does not trigger a screenshot).  

As you move the mouse over different parts of the screen, ActivePresenter shows a red dotted 

outline  around areas that can be captured. 

Note: You will find that ActivePresenter cannot detect some objects in certain target applications. 
This is because those applications have not provided MSAA interface for those controls.  
ActivePresenter typically captures the whole toolbar, because it is usually the lowest level 
child window. 

When you find the correct area to be captured, press the PrintScrn key on your keyboard or 
CTRL+Click. ActivePresenter will capture the screenshot and place the image in the current slide. 

Capturing An Object 

To capture a screenshot of any object in any window, select the  Object option. 

As you move the mouse over different parts of the screen, ActivePresenter shows a red dotted 

outline  around areas that can be captured. 

Note: You will find that ActivePresenter cannot detect some objects in certain target applications. 
This is because those applications have not provided MSAA interface for those controls. 
Typically, ActivePresenter can capture the individual tools on any toolbar, depending on the 
accessibility support level of the target application. 

When you find the correct area to be captured, press the PrintScrn key on your keyboard or 
CTRL+Click. ActivePresenter will capture the screenshot and place the image in the current slide. 

Capturing The Full Screen 

To capture a screenshot of the entire screen of your PC, select the  Full Screen option. 
(Some screen-capturing applications call this “desktop” mode.) 

ActivePresenter will minimize its own screen, and capture whatever is visible on your computer 
screen. This may be a single application (running with its window maximized), or several windows 
of different applications. 

ActivePresenter will then place this image on the current slide. 

Be careful: This image is very likely to be larger than your slide. If you re-size it to fit the canvas 
size, the details in the image will get blurred, and the viewers may not be able to read specific 
details. 
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Capturing An Application or Region 

To capture a screenshot of the top-level window of the target application, or a rectangular region of 

the screen, select the  Application or Region option. 

A target-seeker window pops up as shown below.  

(A cross-hair in the middle of this window indicates that this is a target-seeker window.) 

 Drag and position this window around the target part of the screen. 

 Re-size the window by dragging its handles (tiny squares at the corners and middle of all 
sides). 

The screenshot command window: 

 

This window works as follows: 

The Screenshot Usage section allows you to insert the screenshot as an image in the current 
slide, and/or as a background image of a new slide that is inserted after the current slide. 

The Screenshot size section allows you to set the size precisely (instead of setting the size 
visually by adjusting the target-seeker window). When you set a size, the target-seeker window re-
sizes to that specified size. The Preset sizes button allows you to select from pre-defined sizes. 

The Application section provides you a drop-down list of all applications running on this PC that 
have a visible window. Generally you need to take the screenshot of an application, so this list 
should satisfy your needs. 

 The Fit To Application button fits the window of the selected target application to the 
target-seeker window's current size. 
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 The Fit To Boundary button fits (re-sizes) the target-seeker window to the selected target 
application's window. 

The Wait for control allows you to take the snap after a delay (defined in milliseconds). Use this 
delay to quickly interact with the target application after you, and capture its response. 

To take the screenshot, click on the Take Screenshot button. 

Screenshot Options 

The ANNOTATION > Screenshot  menu also contains a few options, as explained below. Note 
that the first three options work only when capturing a window at any level (not when you are 
capturing a region or an object). 

 Capture shadow (Windows Vista or later): When an application's window is in non-
maximized state, the Windows OS casts a drop-shadow around its border.  

ActivePresenter has the option to capture this shadow while taking a screenshot of the 
target window.  

Note that this drop-shadow is treated as part of the image, and not a shadow property of 
the screenshot image that is captured. In other words, you can add one more shadow to 
this captured image, with a different set of parameters (color, distance, angle, etc.) 

 Process rounded corners:  When an application's window is in non-maximized state, the 
Windows OS offers an option to display rounded corners. 

ActivePresenter has the option to capture these rounded corners. If this option is turned off, 
the captured image will have sharp corners. 

 Use opaque background:  Windows Vista and later have the option to use Aero theme, 
where the borders of windows appear semi-transparent. While the windows look great, they 
also mess up the screenshot, because any text/images in the background will also show up 
through these borders. 

ActivePresenter has the option to replace this transparency in the captured screenshot with 
an opaque border. 

 Show usage guide: Shows a yellow text box that describes how to actually capture the 
screenshot when capturing windows or objects. If you are apt to forget the shortcuts, leave 
this display on. 

Audio 

An audio object is displayed on the canvas pane as the  icon, and its Time Bar is displayed in 
the Timeline. Note that the canvas icon is just a visual indicator to remind you that there is an 
audio in the slide: Its placement in the canvas is not important. This icon is not visually rendered in 
the final output. 

In a capture type project, a new audio object is created when you narrate the operation of the 
target software.  

Later, during the edit phase, you can add audio objects to the slide in four different ways: 

1. Adding A Voice-over/Commentary (or Dubbing) 

2. Insert an audio file (mp3, ogg, wav, wma,...) 

3. Record a new audio track 
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4. Convert some text to speech 

To insert an audio into a slide, click ANNOTATION >Audio  and select an existing audio file to 
insert. You can also drag an existing audio file from Explorer and drop it onto the Canvas to insert. 

To insert an empty audio object which will be later used for recording or converting text to speech, 
click ANNOTATION > Audio > Create New… 

For recording a new audio track or converting text to speech, you can refer to The Audio Section 
for more details. 

Display Styles of Audio Objects 

Depending on how the audio objects are created, they are displayed in three different ways: 

1. When an audio object is inserted to the slide, an  icon is displayed in the Canvas pane 
(only during edit mode; not when the slide is being played). 

The Timeline pane displays the Time bar of the object. 

2. When an audio track is attached to an object (e.g. the sound track of a video), the Timeline 
pane displays its Time bar. 

3. When a Closed Caption is converted into audio, a separate audio object is created. The 
Timeline shows a separate audio object. 

In all cases, the time bar in the Timeline shows the actual audio waveform, which facilitates 
editing. 

Properties Of Audio Object 

The audio objects have the following properties: 

Property Remarks 

Name A name generated by ActivePresenter, to identify the audio object 
uniquely. The name is simply “Audio_n”, where n is an incremental 
counter number. 

Audio The media resource which selected object refers to. You can change it to 
another resource. 

Loop If selected, the audio is played in an endless loop (when the end is 
reached, the tracked starts playing from the beginning.) 

Ignore Pausing If this option is selected, even when the presentation is paused (e.g. to 
wait for user's input), the track will keep playing. 

Note that this control cannot ignore a pause command from toolbar of 
player. In other words, if the user pauses the presentation using the 
toolbar, the audio will pause. 
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Property Remarks 

Boundary  

Physical placement of the  icon, measured from the top-left corner of 
the canvas. Change the placement if the icon is obstructing any other 
element.  

Note that this is only an indication that the slide has an audio track: During 
actual rendering, this icon is not used at all. 

Left 

Top 

Start Time This is the time when the audio track starts playing. The starting moment 
of the slide is taken as reference (t=0) 

Duration The duration of the audio track (in ms). 

This value is non-editable (grayed out). 

Show in mode Select one or more from- 

Demonstration, tutorial, practice, test.  

Video 

To insert a video into a slide, click ANNOTATION > Video  and select an existing video file to 
insert. You can also drag an existing video file from Explorer and drop it onto the Canvas to insert. 

Typically the next step is to re-size and re-position the video frame by dragging the handles on all 
sides and corners. 
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To change a video, in the Properties pane, go to the Video page: 

 

Click on the  button to insert a resource from the Library, or  button to insert a file from the 
disk. 

The  button is used to remove an existing resource, so that you can insert another resource. 

The playback controls allow you to play the video and check it out. 

You can insert multiple frames in the slide and play multiple videos simultaneously. 

 Play two videos side by side in a before-after scenario, or  

 Play multiple videos side by side to compare different techniques  
(e.g. bowling action, batting strokes, biking posture, running, etc.). 

Common Properties Of Video Object 

The video objects have the following properties: 

Property Remarks 

Name A name generated by ActivePresenter, to identify the audio object 
uniquely. The name is simply “Video_n”, where n is an incremental 
counter number. 

Video The media resource which selected object refers to. You can change it to 
another resource. 
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Loop If selected, the video is played in an endless loop (when the end is 
reached, the tracked starts playing from the beginning.) 

Ignore Pausing If this option is selected, even when the presentation is paused (e.g. to 
wait for user's input), the track will keep playing. 

Note that this control cannot ignore a pause command from toolbar of 
player. In other words, if the user pauses the presentation using the 
toolbar, the video will pause. 

Boundary The boundary of frame that contains the video, measured from the top-left 
corner of the canvas. 

Left Left edge of the frame. 

Top Top edge of the frame. 

Width Width of the frame 

Height Height of frame 

Lock aspect ratio By unchecking this check box, you can stretch the video in width or 
height. 

Start Time This is the time when the video track starts playing. The starting moment 
of the slide is taken as reference (t=0) 

Duration The duration of the video track (in ms). 

This value is non-editable (grayed out). 

Show in mode- Select one or more from- 

Demonstration, tutorial, practice, test.  

Cursor Effects Properties In Recorded Video 

When you recording a video with the option Make Cursor Editable for Full Motion Recording 
selected in the capture profile, you can change the cursor effects of the recorded video. 

To change the cursor effects of a video, you need to select the video and go to the Cursor Effects 
section in the Properties pane. The cursor effects have following options: 

Property Remarks 

Render Cursor Display the cursor, highlight effect, click effects and play the click 
sounds when playing this video. 

Cursor Highlight Additional content which is drawn around the cursor to highlight it. 
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Highlight Type of highlight effect. You can select from: None, Circle, and 
Square. 

Size Size of highlight effect. It is the radius of the circle in the Circle 
highlight or half size of the width of the square in the Square highlight. 

Color The color which is used to draw the highlight. 

Opacity The opacity which is used to draw the highlight. 

Click Effects   Play a sound and render an animation when the mouse is clicked. 
You can customize the Left-Click Effects, Right-Click Effects, and Left 
Double-Click effects separately.  

Click Sound The sound which is played when a mouse button is pressed. 

Click Effects The animation effects which is rendered when a mouse button is 
pressed. You can select from: None, Circle, Concentric Circles, and 
Square. 

Size Size of click effect.  

Color The color which is used to draw the click effect. 

Opacity The opacity which is used to draw the click effect. 

Freeze-Frame 

The Freeze-frame control works on both audio and video objects, as described below: 

 If the selected track is a video track, the effect is to pause the video for any desired period. 

 If the selected track is an audio track, the effect is to insert an interval of silence. 

In the older versions of ActivePresenter, you can insert Freeze-Frames into an audio/video by 

using the Insert Silence/Freeze-Frame  tool in Timeline. From version 5.5, this tool is 

superseded by a more powerful tool, Insert Time . 

To insert a freeze-frame control in an audio/video track, select the audio/video object (you can 
select multiple objects at once) then click on the Ruler where you want to pause the video. This 

activates the Insert Time   button in the toolbar of the Timeline pane. Click on this button.  

Now a yellow diamond and bar will get superimposed on the host time bar.   

 If you had defined a range in the previous step, the yellow bar is adjusted to this range. 
However, the usual practice is to drag the diamond and the right-side edge of the yellow 
band. During this drag operation, ActivePresenter shows you precise time stamp on the 
Ruler (as in case of entrance/exit markers.) 
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 Each Freeze-frame control extends the host track by its duration.  

In other words, if you insert an x-second pause in an audio/video clip, its total duration will 
be increased by x seconds. 

 You can insert any number of Freeze-frame controls in any selected track. The only 
condition is that two Freeze-frame controls cannot overlap. 

Keep in mind that each Freeze-frame control will further extend the host track's duration! 

To remove the freeze-frame from its host track, 
click on it and drag it downward out of the 
Time Bar of the host track. Keep dragging till 
the annotation turns gray, and then release the 
LMB. The annotation (i.e., the pause) will 
disappear, and the duration of the host track 
will be reduced by the duration of the pause. 

So why don't we simply split the track, and shift the latter part to achieve the same end-result? 

Well, there are two benefits of using a Freeze-frame control: (a) It is easier to remove (to reverse 
its effect), and (b) It does not create extra resources by splitting the original object. 

Let us see how the Freeze-frame control affects the audio and video tracks. 

Pausing A Video Track (Freezing The Scene) 

When the slide is played in preview mode (or exported), the host video is paused for the duration 
of the Freeze-frame control's duration. However, the other objects in the slide are played normally. 

Now why should we want to do this in the first place? 

Well, sometimes, a video contains a significant scene, which lasts only for a few seconds. The 
scene is over even before your audience has the time to absorb the important clues. If this were a 
live lecture, you would pause the video, and explain various parts of the frozen scene to your 
audience. But what to do if this is a self-running video? 

This is where the Freeze-frame is useful: It allows you to pause a video for the duration of its time 
bar. You can extend this pause as long as you want, and add a commentary track or annotations 
to analyze the frozen video frame. 

In the above example, the video in Video2 object is frozen, and an audio commentary is 
introduced in the paused duration. During this time, two annotation shapes are also displayed on 
the screen, and two closed caption lines appear. While the video is paused, all these other objects 
are played normally. 

Note that you can insert any number of Freeze-frame controls in a video clip. This allows you to 
pause the video any number of times and explain those frames to your viewers. 

Pausing An Audio Track (Inserting Silence) 

When a Freeze-frame control is inserted in an audio track, it inserts an interval of silence. 
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When the slide is played in preview mode (or exported), the host audio clip is paused for the 
duration of the Freeze-frame control's duration. However, the other objects in the slide are played 
normally. 

Normally you would apply this effect only to a significant audio track that needs to be synchronized 
with the visual part of the presentation (for example, you would not need it for a background music 
track!). 

A typical example is to re-sync a stand-alone commentary track with the rest of the slide by holding 
it off for a few seconds.
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Menus, Toolbars And 
Shortcuts 

In this appendix the menus, toolbar buttons and default keyboard shortcuts are listed. Note that 
ActivePresenter allows you to customize the keyboard shortcuts. 

ActivePresenter Main Menu 

Menu Item Default 
Shortcut 

Icon Remarks 

Create Project...   Create a new project (select the type). 

Blank Project...  Ctrl+K  Create a new blank project. 

New Capture...  Ctrl+N  Create a new capture project. 

Open Project...  Ctrl+O 
 

Open an existing project. 

Save  Ctrl+S 
 

Save the current project. 

Save All   Save all open projects. 

Save As...   Save the project under a new name. 

Close Ctrl+W  Close the current project. 

Project Properties...  
 

Project's properties. 

Project Settings...  
 

View and edit the project's settings. 

Shrink project…   Make the project compact. 
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Recent Projects   List of recently opened projects. 

Preferences...  
 

View and edit the global settings. 

Exit  Ctrl+Q  Close the ActivePresenter application. 

Quick Access Toolbar 

Tool Default 
Shortcut 

Icon Remarks 

Create Project...   Create a new project (select the type). 

Open Project... Ctrl+O  Open an existing project. 

Save Ctrl+S  Save the current project. 

Undo Ctrl+Z  Reverse the last actions. 

Redo  Ctrl+Y  Repeat the last “undone” actions. 

 

HOME Tab 

Tool Default 
Shortcut 

Icon Remarks 

Paste Ctrl+V 
 

Paste the contents of clipboard. 

Cut  Ctrl+X 
 

Cut the selected items into clipboard. 

Copy Ctrl+C 
 

Copy the selected items into clipboard. 

Blank Slide  
 

Insert a blank slide. 
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Capture Slides  
 

Insert new slides by fresh capturing. 

Slides From  
 

Insert images as slides (create new slides and 
insert images from disk as their background), 
or insert slides from a PowerPoint 
presentation. 

Font Name   Change the font name for the selected text or 
objects. 

Font Size   Change the font size for the selected text or 
objects. 

Increase Font Size Ctrl+]  Increase font size for the selected text or 
objects. 

Decrease Font 
Size 

Ctrl+[  Decrease font size for the selected text or 
objects. 

Remove Format   Remove inline text formatting for the selected 
objects. 

Floating Text 
Format Toolbar 

  Show/Hide the Floating Text Format toolbar 
when editing text. 

Bold Ctrl+B  Make the selected text, or the text in the 
selected objects bold. 

Italic Ctrl+I  Make the selected text, or the text in the 
selected objects italic. 

Underline Ctrl+U  Underline the selected text, or the text in the 
selected objects. 

Strikethrough Ctrl+Shift+S  Strikethrough the selected text, or the text in the 
selected objects. 

Text Color   Change the text color for the selected text or 
objects. 

Highlight Color   Highlight the selected text, or the text in the 
selected objects. 

Subscript Ctrl++  Format the selected text as subscript. 
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Superscript Ctrl+Shift++  Format the selected text as superscript. 

Insert Symbol   Insert symbol to the editing text. 

Insert Hyperlink   Make the selected text link to a webpage. 

Remove Hyperlink   Remove the link to a webpage from the selected 
text. 

Numbering   Add numbering to the selected text. 

Bullets   Add bullets to the selected text. 

Decrease Indent   Increase the indent of the selected text. 

Increase Indent   Decrease the indent of the selected text. 

Align Text Left Ctrl+L  Align the selected text, or the text in the 
selected objects left. 

Align Text Center Ctrl+E  Align the selected text, or the text in the 
selected objects center. 

Align Text Right Ctrl+R  Align the selected text, or the text in the 
selected objects right. 

Justify Ctrl+J  Justify the selected text, or the text in the 
selected objects. 

Text Vertical Align   Change the vertical alignment of the text in the 
selected objects. 

Shapes  
 

Insert a Shape. 

Interactions  
 

Insert an interactive object. 

Text Caption  
 

Insert a Text Caption. 

Order  
 

Change the z-order of the selected objects. 

Order > Bring to 
Front 

CtrI+Home  Brings the selected object to the top of z-order 
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Order > Bring 
Forward 

CtrI+PageUp  Brings the selected object one level upward in 
the z-order 

Order > Send to 
Back 

CtrI+End  Sends the selected object to the bottom of the 
z-order 

Order > Send 
Backward 

CtrI+PageDn  Sends the selected object one level downward 
in the z-order 

Align  
 

Align the selected objects. 

Quick Style  
 

Quickly set the style (fill, line, shadow and text) 
for the selected objects. 

Fill  
 

Change the fill for the selected objects. 

Line  
 

Change the line for the selected objects. 

Shadow  
 

Change the shadow for the selected objects. 

Find Ctrl+F 
 

Find the occurrence of text in objects in 
specified slides. 

Replace… Ctrl+H 

 

Replace the occurrence of text by specified text. 

Project Settings...  
 

View and edit the project's settings. 

SLIDE Tab 

Tool Default 
Shortcut 

Icon Remarks 

Blank  
 

Insert a blank slide. 

Capture  
 

Inserting new slides by fresh capturing. 

Images  
 

Inserting images as slides (create new slides 
and insert images from disk as their 
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background). 

PowerPoint  
 

Insert slides from a PowerPoint presentation. 

Save Slide As 
Image 

 
 

Export the current slide as an image. 

Change 
Background 

 
 

Set a slide's background image. 

Edit Background  
 

Edit a slide's background image. 

View Active 
Window 

 
 

Show/hide the Active Window area. 

Edit Active Window  
 

Enable/disable editing the Active Window area. 

Batch Operations  
 

Provide options for changing multiple objects in 
multiple slides at once. 

Batch Operations > 
Insert Objects... 

  Select an object of any type, and insert it in 
multiple slides. 

Batch Operations > 
Delete Objects... 

  Delete objects of selected type from multiple 
slides. 

Batch Operations > 
Change Style for 
Multiple Objects… 

  Change the style of objects for the current 
slide, selected slides or all slides. 

Batch Operations > 
Change Transition 
Effects for Multiple 
Objects… 

  Change the entrance and exit effects of objects 
for the current slide, selected slides or all slides. 

Batch Operations > 
Convert Closed 
Captions to 
Audio… 

  Convert closed captions to speech for the 
current slide, selected slides or all slides 
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ANNOTATION Tab 

Tool Default 
Shortcut 

Icon Remarks 

Shapes  
 

Insert a Shape. 

Text Caption  
 

Insert a Text Caption. 

Highlight  
 

Insert a Highlight. 

Spotlight  
 

Insert a Spotlight. 

Feedback  
 

Insert a Feedback object. 

Gesture Effects  
 

Insert a Gesture Effect. 

Cursor Path  
 

Insert a Cursor Path. 

Zoom-n-Pan  
 

Insert a Zoom-n-Pan object. 

Closed Caption  
 

Insert a Closed Caption (CC) object or insert a CC 
line into an existing CC object. 

Image  
 

Insert an Image. 

Screenshot >  
Window 

  Capture a window. 

Screenshot > 
Object 

  Capture an object. 

Screenshot > Full 
Screen 

  Capture the full screen. 

Screenshot > 
Application or 
Region 

  Capture an application or rectangular area. 
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Screenshot > 
Options > Capture 
Window Shadow 

  Screenshot option to capture the shadow of the 
target window (when not maximized). 

Screenshot > 
Options > Process 
Rounded Corners 

  Screenshot option to keep rounded corners of 
target window (instead of sharp corners). 

Screenshot > 
Options > Use 
Opaque 
Background 

  Screenshot option to use opaque borders of the 
target window instead of translucent (transparent) 
borders. 

Screenshot > 
Options > Show 
Usage Guide 

  Screenshot option to show tooltip on how to use. 

Audio  
 

Click the icon to insert an Audio from external 
audio file. Click the dropdown arrow to display the 
sub-menu. 

Audio > From File   Insert an Audio from external audio file. 

Audio > Create New   Insert an Audio object for recording, TTS... 

Video  
 

Insert a Video. 

ITERACTION Tab 

Tool Default 
Shortcut 

Icon Remarks 

Mouse Click  
 

Insert a Mouse Click object. 

Key Stroke  
 

Insert a Key Stroke object. 

Text Box  
 

Insert a Text Box object. 

Mouse Hover  
 

Insert a Mouse Hover object. 
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Drop Area  
 

Insert a Drop Area object. 

True/False  
 

Insert a True/False-type question object. 

Multiple Choice  
 

Insert a Multiple Choice-type question object. 

Multiple Response  
 

Insert a Multiple Response-type question 
object. 

Essay  
 

Insert an Essay-type question object. 

Fill in Blank  
 

Insert a Fill In The Blank-type question object. 

Fill in Multiple 
Blank 

 
 

Insert a Fill In Multiple Blank-type question 
object. 

Sequence  
 

Insert a Sequence-type question object. 

Drag-n-Drop  
 

Insert a Drag-n-Drop-type question object. 

Event  
 

Show the Event Editor window for the focused 
interactive object. If the focused object is an 
element of a question object, the question Event 
Editor will be displayed. 

Message  
 

Insert feedback message (for example Correct, 
Incorrect…) for the focused interactive object. If 
the focused object is an element of a question 
object, the message is inserted for the question. 

Question Button  
 

Insert button for the focused question object, 
including Clear, Back, Skip, Submit button. 

Question Answer  
 

Insert answer for the focused question object. 

Question Object  
 

Insert shape or image into the focused Drag-n-
Drop question object. 

http://atomisystems.com/tutorials/


ActivePresenter User Manual  Version 5.5 

Menus, Toolbars And Shortcuts> EXPORT Tab 311 

EXPORT Tab 

Tool Default 
Shortcut 

Icon Remarks 

Images  
 

Export slides as individual images. 

Video  
 

Export as a video (specify the output format; from 
AVI, WMV, MPEG4 and WebM). 

FLV  
 

Export as flash video. 

HTML SlideShow  
 

Export the slides as HTML slideshow. 

PDF Document  
 

Export as a PDF file. 

Microsoft Word  
 

Export as MS Word file. 

Microsoft Excel  
 

Export as MS Excel file. 

Microsoft 
PowerPoint 

 
 

Export as Microsoft PowerPoint file. 

Flash Simulation  

 

Export as Flash Simulation. 

HTML5 Simulation  

 

Export as HTML5 Simulation. 

LOCALIZE Tab 

Tool Default 
Shortcut 

Icon Remarks 

Replace Slide 
Backgrounds 

 
 

Provide four options to replace the slide 
backgrounds with the new ones, as described 
below. 
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Replace Slide 
Backgrounds > All 
Slides 

  Start replacing the backgrounds of all slides in 
current project by capturing new backgrounds. 

Replace Slide 
Backgrounds > 
Selected Slides 

  Start replacing the backgrounds of selected 
slides in current project by capturing new 
backgrounds. 

Replace Slide 
Backgrounds > All 
Slides From 
Project 

  Start replacing the backgrounds of all slides in 
current project by backgrounds of slides in an 
existing project. 

Replace Slide 
Backgrounds > 
Selected Slides 
From Project 

  Start replacing the backgrounds of all slides in 
current project by backgrounds of slides in an 
existing project. 

Import From 
XLIFF 

 
 

Import translated text in XLIFF format into the 
project. 

Export To XLIFF  
 

Export text in the project to XLIFF format for 
translation. 

VIEW Tab 

Tool Default 
Shortcut 

Icon Remarks 

Slides In Column  

 

Show slide thumbnails in the Slides pane. The 
slide thumbnails are resized automatically to fit 
the available width. 

Slides In Grid  

 

Show slide thumbnails in the Slides pane. The 
slide thumbnails have a fixed size and are 
displayed in grid. 

Slides In Titles  

 

Show slide titles in the Slides pane. 

Timeline  

 

Show/hide the Timeline pane. 

Resources  

 

Show/hide the Resource pane. 
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Properties  

 

Show/hide the Properties pane. 

Slides  

 

Show/hide the Slides pane. 

Drag-n-Drop Ctrl+D 

 

Show/hide the highlight rectangles of drag source 
and drop target, and the connection between 
them. 

Canvas Snapping  

 

Enable/disable snapping in the Canvas panes. 

Timeline Snapping  

 

Enable/disable snapping in the Timeline panes. 

First Slide  

 

Go to the first slide. 

Previous Slide  

 

Go to the previous slide. 

Next Slide  

 

Go to the next slide. 

Last Slide  

 

Go to the last slide. 

Specified Slide Ctrl+G 

 

Go to the specified slide. 

Zoom  

 

Set the zoom level for the Canvas panes. 

Zoom Fit  

 

Adjust the zoom level automatically to fit the 
Canvas to the available space. 

Language  

 

Choose the language of the GUI. 

HELP Tab 

Tool Default 
Shortcut 

Icon Remarks 
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Help Contents  F1 
 

Launch this help file. 

Product Homepage   
 

Launch the default browser and take you to the 
homepage for ActivePresenter. 

Support Center  

 

Launch the default browser and take you to the 
user forum /FAQ. 

Purchase A License   

 

Launch the default browser and take you to the 
store to buy ActivePresenter Standard or 
Professional edition. This tool is only available if you 
are using the Free edition. 

Activate Product  
 

Enter the license information to activate the 
product, i.e. convert Free edition to Standard or 
Professional edition. This tool is only available if you 
are using the Free edition. 

Deactivate Product  
 

Remove the license information to convert Standard 
or Professional edition back to Free edition. This 
tool is only available if you have already activated 
ActivePresenter. 

Check Updates  
 

Check for update at the website. 

About  
 

Provide information about the current version. 

FORMAT Tab 

This is a context tab which its visibility and content vary according to the selected objects. If there 
is no selected object, it will not be shown. If you select different types of objects, the available tools 
are also different. The following table lists all tools that the FORMAT tab may contains. 

Tool Default 
Shortcut 

Icon Remarks 

Change Shape  
 

Change the shape for the selected objects, for 
example, from Rectangle to Oval. 

Quick Style  
 

Quickly set the style (fill, line, shadow and text) for 
the selected objects. 
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Fill  
 

Change the fill for the selected objects. 

Line  
 

Change the line for the selected objects. 

Shadow  
 

Change the shadow for the selected objects. 

Order  
 

Change the z-order of the selected objects. 

Align  
 

Align the selected objects. 

Entrance Effect  
 

Change the entrance effect and its options for the 
selected objects. 

Exit Effect  
 

Change the exit effect and its options for the 
selected objects. 

Reset Zoom-n-Pan  
 

Reset the scale for selected zoom-n-pan objects to 
100%. 

Curved Cursor Path  
 

Make the cursor path curved. 

Straight Cursor 
Path 

 
 

Make the cursor path straight. 

Snap to Previous  
 

Make the first cursor snap to the last cursor in the 
previous slide. 

Snap to Next  
 

Make the last cursor snap to the first cursor in the 
next slide. 

http://atomisystems.com/tutorials/


ActivePresenter User Manual  Version 5.5 

Customizing ActivePresenter> Changing The Language 316 

Customizing 
ActivePresenter 

You can customize the following aspects in ActivePresenter. 

Changing The Language 

Use the VIEW > Language menu. The available languages will be listed. Select the appropriate 
language. 

Customizing The User Interface 

You can make the following changes to the user interface: 

1. Collapse/expand the toolbars 
(use the Minimize Tabbed Toolbar button) 

2. View/hide the various panes (Library, Timeline, Slides, Properties) 
(use the VIEW tab) 

ActivePresenter saves the project settings when the project is closed. If you open a new project, 
the settings of the last saved project will be automatically applied to it. 

Customizing The Preferences 

Use the ACTIVEPRESENTER > Preferences... menu option. 

The Preferences window pops up. It has six tabs, each serving a different area. Select the 
relevant tab to change the relevant setting. 

Tab What controls are provided 

General General options applicable to the entire software. 

Interaction  Parts of objects that have interactive nature are controlled from here.  

Annotation  Parts of objects that have annotative nature are controlled from here.  
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Auto Annotation Text  ActivePresenter has the capability to generate appropriate annotation 
automatically from interactions. This tab controls how those annotations 
are generated. 

Hot keys  Change the hot keys used for various operations. 

Tabbed Toolbar Customize the tabs and tools in the Tabbed Toolbar. 

Miscellaneous Options that don't fit anywhere in the above tabs. 

Note that some objects have multiple elements. Some of these elements are meant for annotation, 
while the other elements are for interaction. Such elements are controlled by the Annotation and 
Interaction tabs, respectively. 

For example, a True/False type Question object has these elements: 

1. A Question Label that is displayed on screen. (Annotation type element) 

2. Two Answer Labels that the viewer can click to choose the answer (Annotation type 
elements) 

3. A Submit button that the viewer clicks (Interaction type element) 

4. Various attached messages that will be displayed for various events such as: On Correct, 
On Incorrect On Incomplete and On Timeout, these events are triggered automatically 
when viewer interact with the question. These messages are also classified as Annotation 
elements. 

All these various elements form a question object as a whole. A question as a whole is also an 
Interaction. Therefore, in case of a True/False type Question object, its button element and the 
question itself will be controlled by the Interaction tab, and the remaining elements will be 
controlled by the Annotation tab. 
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The General Tab 

 

The options work as follows: 

Interface section 

Control Remarks 

Choose your preferred 
language 

The drop-down menu provides the choice of available languages. 

Max recently used The spinner defines the number of recently opened projects would 
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projects be listed.  

Note that a large number is not actually useful. Instead, cultivate the 
habit of storing the project files in a hierarchical folder system, so that 
you can retrieve any project fast. 

Clear list button ActivePresenter will forget the actual list of recently opened projects.  

Canvas background color Use this to change the color of the canvas background. Click on the 
button to see a palette of colors. Select any desired color. Please 
note that this will only affect the canvas inside ActivePresenter editor, 
it does not affect your projects at all. If you want to change the 
default background color for all slides in an opening project, go to 
ACTIVEPRESENTER > Project Information > Background Color. 

Show disabled features Controls whether ActivePresenter will show menu and toolbar items 
for features which is not available in the edition you are using. For 
example, you can choose to hide most of the items on Export tab if 
you are using a Free edition. 

Show UAC elevating 
message on start-up 

In order to be able to capture applications which were run as 
Administrator, ActivePresenter will also need Administrator privilege. 
On recent versions of Windows that have UAC 
(http://en.wikipedia.org/wiki/User_Account_Control) enabled, 
ActivePresenter will notify you on start up that it need to be elevated 
to capture those applications. However, if you just need to capture 
applications with normal privilege (this is the most common cases) 
then you should not care about this and can safely deselect this 
option to bypass the notification message. 

Project section 

Control Remarks 

Backup project every n 
minutes 

Define how frequently to back up (save) the project. In rare cases 
when ActivePresenter crashes, it will allow you to recover your last 
opening projects from the latest back-ups.  

Please note that these are not permanent back-ups: They will be 
automatically removed when you close your projects. 

Default slide duration Set a default duration for each slide (in milliseconds). 

 If the total run time for all components of a slide exceeds this 
value, this setting will be ignored for that slide. So this can 
also be considered as the minimum duration for each slide. 

Default project location  This is the default folder path where all new projects will be saved.  

 You are allowed to change this folder when you save a new 
project. 
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Library and Configuration section 

This feature is commonly used in production environment where the consistency of content 
crossing multiple projects is required. 

Control Remarks 

Name Displays the name of current Library and Configuration of 
ActivePresenter. From this name, you can know that whether the 
required Library and Configuration is imported into ActivePresenter 
to start the production. 

Export Save the current Library and Configuration of ActivePresenter to a 
file. This file can be imported later into ActivePresenter, may be on 
other computer.  

All the audio/video/images in Library are exported.  

The following settings in Configuration are exported: 

 Settings in Interactions and Annotations tabs of the 
Preferences dialog. 

 Settings in Auto Annotation Text tab of the Preferences 
dialog. 

 The translation in Output Language Editor which is used in 
HTML5/Flash Simulation. 

 The Capture Profiles. 

Import  Import the Library and Configuration of ActivePresenter from a file. 
For the list of items will be imported, see the Export section. 

The Interaction Tab 

As described earlier, you can set properties of all the objects in the Interaction tab and the 
Annotation tab.  

The Interaction Tab deals with only the interactive-type parts of the objects. 
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When you select an element from the list at left (1), its settings are shown on the right (2). These 
elements have similar properties (but you can set their values independently for each type of 
element).  

 

The following properties can be edited (depending on which element is selected, some of these 
options may not be shown): 

Option What it does 

Autofit text Automatically enlarges the outline of the shape till the text fits inside the 
shape. 
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Change text Launches the Text Editor window and allows you to enter a message in rich 
text format. 

Change shape Lets you change the shape for the element. 

Change style Lets you change the style of the element  
 
(Style is the combination of attributes for line, fill, shadow and text). 

Preview Shows how the element will look with all the new settings. 

Preferred size 
(width, height) 

Sets the default width and height. 

Timing (Duration) Sets the default timing for the element, as shown on the Timeline. 

Transition effects Allows you to select effect for entry and exit of the object in the slide (when 
rendered). 

Show in mode- State whether you want to show this element in the Demonstration, Tutorial, 
Practice and Test modes. 

Default Action 

 

In edit mode, when you insert any interaction object, ActivePresenter 
automatically adds one action to be performed by default (see the Event 
Editor). You can use this control to choose the action that will be inserted as 
default. 

Scoring 

(Max attempts, 
points) 

After the viewer has exceeded the maximum allowed attempts, the 
interaction is abandoned, and the control takes the actions defined for the On 
Incorrect event. 

Attached 
message 

You can select which messages to attach with the selected element.  

 Correct – When the viewer's answer is correct 

 Incorrect – When the viewer's answer is incorrect  

 Incomplete – When the viewer's answer is incomplete  

 Hint – A helpful hint (the viewer can hover the mouse on the element 
to see it) 

 Timeout – When the viewer does not respond within predefined time 

Click sound A default sound is shown. But you can use another sound to create a clicking 
sound.  

 The  button lets you select a sound from the library 

 The  button lets you delete the current selection 
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 The  button lets you play the currently selected sound. 

Question Button Allows you to insert up to four different buttons with the following labels on 
them: 

 Clear: Clear the input which viewer has entered. 

 Back: Go back one slide. 

 Skip: Skip this question and move on. 

 Submit: Submit answers. 

Restore defaults Restores the “Factory-set” values. 

Useful to roll back your changes. 

The Annotation Tab 

As described earlier, you can set properties of all the components in the Interaction tab and the 
Annotation tab.  

The Annotation tab deals with only the non-interactive parts of the objects. 

The following options are offered (depending on which element is selected, some of these options 
may not be shown): 

Unlike the interaction-type elements, the annotation elements do not have common properties. In 
fact, they can be divided in three distinct groups based on their properties: 

Group Elements 

1 Shape, Highlight, Text Caption, Question Title, Answer Label, Correct, Incorrect, Hint, 
Complete, Incomplete, Timeout 

2 Image, Audio, Video, Zoom-n-Pan, Closed Caption 

3 Cursor Path 

Within each group, the elements have small differences in their properties. 

We will describe all groups separately. 
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Group 1 Elements 

The following screenshot shows properties for Shape, which is a typical representative of Group 1 
elements. The other elements in this group have lesser properties than Shape. 

 

Elements in this group have the following properties: 

Snap to default 
interaction if 
any 

Causes the mouse pointer to automatically jump to the default interaction (if 
any). 

Generate text Whether ActivePresenter should generate text for the shape based on the 
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from default 
interaction if 
any 

default (first) interaction on current slide. For example, if there is a mouse click 
interaction on current slide, the text can be generated to something like “Click on 
[XXX]”..., This is called auto-annotation. Refer to the Auto-Annotation tab to 
understand how it works. 

AutoFit Text Automatically enlarges the outline of the shape till the text fits inside the shape. 

Change text Launches the Text Editor window and allows you to enter a message in HTML 
format. 

Change shape Lets you change the shape for the element. 

Change style Style is the combination of attributes for fill area, outline, shadow and text. 

Transition 
effects 

Allows you to select the following: 

1. The effect and duration of the entry of the object in the slide  
(when rendered). 

2. The effect and duration of the exit of the object in the slide 
(when rendered). 

Preferred size 
(width, height) 

Set the default width and height. 

Timing 
(duration in ms) 

Sets the default timing for the element, as shown on the Timeline. 

If the duration is set to -1, the object will be displayed till the end of the slide. 

(If the duration of the slide is changed for any reason, the object's duration will 
be automatically adjusted.) 

Show in mode- State whether to show this element in the four modes: Demonstration, Tutorial, 
Practice and Test. (Select one or more modes). 

Group 2 Elements 

The following screenshot shows properties for Audio, which is a typical representative of Group 2 
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elements. 

 

Elements in this group have the following properties: 

Show in mode- State whether to show this element in the four modes: Demonstration, Tutorial, 
Practice and Test. (Select one or more modes). 

Sample rate Select from 11025, 22050 and 44100 Hz. 

Channels Select from mono/stereo. 

Bit rate Select from 64, 96 and 128 kbps. 

Zooming 
transition 

Duration: Duration of the zoom movement. 

Zoom scale: How much to zoom in 
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Group 3 Elements 

The following screenshot shows properties for Cursor Path, which is a unique type of element 
(placed in Group 3). 

 

It has the following properties: 

Show in mode- State whether to show this element in the four modes: Demonstration, 
Tutorial, Practice and Test. (Select one or more modes). 

Cursor highlight type Select between none, circle, and square 

Movement path Select between- 

 Straight: The actual path of the mouse cursor is replaced by 
straight lines between clicks. 

 Curved: ActivePresenter preserves the actual movement path and 
represents it with a Bézier curve. 

Cursor shape Click the Change cursor button to see other shapes. Select any shape 
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and press OK. 

Click sound This section shows three different sounds, which correspond to the clicking 
sound associated with a Left-click, a Right-click and a Left double-click. 

You can use another sound to create a clicking sound.  

 The  button lets you select a sound from the library 

 The  button lets you delete the current selection 

 The  button lets you play the currently selected sound. 

Click effect This section show three different effects, which correspond to the clicking 
effect associated with a Left-click, a Right-click and a Left double-click. 

You can select none, circle, concentric circles or rectangle effect type. For 
each effect other than none, you can also customize effect color, opacity 
and size.  
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The Auto-Annotation Text Tab 

 

ActivePresenter can generate the text for annotation automatically based on what you are 
interacting with while capturing.  

For example, when you type your User Name into a log-in screen, ActivePresenter can create a 
call out which says “Type [XXX] into User Name text box”.  

You can easily customize how ActivePresenter generates the annotation text through the settings 
in this tab. 

With these options, you can easily control the annotation contents which are generated 
automatically by ActivePresenter when capturing.  

There are 3 parameters that you can use to specify dynamic content depends on the context. 
Every parameter has the form {$XXX}, in which XXX is the parameter name: 

{$name} This is the name of the item that you are interacting with when capturing. 
For example, when you entering your name in a log-in screen, the text box 
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may have a name like “User Name” 

{$type} This is the type of the item that you are interacting with. The types of items 
are provided by the OS. For example, you are typing in a text box, then its 
type is “text box”. If you are clicking on a button then its type is “button”. 

{$value} This is what you are entering while capturing. If you are pressing a key, 
the value is the key that you've pressed. If you are entering text into a text 
box, then the value is the text you've entered. 

The Hot keys Tab 

This tab contains all the hot keys used by ActivePresenter for various functions. 

 

The GUI works as follows: 

1. All the major functions of ActivePresenter are grouped functionally in a hierarchical tree.  
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The tree consists of nodes, like Project, Edit, View, etc. Each node contains a group of related 
functions. 

To open any node, click on the  button on the left of it. The node expands to show the options 
contained in it.  

2. Click on any option to set its hot key.  

3. The hot key that is currently assigned to this activity (in this case, to start a new capture 
project.) is displayed here.  

4. You can remove the assigned hot key. 

5. To assign a new hot key to the function, first click in the input box and then press the hot 
key. 

In this example, we have pressed CTRL+C, which is automatically captured and displayed 
in the input box. In fact, ActivePresenter detected that this hot key is currently assigned to 
the copy function. 

Now you have two options: Either try another hot key. (and repeat the cycle), or press the 
Add button to re-assign the CTRL+C hot key to start a new capture project function. 
Naturally, this hot key will no longer be assigned to the copy function. 

6. If your experiments go haywire, you can always restore to the defaults by pressing this 
button. All your hot key customization will be removed. 

The Tabbed Toolbar Tab 
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In this tab, you can customize the toolbar for your interest and improving the performance in 
editing.  
The window on the left of this tab contains all commands which are organized in groups. The 
window on the right of this tab is the structure of current toolbar of program. 
If you want to restore the default structure of toolbar, just click the Restore Default button then 
click OK. 

 

The Miscellaneous Tab 

This tab is a “catch-all” tab: It contains program options that could not be placed in the other tabs. 

 

The options on this tab are as follows: 

Automatic Updates Selecting the Automatically Check for Updates option allows 

http://atomisystems.com/tutorials/


ActivePresenter User Manual  Version 5.5 

Customizing ActivePresenter> Customizing The Preferences 333 

 ActivePresenter to contact its server to check for updates automatically. 

If enabled, ActivePresenter will periodically check for updates when 
started. 

Connection settings In order to connect to the internet, ActivePresenter needs the connection 
settings. 

When you click this button, a dialog pops up and offers the following 
options: 

 No proxy 

 Use system settings (default) 

 Manual configuration 

Check with your admin and set the values. 

Log section Provides logging-related options. Logs are important for troubleshooting. 

Enable logging If you disable this option, no logs will be kept. 

Log UI level Select the log level that will be displayed. Only log messages which have 
severity level that is higher or equal to the selected level will be displayed. 
The other logs will be written to the log file silently. 

Verbose mode In verbose mode, more details are captured. This is better for 
troubleshooting. 

Log level There are five levels: 

1. Fatal error (most severe level) 

2. Error 

3. Warning 

4. Message 

5. Status 

6. Information  

If you select any level, the log will be kept of that level and higher levels (if 
any).  

For example, selecting Warning will keep a log of the top three types of 
problems, but selecting Fatal error will keep log of fatal errors only. 

View Log Clicking on this button shows the log file. 

The log file is automatically cleared and started over when its size reaches 
2 MB. 

Confirmation 
Settings 

These settings specify whether appropriate messages will be displayed to 
seek the user's confirmation. 
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 Warning about non-ANSI path when exporting: When you export your 
project, there are some outputs that can not be opened or run properly if 
the file name contains non-ANSI characters. This option specifies whether 
ActivePresenter should ask you in such case or not. 

Show dialog when converting shape’s text to speech: Should 
ActivePresenter display the dialog so you can make further changes to the 
TTS settings before converting? 

Extend object duration to match the duration of generated audio 

Link resources with 
file size greater than 
x MB 

When a resource is added to the Library or a project, ActivePresenter 
creates a copy of the resource file and stores it in the Library or that 
project. (That ensure that even if you rename, move or delete the original 
file, the Library item will not be affected.)  

But if the original file is large, storing it directly in the Library or project will 
consume more disk space than necessary, severely reduce the 
performance and prone to errors that might corrupt the Library or project. 
In that case, ActivePresenter doesn't store the original file directly in the 
Library or project but maintains its own copy of the original file and creates 
a link in the Library or project which points to its own copy. 

This parameter defines the threshold above which ActivePresenter will 
create a link to the resource instead of storing the original file directly 
inside the Library or project. 

Allow pasting HTML 
text copied from 
other applications 

HTML is a huge standard which has many tags meanwhile 
ActivePresenter’s editor only support some basic tags for formatting 
characters and paragraphs. Using HTML text copied from other 
applications may produce incorrect result in some output such as HTML5 
Simulation. Selecting this option is not recommended. 

Auto-Adjust 
annotation’s width 
when importing 
XLIFF 

Select this option allows ActivePresenter to adjust the width of shape 
automatically to have a best look when importing XLIFF. 
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What's New 

All changes are tagged to identify their source: 

Tag What it means 

New A new feature was introduced in the latest ActivePresenter  

Modified An existing feature was modified/enhanced in the latest ActivePresenter  

Added The earlier version of manual missed a feature/detail 

Corrected Mistake in an earlier version of manual is corrected now. 

In the table below, click on the page number (in the left column) to jump to the changed text.  
Use your pdf-reader's Back button to return here. 

Page What's new 

16 Modified: Capture Profile. Update names and descriptions of capture profiles. 

20 Added: The path of external data folder. 

23 New: Add the Selection pane. 

27 Modified: Export To FLV is combined into Export To Video 

28 Modified: The rotation feature is not available when running the HTML5 output in 
IE7 and IE8 

34 Modified: Update names and descriptions of capture profiles. 

56 Modified: The table of slide properties is moved to the Slide Properties section. 

59 New: Add the Event tab for the Project Properties dialog. 

62 Added: Add the Slide Properties section. 

66 New: Object rotation 
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69 Modified: Z-orders and Selection pane 

89 New: The HTML5 JavaScript API 

106 Modified: Export To Video: add H264 video codec, add more audio bit-rates, FLV 
format (Export To FLV is removed). 

171 New: Allow editing cursor effects in recorded video, the Cursor tab of Capture 
Profile Editor is simplified. 

221 New: The Selection pane. 

223 Modified: Timeline: remove View All Object feature, the Insert Freeze Frame/Silence 
tool is superseded by Insert Time tool. 

233 New: Organize multiple objects into a line in Timeline 

243 New: Change media playback speed 

298 New: Edit cursor effects in a recorded video 

331 New: The Customize Toolbar tab. 
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